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Introduction

The Adafruit Feather nRF52 Bluefruit is our latest easy-to-use all-in-one Bluetooth
Low Energy board, with a native-bluetooth chip, the nRF52832! It's our take on an
'all-in-one' Arduino-compatible + Bluetooth Low Energy with built in USB and battery
charging.

This chip has twice the flash, SRAM and performance of the earlier nRF51-based
Bluefruit modules. Best of all it has Arduino IDE support so there is no 'helper' chip
like the ATmega32u4 or ATSAMD?21. Instead, this chip is programmed directly! It's got
tons of awesome peripherals: plenty of GPIO, analog inputs, PWM, timers, etc.
Leaving out the extra microcontroller means the price, complexity and power-usage
are all lower/better. It allows you to run code directly on the nRF52832, straight from
the Arduino IDE as you would with any other MCU or Arduino compatible device. A
single MCU means better performance, lower overall power consumption, and lower
production costs if you ever want to design your own hardware based on your
Bluefruit nRF52 Feather project!

The chips are pre-programed with an auto-resetting bootloader so you can upload
quickly in the Arduino IDE with no button-pressing. Want to program the chip directly?
You can use our command line tools with your favorite editor and toolchain.

And to get you up and running quickly, we've done all the heavy lifting of getting
the low level BLE stack into shape so that you can focus on your project from day
one!

NRF52832 Technical Details

« ARM Cortex M4F (with HW floating point acceleration) running at 64MHz

» 512KB flash and 64KB SRAM

« Built in USB Serial converter for fast and efficient programming and debugging

» Bluetooth Low Energy compatible 2.4GHz radio (Details available in the nRF528
2 (https://adafru.it/vaJ) product specification)

« FCC /IC / TELEC certified module

« Up to +4dBm output power

+ 1.7v to 3.3v operation with internal linear and DC/DC voltage regulators

+ 19 GPIO, 8 x 12-bit ADC pins, up to 12 PWM outputs (3 PWM modules with 4
outputs each)

« Pin #17 red LED for general purpose blinking

- Power/enable pin
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https://www.nordicsemi.com/eng/Products/Bluetooth-low-energy/nRF52832
https://www.nordicsemi.com/eng/Products/Bluetooth-low-energy/nRF52832

« Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in

- Light as a (large?) feather - 5.7 grams

+ 4 mounting holes

» Reset button

« Optional SWD connector for debugging

« Works out of the box with just about all of our Adafruit FeatherWings! (https://
adafru.it/vby) (Wings that require the UART like the GPS FeatherWing won't
work)

Further technical details available in the nRF52832 (https://adafru.it/val) product
specification.

Like all of our Feather boards, the Bluefruit nRF52 Feather includes on board
USB-based LIPO charging, and has a standard LIPO battery connector to make

your wireless projects genuinely 'wireless' at no additional cost (aside from the
LIPO cell itself).

NRF51 or nRF52 Bluefruit Devices?

The Bluefruit nRF52 Feather (based on the nRF52832 (https://adafru.it/vaJ) SoC) is
quite different from the earlier nRF51822 based Bluefruit products (Bluefruit MO
Feather (https://adafru.it/t6a), etc.), both of which will continue to exist.

From a hardware perspective, the nRF52 Feather is based on a much more powerful
ARM Cortex M4F processor, with 512KB flash, 64KB SRAM and hardware floating point
acceleration ... whereas the earlier nRF51822 is based on the smaller ARM Cortex MO
core (fewer internal instructions), with 256KB flash and either 16KB or 32KB SRAM.
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https://www.adafruit.com/categories/814
https://www.nordicsemi.com/eng/Products/Bluetooth-low-energy/nRF52832
https://www.nordicsemi.com/eng/Products/Bluetooth-low-energy/nRF52832
https://www.adafruit.com/product/2995
https://www.adafruit.com/product/2995

More importantly, the design approach that we took with the nRF52 is completely
different:

« NRF51 based Bluefruit boards run as modules that you connect to via an external
MCU (typically an Atmel 32u4 or a SAMD21), sending AT style commands over
SPI or UART.

« With the nRF52, you run all of your code directly on the nRF52832 and no
external MCU is used or required!

This change of design helps keep the overall costs lower, allows for far better
performance since you aren't limited by the SPI or UART transport channel, and can
help improve overall power consumption.

As a tradeoff, it also means a completely different APl and development process,
though!

nRF51 Bluefruit sketches won't run on nRF52 Bluefruit hardware without

modification! The two device families have different APls and programming
models, and aim to solve your wireless problems in two different ways.

Device Pinout
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Special Notes

The following pins have some restrictions that need to be taken into account when
using them:

« PIN_DFU / P0.20: If this pin is detected to be at GND level at startup, the board
will enter a special serial bootloader mode and will not execute any user code,
going straight into bootloader mode. If you wish to use this pin as a standard
GPIO, make sure that it is pulled high with a pullup resistor so that your code will
execute normally when the MCU starts up.

« PO.31/ A7: This pin is hard wired to a voltage-divider on the LIPO battery input,
allow you to safely measure the LIPO battery level on your device. If possible,
you should avoid using this pin as an input because you will lose the ability to
read the battery voltage. You can use it as an output just make sure to switch
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the pin to analog input when you want to do the battery read, then back to
output when toggling pins

« FRST/P0.22: Setting this pin to GND at startup will cause the device to perform a
factory reset at startup, erasing and config data as well as the user sketch. At
the next reset, you should enter serial bootloader mode by default, since no
user sketch will be present. You can use this to recover 'bricked' boards, but if
you don't wish to do this be careful not to have FRST low at startup. By default, a
weak internal pull-up resistor is enabled on this pin during the bootloader
phase. FRST does not work with Mynewt bootloader !!

Power Pins

« 3.3V Output: This two pins are connected to the output of the on board 3.3V
regulator. They can be used to supply 3.3V power to external sensors, breakouts
or Feather Wings.

« LIPO Input (VBAT): This is the voltage supply off the optional LIPO cell that can
be connected via the JST PH connector. It is nominally V3.5-4.2V.

« VREG Enable: This pin can be set to GND to disable the 3.3V output from the on
board voltage regulator. By default it is set high via a pullup resistor.

« USB Power (VBUS): This is the voltage supply off USB connector, nominally
4.5-5.2V.

Analog Inputs

The 8 available analog inputs can be configured to generate 8, 10 or 12-bit data (or 14-
bits with over-sampling), at speeds up to 200kHz (depending on the bit-width of the
values generated), based on either an internal 0.6V reference or the external supply.

The following default values are used:

- Default voltage range: 0-3.6V (uses the internal 0.6V reference with 1/6 gain)
« Default resolution: 10-bit (0..1023)

Unlike digital functions, which can be remapped to any GPIO/digital pin, the ADC

functionality is tied to specified pins, labelled as A" in the image above (AO, A1,
etc.).
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PWM Outputs

Any GPIO pin can be configured as a PWM output, using the dedicated PWM block.

Three PWM modules can provide up to 12 PWM channels with individual frequency
control in groups of up to four channels.

Please note that DMA based PWM output is still a work in progress in the initial

release of the nR52 BSP, and further improvements are planned here.

12C Pins

I12C pins on the nRF52832 require external pullup resistors to function, which are not
present on the Adafruit nRF52 Feather by default. You will need to supply external
pullups to use these. All Adafruit 12C breakouts have appropriate pullups on them
already, so this normally won't be an issue for you.

Assembly

We ship Feathers fully tested but without headers attached - this gives you the most
flexibility on choosing how to use and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!
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The first option is soldering in plain male
headers, this lets you plug in the Feather
into a solderless breadboard

Another option is to go with socket
female headers. This won't let you plug
the Feather into a breadboard but it will
let you attach featherwings very easily
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https://learn.adafruit.com//assets/30201
https://learn.adafruit.com//assets/30201
https://learn.adafruit.com//assets/30195
https://learn.adafruit.com//assets/30195
https://learn.adafruit.com//assets/30196
https://learn.adafruit.com//assets/30196

We also have 'slim' versions of the
female headers, that are a little shorter
and give a more compact shape

Finally, there's the "Stacking Header"
option. This one is sort of the best-of-
both-worlds. You get the ability to plug
into a solderless breadboard and plug a
featherwing on top. But its a little bulky
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Add the breakout board:

Place the breakout board over the pins
so that the short pins poke through the
breakout pads

And Solder!

Be sure to solder all pins for reliable

,.:—L.’-‘ -\.-l“--l-- LR R .'7--.7..- e|eCtI’IC8|C0ntaCt

Sl EEEEE EEEEE A
v

(For tips on soldering, be sure to check
out our Guide to Excellent
Soldering (https://adafru.it/aTk)).
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© % annaiad Ml‘“‘t
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https://learn.adafruit.com//assets/30186
http://learn.adafruit.com/adafruit-guide-excellent-soldering
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Solder the other strip as well.

NACID: FSFOCSF19136

@‘%? DC D15R

-

N AN AR S EEEEN Sssss sassnn =8
l-a.-- - ... - - ... - .

You're done! Check your solder joints
Trrrs seaes sesss seass saaes visually and continue onto the next steps
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https://learn.adafruit.com//assets/30188
https://learn.adafruit.com//assets/30189
https://learn.adafruit.com//assets/30189
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Soldering on Female Header

Tape In Place

For sockets you'll want to tape them in
place so when you flip over the board
they don't fall out
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Flip & Tack Solder

After flipping over, solder one or two
points on each strip, to 'tack' the header
in place

8TOTZaUMS)
: @BSTONIALY) ®°
#§ ran eu sswmeay
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And Solder!

Be sure to solder all pins for reliable
electrical contact.

““;‘é,‘zg‘;‘ﬁ“ 5' (For tips on soldering, be sure to check
) NS 1Y . .
Uil o out our Guide to Excellent
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You're done! Check your solder joints
visually and continue onto the next steps

Feawther M@ WiFi G@
(ATWINC1500)

’ $€ arswnn21618
f == 48MHZz & 3.3V
e | i3
¢ d 2 -

Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer
as well as via battery. There's two ways to power a Feather. You can connect with a
MicroUSB cable (just plug into the jack) and the Feather will regulate the 5V USB
down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer (Lipo/Lipoly) or Lithium
lon (Lilon) battery to the JST jack. This will let the Feather run on a rechargable
battery. When the USB power is powered, it will automatically switch over to USB for
power, as well as start charging the battery (if attached) at 100mA. This happens
'hotswap' style so you can always keep the Lipoly connected as a 'backup' power that
will only get used when USB power is lost.
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The above shows the Micro USB jack (left), Lipoly JST jack (top left), as well as the
changeover diode (just to the right of the JST jack) and the Lipoly charging circuitry
(to the right of the JST jack). There's also a CHG LED, which will light up while the
battery is charging. This LED might also flicker if the battery is not connected.

Power supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied
to the lipoly JST connector, as well as USB which is the +5V from USB if connected.
We also have the 3V pin which has the output from the 3.3V regulator. We use a
500mA peak regulator. While you can get 500mA from it, you can't do it continuously
from 5V as it will overheat the regulator. It's fine for, say, powering an ESP8266 WiFi
chip or XBee radio though, since the current draw is 'spikey' & sporadic.

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply
tie this pin to Ground and it will disable the 3V regulator. The BAT and USB pins will
still be powered
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Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into
the JST port or a USB power cable.

If you need other ways to power the Feather, here's what we recommend:

« For permanent installations, a 5V 1A USB wall adapter (https://adafru.it/duP) will
let you plug in a USB cable for reliable power

« For mobile use, where you don't want a LiPoly, use a USB battery pack! (https://
adafru.it/e2q)

« If you have a higher voltage power supply, use a 5V buck converter (https://
adafru.it/DHs) and wire it to a USB cable's 5V and GND input (https://adafru.it/
DHu)

Here's what you cannot do:

« Do not use alkaline or NiMH batteries and connect to the battery port - this will
destroy the LiPoly charger and there's no way to disable the charger
« Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather is not designed for external power supplies - this is a design decision to
make the board compact and low cost. It is not recommended, but technically
possible:

« Connect an external 3.3V power supply to the 3V and GND pins. Not
recommended, this may cause unexpected behavior and the EN pin will no
longer. Also this doesn't provide power on BAT or USB and some Feathers/
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Wings use those pins for high current usages. You may end up damaging your
Feather.

« Connect an external 5V power supply to the USB and GND pins. Not
recommended, this may cause unexpected behavior when plugging in the USB
port because you will be back-powering the USB port, which could confuse or
damage your computer.

Arduino Support Setup

You can install the Adafruit Bluefruit nRF52 BSP (Board Support Package) in two
steps:

NRF52 support requires at least Arduino IDE version 1.8.6! Please make sure you
have an up to date version before proceeding with this guide!

Please consult the FAQ section at the bottom of this page if you run into any
problems installing or using this BSP!

1. BSP Installation

Recommended: Installing the BSP via the Board Manager

« Download and install the Arduino IDE (https://adafru.it/fvm) (At least v1.8)

. Start the Arduino IDE

« Go into Preferences

« Add https://www.adafruit.com/package adafruit index.json as an'Ad
ditional Board Manager URL' (see image below)

©Adafruit Industries Page 24 of 176
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« Restart the Arduino IDE
« Open the Boards Manager option from the Tools -> Board menu and install 'Ada
fruit nRF52 by Adafruit' (see image below)

It will take up to a few minutes to finish installing the cross-compiling toolchain and
tools associated with this BSP.

The delay during the installation stage shown in the image below is normal, please be
patient and let the installation terminate normally:

Once the BSP is installed, select

« Adafruit Bluefruit nRF52832 Feather (for the nRF52 Feather)

« Adafruit Bluefruit nRF52840 Feather Express (for the nRF52840 Feather)
« Adafruit ItsyBitsy nRF52840 (for the Itsy '850)

« Adafruit Circuit Playground Bluefruit (for the CPB)

. etc...
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from the Tools -> Board menu, which will update your system config to use the right
compiler and settings for the nRF52:

2. LINUX ONLY: adafruit-nrfutil Tool
Installation

adafruit-nrfutil (https://adafru.it/Cau) is a modified version of Nordic's nrfutil (https://

adafru.it/vaG), which is used to flash boards using the built in serial bootloader. It is
originally written for python2, but have been migrated to python3 and renamed to ad
afruit-nrfutil since BSP version 0.8.5.

Install python3 if it is not installed in your system already

$ sudo apt-get install python3

Then run the following command to install the tool from PyPi

$ pip3 install --user adafruit-nrfutil

Add pip3 installation dir to your PATH if it is not added already. Make sure adafruit-
nrfutil can be executed in terminal by running

$ adafruit-nrfutil version
adafruit-nrfutil version 0.5.3.postl2
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3. Update the bootloader (hnRF52832 ONLY)

To keep up with Nordic's SoftDevice advances, you will likely need to update your
bootloader if you are using the original nRF52832 based Bluefruit nRF52 Feather
boards.

Follow this link for instructions on how to do that

This step ISN'T required for the newer nRF52840 Feather Express, which has a
different bootloader entirely!

Update the nRF52832 Bootloader

https://adafru.it/Dsx

Advanced Option: Manually Install the BSP
via 'git’

If you wish to do any development against the core codebase (generate pull requests,
etc.), you can also optionally install the Adafruit nRF52 BSP manually using 'git', as
decribed below:

Adafruit nRF52 BSP via git (for core development and PRs only)

1. Install BSP via Board Manager as above to install compiler & tools.

2. Delete the core folder nrf52 installed by Board Manager in Adruino15,
depending on your OS. It could be
macOS: ~/Library/Arduinol5/packages/adafruit/hardware/nrf52
Linux: ~/.arduinol5/packages/adafruit/hardware/nrf52
Windows: SAPPDATAS
\Local\Arduinol5\packages\adafruit\hardware\nrf52

3. Go to the sketchbook folder on your command line, which should be one of the
following:
macOS: ~/Documents/Arduino
Linux: ~/Arduino
Windows: ~/Documents/Arduino

4. Create a folder named hardware/Adafruit, if it does not exist, and change
directories into it.
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5. Clone the Adafruit_nRF52_Arduino (https://adafru.it/vaF) repo in the folder
described in step 2:

git clone --recurse-submodules git@github.com:adafruit/
Adafruit nRF52 Arduino.git

6. This should result in a final folder name like ~/Documents/Arduino/hardware
/Adafruit/Adafruit nRF52 Arduino (macOS).

7. Restart the Arduino IDE

Arduino Board Testing

Once you have the Bluefruit nRF52 BSP setup on your system, you need to select the

appropriate board, which will determine the compiler and expose some new menus
options:

1. Select the Board Target

« Go to the Tools menu

« Select Tools > Board > Adafruit Bluefruit nRF52 Feather for nRF52832-based
boards

« Select Tools > Board > Adafruit Bluefruit nRF52840 Feather Express for nRF528
40-based boards

« Select Tools > Board > Adafruit CLUE for the Adafruit CLUE

2. Select the USB CDC Serial Port

Finally, you need to set the serial port used by Serial Monitor and the serial
bootloader:

- Go to Tools > Port and select the appropriate device
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Download & Install CP2104 Driver (hnRF52832)

For Feather nRF52832 If you don't see the SiLabs device listed, you may need to
install the SiLabs CP2104 driver (https://adafru.it/yfA) on your system.

On MacOS If you see this dialog message while installing driver

On MacOS If you see this dialog
message while installing driver, System
Extension Blocked

And cannot find the serial port of
CP2104, it is highly possible that driver is
blocked.

To enable it go to System Preferences ->
Security & Privacy and click allow if you
see Silab in the developer name.

Download & Install Adafruit Driver (hRF52840 Windows)

For Feather nRF52840, If you are using Windows, you will need to follows Windows
Driver Installation (https://adafru.it/DOH) to download and install driver.

3. Update the bootloader (hnRF52832
Feather Only)

To keep up with Nordic's SoftDevice advances, you will likely need to update your
bootloader
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Follow this link for instructions on how to do that

This step is only necessary on the nRF52832-based devices, NOT on the newer
NnRF52840 Feather Express.

Update the Bootloader

https://adafru.it/Dsx

4. Run a Test Sketch

At this point, you should be able to run a test sketch from the Examples folder, or just
flash the following blinky code from the Arduino IDE:

void setup() {
pinMode (LED BUILTIN, OUTPUT);

}

void loop() {
digitalWrite(LED BUILTIN, HIGH); // turn the LED on (HIGH is the voltage level)
delay(1000); // wait for a second
digitalWrite(LED BUILTIN, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

This will blink the red LED beside the USB port on the Feather, or the red LED labeled
"LED" by the corner of the USB connector on the CLUE.

If Arduino failed to upload sketch to the Feather

If you get this error:

Timed out waiting for acknowledgement from device.

Failed to upgrade target. Error is: No data received on serial
port. Not able to proceed.
Traceback (most recent call last):
File "nordicsemi\ main_.py", line 294, in serial
File "nordicsemi\dfuldfu.py", line 235, in dfu send images
File "nordicsemi\dfu\dfu.py", line 203, in dfu send image
File "nordicsemi\dfuldfu transport serial.py", line 155, in
send init packet
File "nordicsemi\dfuldfu transport serial.py", line 243, in
send packet
File "nordicsemi\dfuldfu transport serial.py", line 282, in
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get _ack nr
nordicsemi.exceptions.NordicSemiException: No data received on
serial port. Not able to proceed.

This is probably caused by the bootloader version mismatched on your feather and
installed BSP. Due to the difference in flash layout (more details (https://adafru.it/
Dsy)) and Softdevice API (which is bundled with bootloader), sketch built with
selected bootloader can only upload to board having the same version. In short,
you need to upgrade/burn bootloader to match on your Feather, follow

above Update The Bootloader (https://adafru.it/Dsx) guide

It only has to be done once to update your Feather

On Linux I'm getting 'arm-none-eabi-g++: no such file or
directory’, even though 'arm-none-eabi-g++' exists in the
path specified. What should | do?

This is probably caused by a conflict between 32-bit and 64-bit versions of the
compiler, libc and the IDE. The compiler uses 32-bit binaries, so you also need to
have a 32-bit version of libc installed on your system (details (https://adafru.it/vnE)).
Try running the following commands from the command line to resolve this:

1.
sudo dpkg --add-architecture 1386

2.
sudo apt-get update

3.
sudo apt-get install libc6:1386

Using the Bootloader

This page is for information purposes only. Normally the bootloader will work

transparently and automatically from the Arduino IDE, requiring no manual
intervention on your behalf.

The Bluefruit nRF52 Feather includes a customized version of the Nordic bootloader
that enables serial support, over the air (OTA) DFU support, and various fail safe
features like factory reset when the FRST pin is grounded at startup.
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The bootloader that all Bluefruit nRF52 Feathers ships with allows you to flash user
sketches to the nRF52832 using only the CP2104 USB to serial adapter populated on
the board.

The bootloader source code can be found here Adafruit_nRF52_Bootloader (https://
adafru.it/Cnt)

Forcing Serial Boot Mode

The Bluefruit nRF52 Feather is designed to briefly enter serial bootloader mode for a
short delay every time the device comes out of reset, and the DTR line on the CP2104
USB to Serial adapter will trigger a reset every time the Serial Monitor is opened. This
means that you can normally flash a user sketch to the nRF52 with no manual
intervention on your part at a HW level.

If you need to force the serial bootloader mode, however, you can connect the DFU
pin to GND at startup, which will force you to enter serial bootloader mode and stay in

that mode until you reset or power cycle the board.

This can be used to recover bricked boards where a bad user sketch has been

uploaded, since you will enter serial bootloader mode without executing the user
sketch, and you can flash a new sketch directly from the Arduino IDE.

Forcing the serial bootloader can often be used to recover bricked devices.

NRF52840-based board can also use double reset trick to force into serial
bootloader
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Factory Reset

The Bluefruit nRF52 Feather has an optional FRST pad on the bottom of the PCB.

If you brick your device, you can solder a wire to the FRST pad, connecting it to GND.
When a GND state is detected at power up the following actions will be performed:

- The user application flash section will be erased
- The user 'App Data' section that stores non volatile config data will be erased

This will cause the device to enter serial bootloader mode at startup, and the user
sketch or config data that caused the device to stop responding should be removed.

Be sure to disconnect the pin from GND after a successful factory reset!

Advanced: OTA DFU Bootloader

While this is only recommended for advanced users, you can also force OTA (Over
The Air) DFU bootloader mode to enable OTA updates using BLE and Nordic's
proprietary update protocol (which is support by both Nordic mobile apps, and out
own Bluefruit LE Connect).

To force OTA DFU mode, set both FRST and DFU to GND at startup. Power cycling the
board will cause the device to boot up into OTA DFU mode.
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This option is not actively support nor recommended by Adafruit, and we are still
working on making this as safe as possible for users via our Bluefruit LE Connect

application. Use OTA DFU at your own risk knowing you can brick your device
and may need a Segger J-Link or similar device to regain control of it!

Updating the Bootloader

Upgrading the Bootloader is only possible from BSP release 0.8.0 and higher.

Upgrading an Existing Bootloader

The Adafruit Feather nRF52 Bootloader binary contains not only the DFU code, but
also the Bluetooth stack (a.k.a SoftDevice) to make sure they work together reliably.
To get the latest and greatest features from the stack such as Bluetooth 5.0 with
higher throughput, increased broadcast capacities or larger MTU it is necessary to
upgrade Bootloader to get the latest stack.

Therefore latest BSP release could support newer SoftDevice version than one
currently exists on your board. Due to the flash memory & API difference between
SoftDevice major versions, upgrade your board's bootloader to match one supported
by BSP is required to upload compiled sketch. Luckily the Bluefruit nRF52 Bootloader
can be upgraded/downgraded without any additional hardware, and we can even do
that right in Arduino IDE without at risk of typos or common user errors.

Close the Serial Monitor before you click "Burn Bootloader". Afterwards, you
shouldn't close the Arduino IDE, unplug the Feather, launch Serial Monitor etc ...

to abort the process. There is a high chance it will brick your device! Do this with
care and caution.
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First select the Bootloader version that
you want to upgrade under Tools-
>Bootloader

Then select "Bootloader DFU for Bluefruit
nRF52" for Tools->Programmer

Double check all of the following: Board, Bootloader Version, Programmer...

Select Tools->Burn Bootloader to start the upgrade.

After receiving the new Bootloader over the serial connection, the old Bootloader will
erase itselfl The new bootloader will then be flashed. The process typically takes
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30-60 seconds to complete. Make sure you see the "Device programmed" in the
output log before launching Serial monitor or uploadinga new sketch.

In case you wonder, the command that IDE uses to upgrade bootloader is as follows
(bootloader zip file is different for boards and version).

$ adafruit-nrfutil --verbose dfu serial --package
feather nrf52832 bootloader-0.2.8 s132 6.1.1.zip
-p /dev/ttyACMO -b 115200 --singlebank --touch 1200

Flashing the Bootloader

All Adafruit nRF52 boards chip with the bootloader pre-flashed. This page is

provided for information purposes only!

All Bluefruit nRF52 Feather boards and Bluefruit nRF52 modules ship with the serial
bootloader pre-flashed, so this page is normally not required when setting your
device and system up.

The information provided here is only intended for for rare cases where you may want
or need to reflash the bootloader yourself, and have access to the HW required to do
so.

1. Updating the Bootloader with a Segger J-
Link and Arduino IDE

To burn the bootloader from within the Arduino IDE using a Segger J-Link, you will
need the following tools installed on your system and available in the system path:

JLink Drivers and Tools

Download and install the JLink Software and Documentation Pack (https://adafru.it/

val) from Segger, which will also install a set of command line tools.
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Burning the Bootloader from the Arduino IDE

Once the tools above have been installed and added to your system path, from the
Arduino IDE:

- Select "Tools > Board > Adafruit Bluefruit Feather52"
« Select "Tools > Programmer > J-Link for Feather52"
- Select "Tools > Burn Bootloader with the board and J-Link connected

The appropriate Programmer target and Burn Bootloader button can be seen below:

You will need a Segger J-Link to flash the bootloader to the nRF52832/

nRF52840 SoC!

2. Manually Burning the Bootloader via
nrfjprog

You can also manually burn the bootloader from the command line, using ‘nrfjprog
from Nordic.

You can either download nRF5x-Command-Line-Tools (https://adafru.it/vaJ) for OSX/
Linux/Win32, or use the version that ships with the BSP in the tools/nrf5x-command-

line-tools folder.

Run the folllwing commands, updating the path to the .hex file as appropriate:
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$ nrfjprog --program bootloader binary.hex --chiperase -f nrf52 --reset

You should see something similar to the following output, followed by a fast blinky on
the status LED to indicate that you are in DFU/bootloader mode since no user sketch
was found after the device reset:

All commands below were run from 'tools/nrf5x-command-line-tools/osx/nrfjprog’

$ ./nrfjprog -e -f nrf52
Erasing code and UICR flash areas.
Applying system reset.

$ ./nrfjprog --program ../../../../bin/bootloader/bootloader v050 s132 v201l.hex -f
nrf52

Parsing hex file.

Reading flash area to program to guarantee it is erased.

Checking that the area to write is not protected.

Programing device.

$ ./nrfjprog --reset -f nrf52

Applying system reset.
Run.

OS X Note: You may need to create a symlink in “/usr/local/bin” to the
‘nrfjprog” tool wherever you have added it. You can run the following command, for
example:

$ In -s $HOME/prog/nordic/nrfjprog/nrfjprog /usr/local/bin/nrfjprog

3. Manually Burning the Bootloader via
Adalink

Alternatively, you can use Adalink (https://adafru.it/fPq) to flash the bootloader with a
Segger J-Link:

# First erase the device's flash contents
$ adalink nrf52832 -p jlink -w

# Then flash the bootloader and SoftDevice .hex file
$ adalink nrf52832 -p jlink -h feather52 bootloader v050 s132 v201.hex

©Adafruit Industries Page 38 of 176


https://github.com/adafruit/Adafruit_Adalink

Arduino BLE Examples

There are numerous examples available for the Bluefruit nRF52/nRF52840 Feathers
in the Examples menu of the nRF52 BSP, and these are always up to date. You're first
stop looking for example code should be there:

Example Source Code

The latest example source code is always available and visible on Github, and the
public git repository should be considered the definitive source of example code for
this board.

Click here to browse the example

source code on Github

https://adafru.it/vaK

Documented Examples

To help explain some common use cases for the nRF52 BLE API, feel free to consult
the example documentation in this section of the learning guide:

« Advertising: Beacon - Shows how to use the BLEBeacon helper class to
configure your Bleufruit nRF52 Feather as a beacon

« BLE UART: Controller - Shows how to use the Controller utility in our Bluefruit LE
Connect apps to send basic data between your peripheral and your phone or
tablet.

« Custom: HRM - Shows how to defined and work with a custom GATT Service
and Characteristic, using the officially adopted Heart Rate Monitor (HRM) service
as an example.
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« BLE Pin I/O (StandardFirmataBLE) Shows how to control Pin I/O of nRF52 with
Firmata protocol

For more information on the Arduino nRF52 API, check out this page (https://adafru.it
/1a).

Advertising: Beacon

This example shows how you can use the BLEBeacon helper class and advertising
API to configure your Bluefruit nRF52 board as a 'Beacon".

Complete Code

[/ KRRk sk ok ok ok sk ok kR sk ok ok ok sk ok ok sk sk ok kok sk ok ok ok sk ok ok sk sk ok ok sk ok ok sk sk ok ok sk sk ok ok sk ok ok ok skok ok ok k ok
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information

All text above, and the splash screen below must be included in

any redistribution

stk ok sk ok ok ok sk ok ok ok sk ok ok sk ok ok k sk ok ok ok sk ok ok sk sk sk kR sk ok ook sk ok ok sk sk sk kok sk ok ook sk ok ok sk sk ok ok sk ok ok ok /

#include <bluefruit.h>

// Beacon uses the Manufacturer Specific Data field in the advertising

// packet, which means you must provide a valid Manufacturer ID. Update

// the field below to an appropriate value. For a list of valid IDs see:

// https://www.bluetooth.com/specifications/assigned-numbers/company-identifiers
// 0x004C is Apple

// 0x0822 is Adafruit

// 0x0059 is Nordic

#define MANUFACTURER_ID 0x0059

// "nRF Connect" app can be used to detect beacon
uint8_t beaconUuid[16] =

0x01, O0x12, 0x23, 0x34, 0x45, 0x56, 0x67, 0x78,
0x89, 0x9a, Oxab, 0xbc, 0xcd, Oxde, Oxef, Oxf0O
b s

// A valid Beacon packet consists of the following information:
// UUID, Major, Minor, RSSI @ 1M
BLEBeacon beacon(beaconUuid, 0x0102, 0x0304, -54);

void setup()
{
Serial.begin(115200);

// Uncomment to blocking wait for Serial connection
// while ( !Serial ) delay(10);

Serial.println("Bluefruit52 Beacon Example");
SErilal. Praimtlp(Pe=ccccsccccccccccccccccca= \n");
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Bluefruit.begin();

// off Blue LED for lowest power consumption
Bluefruit.autoConnLed(false);
Bluefruit.setTxPower(0); // Check bluefruit.h for supported values

// Manufacturer ID is required for Manufacturer Specific Data
beacon.setManufacturer (MANUFACTURER ID);

// Setup the advertising packet
startAdv();

Serial.println("Broadcasting beacon, open your beacon app to test");

// Suspend Loop() to save power, since we didn't have any code there
suspendLoop();

}

void startAdv(void)

{
// Advertising packet
// Set the beacon payload using the BLEBeacon class populated
// earlier in this example
Bluefruit.Advertising.setBeacon(beacon);

// Secondary Scan Response packet (optional)

// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected

* - Timeout for fast mode is 30 seconds

* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*

*

3

*

Apple Beacon specs
- Type: Non connectable, undirected
- Fixed interval: 100 ms -> fast = slow = 100 ms
/)
//Bluefruit.Advertising.setType(BLE GAP ADV TYPE ADV_NONCONN IND);
Bluefruit.Advertising.restartOnDisconnect(true);

Bluefruit.Advertising.setInterval (160, 160); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising
after n seconds
}

void loop()
{

// loop is already suspended, CPU will not run loop() at all
}

Output

You can use the nRF Beacons application from Nordic Semiconductors to test this
sketch:

« NRF Beacons for iOS (https://adafru.it/vaC)
« NRF Beacons for Android (https://adafru.it/vaD)
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Make sure that you set the UUID, Major and Minor values to match the sketch above,
and then run the sketch at the same time as the nRF Beacons application.

With the default setup you should see a Mona Lisa icon when the beacon is detected.
If you don't see this, double check the UUID, Major and Minor values to be sure they
match exactly.

BLE UART: Controller

This examples shows you you can use the BLEUart helper class and the Bluefruit LE
Connect applications to send based keypad and sensor data to your nRF52.

Setup

In order to use this sketch, you will need to open Bluefruit LE Connect on your mobile
device using our free iOS (https://adafru.it/f4H), Android (https://adafru.it/f4G) or OS X
(https://adafru.it/09F) applications.

- Load the Controller example sketch (https://adafru.it/vaN) in the Arduino IDE

« Compile the sketch and flash it to your nRF52 based Feather

« Once you are done uploading, open the Serial Monitor (Tools > Serial Monitor)
« Open the Bluefruit LE Connect application on your mobile device
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- Connect to the appropriate target (probably 'Bluefruit52')

« Once connected switch to the Controller application inside the app

- Enable an appropriate control surface. The Color Picker control surface is shown
below, for example (screen shot taken from the iOS application):

Color Picker

R: 255 G: 18 B: 48
Hex: #ff1230

As you change the color (or as other data becomes available) you should receive the
data on the nRF52, and see it in the Serial Monitor output:
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Complete Code

[ Rk sk ok ko sk sk sk kR sk ok ok ok sk ok ok sk ok ok sk ok ok ok sk ok ok sk sk ok kok sk ok ok sk sk ok ok sk sk ok ok sk ok ok sk sk ok ok sk k ok
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information
All text above, and the splash screen below must be included in

any redistribution
ko sk ok ok ok sk ok ok sk sk ok ok sk sk ok sk sk ok ok sk sk ok ok sk sk stk sk sk ok ook sk sk ok sk sk sk sk sk sk koksk sk sk okok sk sk skokok sk kok ok ok f

#include <bluefruit.h>

// OTA DFU service
BLEDfu bledfu;

// Uart over BLE service
BLEUart bleuart;

// Function prototypes for packetparser.cpp

uint8_t readPacket (BLEUart *ble uart, uintl6_t timeout);

float parsefloat (uint8_t *buffer);

void printHex (const uint8_t * data, const uint32_t numBytes);

// Packet buffer
extern uint8_t packetbuffer[];

void setup(void)

Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb

Serial.println(F("Adafruit Bluefruit52 Controller App Example"));
Serial.println(F (" ------cmmm oo "));

Bluefruit.begin();
Bluefruit.setTxPower(4); // Check bluefruit.h for supported values

// To be consistent OTA DFU should be added first if it exists
bledfu.begin();

// Configure and start the BLE Uart service
bleuart.begin();

// Set up and start advertising
startAdv();
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Serial.println(F("Please use Adafruit Bluefruit LE app to connect in Controller
mode"));

Serial.println(F("Then activate/use the sensors, color picker, game controller,
etc!"));

Serial.println();
}

void startAdv(void)

{
// Advertising packet

Bluefruit.Advertising.addFlags (BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include the BLE UART (AKA 'NUS') 128-bit UUID
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected

* - Interval: fast mode = 20 ms, slow mode = 152.5 ms

* - Timeout for fast mode is 30 seconds

* - Start(timeout) with timeout = 0 will advertise forever (until connected)

*

* For recommended advertising interval

* https://developer.apple.com/library/content/qa/qal931/ index.html

*/
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising

after n seconds

}

/KRR sk ok ok sk ok kR sk ok ok ok sk ok ok sk sk ok ok sk ok ok ok sk ok ok sk sk ok kR sk ok ok ok skok ok sk sk ok ok sk ok ook skok ok sk sk kokok sk ok ok f
A"

@brief Constantly poll for new command or response data
*/
/**************************************************************************/
void loop(void)

// Wait for new data to arrive
uint8_t len = readPacket(&bleuart, 500);
if (len == 0) return;

// Got a packet!
// printHex(packetbuffer, len);

// Color

if (packetbuffer[l] == 'C') {
uint8_t red = packetbuffer[2];
uint8_t green = packetbuffer[3];
uint8_t blue = packetbuffer[4];
Serial.print ("RGB #");
if (red < 0x10) Serial.print("0");
Serial.print(red, HEX);
if (green < 0x10) Serial.print("0");
Serial.print(green, HEX);
if (blue < 0x10) Serial.print("0");
Serial.println(blue, HEX);

}

// Buttons

if (packetbuffer[1l] == 'B') {
uint8_t buttnum = packetbuffer[2] - '0';
boolean pressed = packetbuffer[3] - '0';
Serial.print ("Button "); Serial.print(buttnum);
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if (pressed) {
Serial.println(" pressed");
} else {
Serial.println(" released");
}

}

// GPS Location
if (packetbuffer[1l] == 'L"') {
float lat, lon, alt;

lat = parsefloat(packetbuffer+2);
lon = parsefloat(packetbuffer+6);
alt = parsefloat(packetbuffer+10);

Serial.print("GPS Location\t");

Serial.print("Lat: "); Serial.print(lat, 4); // 4 digits of precision!
Serial.print('\t"');

Serial.print("Lon: "); Serial.print(lon, 4); // 4 digits of precision!
Serial.print('\t");

Serial.print(alt, 4); Serial.println(" meters");

}

// Accelerometer
if (packetbuffer[1l] == 'A") {

float x, y, z;

X parsefloat(packetbuffer+2);

y parsefloat(packetbuffer+6);
z = parsefloat(packetbuffer+10);
Serial.print("Accel\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

}

// Magnetometer
if (packetbuffer[l] == 'M') {
float x, y, z;

x = parsefloat(packetbuffer+2);
y = parsefloat(packetbuffer+6);
z = parsefloat(packetbuffer+10);

Serial.print("Mag\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

}

// Gyroscope

if (packetbuffer[l] == 'G"') {
float x, y, z;
x = parsefloat(packetbuffer+2);
y = parsefloat(packetbuffer+6);
z parsefloat(packetbuffer+10);
Serial.print("Gyro\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.println();

}

// Quaternions
if (packetbuffer[1l] == 'Q') {
float x, y, z, w;

x = parsefloat(packetbuffer+2);
y = parsefloat(packetbuffer+6);
z = parsefloat(packetbuffer+10);
w = parsefloat(packetbuffer+14);

Serial.print("Quat\t");
Serial.print(x); Serial.print('\t');
Serial.print(y); Serial.print('\t');
Serial.print(z); Serial.print('\t');
Serial.print(w); Serial.println();
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You will also need the following helper class in a file called packetParser.cpp:

#include <string.h>
#include <Arduino.h>
#include <bluefruit.h>

#define PACKET_ACC_LEN (15)

#define PACKET_GYRO_LEN (15)

#define PACKET_MAG_LEN (15)

#define PACKET_QUAT_LEN (19)

#define PACKET BUTTON_ LEN (5)

#define PACKET_COLOR_LEN (6)

#define PACKET_LOCATION_LEN (15)

// READ BUFSIZE Size of the read buffer for incoming packets
#define READ_BUFSIZE (20)

/* Buffer to hold incoming characters */
uint8_t packetbuffer[READ BUFSIZE+1];

sk >k 3k 3k 5k >k >k 3k 5k >k >k 3k 3k 5k >k 5k 3k 5K 5k >k >k 3k >k >k %k 3k 5K 5k >k 5k 3k >k >k %k 5k 5k >k >k 5k 3k 5K >k %k 5k 5K >k >k 5k 3k >k >k %k 3k 5K 5k >k >k 3k 5k >k %k >k >k >k >k %k 3k >k >k %k %k >k >k k
/ /
A"
@brief Casts the four bytes at the specified address to a float
*/
3k 3k 3k 3k 3k 3k 3k 3k 3k >k 5k 3k >k 5k 3k >k 3k 3k 3K 3k 3k 3K 3k 3k 5k 3k 3k 5k 3k 3k 3k 3k 3K 3k 3k 5k 3k 3k 5k 3k 3k 5k 3k 3k 3k 3k 5k 3k 3k 5k 3k 3k 5k >k 3k 3k >k 5k >k >k 5k >k >k 5k >k >k 5k >k >k >k >k >k ko k
/ /

float parsefloat(uint8_t *buffer)

float f;
memcpy (&f, buffer, 4);
return f;

}

/KRR sk ok ok sk sk sk R sk ok ok ok sk ok ok sk sk ok ok sk ok ok ok sk ok ok sk ok ok ok sk ok okosk sk ok ok sk sk ok ok sk ok ook ko ok sk sk kokok sk ok ok f
A"
@brief Prints a hexadecimal value in plain characters
@param data Pointer to the byte data
@param numBytes Data length in bytes
*/
/**************************************************************************/
void printHex(const uint8_t * data, const uint32_t numBytes)
{
uint32_t szPos;
for (szPos=0; szPos < numBytes; szPos++)

{
Serial.print(F("0x"));
// Append leading 0 for small values
if (data[szPos] <= 0OxF)
{
Serial.print(F("0"));
Serial.print(data[szPos] & Oxf, HEX);
}
else
{
Serial.print(data[szPos] & Oxff, HEX);
}
// Add a trailing space if appropriate
if ((numBytes > 1) && (szPos != numBytes - 1))
{
Serial.print(F(" "));
}
}
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}

Serial.println();

/**************************************************************************/

/*
*/

@brief Waits for incoming data and parses it

[ KRR KKK KKK KR R R oK oK oK KoK KK KKK R K K oK oK K KKK KKK R K oK oK oK oK oK KK KKK R KSR oK oK oK KKK KRR R KoK oK Sk ok ko ok
uint8_t readPacket(BLEUart *ble uart, uintl6_t timeout)

{

uintl6é_t origtimeout = timeout, replyidx = 0;

memset (packetbuffer, 0, READ BUFSIZE);

while (timeout--) {

}

if (replyidx >= 20) break;

if ((packetbuffer[1] == 'A') & (replyidx == PACKET_ACC_LEN))
ifb??::éketbuffer[ll == 00 e (replyaent == e @R LA
ifb??ggéketbuffer[ll == ) e (Fepliteke == PRERET LG HE))
ifb??ggéketbuffer[ll == '0") && (replyidx == PACKET_QUAT_LEN))
ifb??::éketbuffer[ll == ) s (replyneht s= PG BInTe A
ifb??ggéketbuffer[ll D TG s (rEplaeht o PN CUHR [HA))
if:??ggéketbuffer[ll == 'L') & (replyidx == PACKET LOCATION LEN))
reak;

while (ble uart->available()) {

char ¢ = ble uart->read()
if (c=="1") {
replyidx = 0;

packetbuffer[replyidx] = c;
replyidx++;
timeout = origtimeout;

}

if (timeout == 0) break;
delay(1l);

packetbuffer[replyidx] = 0; // null term

if (!replyidx) // no data or timeout

return 0;

if (packetbuffer[0] !'= '!') // doesn't start with '!' packet beginning

return 0;

// check checksum!
uint8_t xsum = 0;
uint8_t checksum = packetbuffer[replyidx-1];

for (uint8 t i=0; i<replyidx-1; i++) {

}

xsum += packetbuffer[i];

Xsum = ~Xsum;

// Throw an error message if the checksum's don't match
if (xsum != checksum)

{

}

Serial.print("Checksum mismatch in packet : ");
printHex(packetbuffer, replyidx+l);
return 0;
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// checksum passed!
return replyidx;

}

Custom: HRM

The BLEService and BLECharacteristic classes can be used to implement any custom
or officially adopted BLE service of characteristic using a set of basic properties and
callback handlers.

The example below shows how to use these classes to implement the Heart Rate
Monitor (https://adafru.it/vaO) service, as defined by the Bluetooth SIG.

HRM Service Definition

UUID: 0x180D (https://adafru.it/vaO)

Characteristic Name UuID Requirement Properties
Heart Rate Measurement Ox2A37 Mandatory Notify
Body Sensor Location Ox2A38 Optional Read
Heart Rate Control Point Ox2A39 Conditional Write

Only the first characteristic is mandatory, but we will also implement the optional Body
Sensor Location characteristic. Heart Rate Control Point won't be used in this example
to keep things simple.

Implementing the HRM Service and
Characteristics

The core service and the first two characteristics can be implemented with the
following code:

First, define the BLEService and BLECharacteristic variables that will be used in your
project:

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: Ox2A38
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https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.heart_rate.xml
https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.heart_rate.xml
https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.heart_rate.xml
https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteristic.heart_rate_measurement.xml
https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteristic.body_sensor_location.xml
https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.characteristic.heart_rate_control_point.xml

&

BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16 SVC HEART RATE);
BLECharacteristic(UUID16 CHR _HEART RATE MEASUREMENT);
BLECharacteristic(UUID16 CHR BODY SENSOR LOCATION);

Then you need to 'populate' those variables with appropriate values. For simplicity
sake, you can define a custom function for your service where all of the code is
placed, and then just call this function once in the 'setup' function:

void setupHRM(void)
{

// Configure the Heart Rate Monitor service

// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.service.heart rate.xml

// Supported Characteristics:

// Name UUID Requirement Properties

[/ coccoccooo000c000000000000000 900000 COOODODO000 COCOCCC00D

// Heart Rate Measurement 0x2A37 Mandatory  Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write &lt;-- Not used
here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was ‘'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Permission = Notify

// Min Len =1

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0@ = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)

// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but

contact not detected, 3 = Supported and detected)

// b0o = Value format (0 = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties(CHR_PROPS NOTIFY);

hrmc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd_callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdatal[2] = { 0b00000110, O0x40 }; // Set the characteristic to use 8-bit
values, with the sensor connected and detected

hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Permission = Read

// Min Len = 1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
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// 4 = Hand
// 5 = Ear Lobe
// 6 = Foot
// 7:255 = Reserved

bslc.setProperties(CHR _PROPS READ);
bslc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);
bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)

Service + Characteristic Setup Code Analysis

1. The first thing to do is to call .begin() on the BLEService (hrms above). Since the
UUID is set in the object declaration at the top of the sketch, there is normally nothing
else to do with the BLEService instance.

You MUST call .begin() on the BLEService before adding any BLECharacteristics.

Any BLECharacteristic will automatically be added to the last BLEService that

was ‘begin()'ed!

2. Next, you can configure the Heart Rate Measurement characteristic (hrmc above).
The values that you set for this will depend on the characteristic definition, but for
convenience sake we've documented the key information in the comments in the
code above.

«'"hrmc.setProperties (CHR PROPS NOTIFY); '- This sets the PROPERTIES
value for the characteristic, which determines how the characteristic can be
accessed. In this case, the Bluetooth SIG has defined the characteristic
as Notify, which means that the peripheral will receive a request ('notification')
from the Central when the Central wants to receive data using this
characteristic.

« hrmc.setPermission(SECMODE OPEN, SECMODE NO ACCESS); " - This sets

the security for the characteristic, and should normally be set to the values used

in this example.

“hrmc.setFixedLen(2); " - This tells the Bluetooth stack how many bytes the

characteristic contains (normally a value between 1 and 20). In this case, we will

use a fixed size of two bytes, so we call .setFixedLen. If the characteristic has a

variable length, you would need to set the max size via .setMaxLen.
"hrmc.setCccdWriteCallback(cccd callback); '- This optional code sets
the callback that will be fired when the CCCD record is updated by the central.
This is relevant because the characteristic is setup with the NOTIFY property.
When the Central sets to 'Notify' bit, it will write to the CCCD record, and you
can capture this write even in the CCCD callback and turn the sensor on, for

©Adafruit Industries Page 51 of 176



example, allowing you to save power by only turning the sensor on (and back
off) when it is or isn't actually being used. For the implementation of the CCCD
callback handler, see the full sample code at the bottom of this page.

«'"hrmc.begin(); ' Once all of the properties have been set, you must call .begi
n() which will add the characteristic definition to the last BLEService that was
"begin()ed".

3. Optionally set an initial value for the characteristic(s), such as the following code
that populates 'hrmc' with a correct values, indicating that we are providing 8-bit heart
rate monitor values, that the Body Sensor Location characteristic is present, and
setting the first heart rate value to Ox04:

Note that we use .notify() in the example above instead of .write(), since this

characteristic is setup with the NOTIFY property which needs to be handled in a

slightly different manner than other characteristics.

// Set the characteristic to use 8-bit values, with the sensor connected and
detected
uint8 t hrmdata[2] = { 0b00000110, Ox40 };

// Use .notify instead of .write!
hrmc.notify(hrmdata, 2);

The CCCD callback handler has the following signature:

void cccd callback(uintl6 t conn hdl, BLECharacteristic* chr, uintl6 t cccd value)
{

// Display the raw request packet

Serial.print("CCCD Updated: ");

//Serial.printBuffer(request-&gt;data, request-&gt;len);

Serial.print(cccd value);

Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr-&gt;uuid == htmc.uuid) {
if (chr-&gt;indicateEnabled(conn_hdl)) {
Serial.println("Temperature Measurement 'Indicate' enabled");
} else {
Serial.println("Temperature Measurement 'Indicate' disabled");
}

4. Repeat the same procedure for any other BLECharacteristics in your service.
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Full Sample Code

The full sample code for this example can be seen below:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information

All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/

#include <bluefruit.h>

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: Ox2A38
W/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16 SVC HEART RATE);
BLECharacteristic (UUID16 CHR HEART RATE MEASUREMENT);
BLECharacteristic (UUID16 CHR BODY SENSOR LOCATION);

BLEDis bledis; // DIS (Device Information Service) helper class instance
BLEBas blebas; // BAS (Battery Service) helper class instance

uint8_t bps = 0;

void setup()
{
Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb

Serial.println("Bluefruit52 HRM Example");
Serial.println("--------------ccoommo-- \n");

// Initialise the Bluefruit module
Serial.println("Initialise the Bluefruit nRF52 module");
Bluefruit.begin();

// Set the connect/disconnect callback handlers
Bluefruit.Periph.setConnectCallback(connect callback);
Bluefruit.Periph.setDisconnectCallback(disconnect callback);

// Configure and Start the Device Information Service
Serial.println("Configuring the Device Information Service");
bledis.setManufacturer("Adafruit Industries");
bledis.setModel ("Bluefruit Feather52");

bledis.begin();

// Start the BLE Battery Service and set it to 100%
Serial.println("Configuring the Battery Service");
blebas.begin();

blebas.write(100);

// Setup the Heart Rate Monitor service using

// BLEService and BLECharacteristic classes
Serial.println("Configuring the Heart Rate Monitor Service");
setupHRM() ;
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// Setup the advertising packet(s)
Serial.println("Setting up the advertising payload(s)");
startAdv();

Serial.println("Ready Player One!!!");
Serial.println("\nAdvertising");

}

void startAdv(void)

{
// Advertising packet
Bluefruit.Advertising.addFlags (BLE_GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include HRM Service UUID
Bluefruit.Advertising.addService(hrms);

// Include Name
Bluefruit.Advertising.addName();

/* Start Advertising

* - Enable auto advertising if disconnected
* - Interval: fast mode = 20 ms, slow mode = 152.5 ms
* - Timeout for fast mode is 30 seconds
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
* For recommended advertising interval
* https://developer.apple.com/library/content/qa/qal931/ index.html
WY
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising
after n seconds
}
void setupHRM(void)
{

// Configure the Heart Rate Monitor service

// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.service.heart rate.xml

// Supported Characteristics:

// Name UUID Requirement Properties

/[ =eeeeeecssccoccocooosso20000 2o00ss  So9S0S0000SS Cooooo0000

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was 'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Properties = Notify

// Min Len =1

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0 = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)

// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but
contact not detected, 3 = Supported and detected)

// b0o = Value format (0 = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
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// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules
// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties(CHR PROPS NOTIFY);

hrmc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdata[2] = { 0b00OEO110, Ox40 }; // Set the characteristic to use 8-bit
values, with the sensor connected and detected

hrmc.write(hrmdata, 2);

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Properties = Read

// Min Len = 1l

// Max Len = 1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties(CHR _PROPS READ);
bslc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);
bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)
}
void connect_callback(uintl6_t conn_handle)
{

// Get the reference to current connection
BLEConnection* connection = Bluefruit.Connection(conn_handle);

char central name[32] = { 0 };
connection->getPeerName(central name, sizeof(central name));

Serial.print("Connected to ");
Serial.println(central name);

}

/**
* Callback invoked when a connection is dropped
* @param conn_handle connection where this event happens
* @param reason is a BLE HCI STATUS CODE which can be found in ble_hci.h
*/
void disconnect_callback(uintl6_t conn _handle, uint8_t reason)
{
(void) conn_handle;
(void) reason;

Serial.print("Disconnected, reason = 0x"); Serial.println(reason, HEX);
Serial.println("Advertising!");

}

void cccd_callback(uintl6_t conn hdl, BLECharacteristic* chr, uintl6_t cccd value)

{
// Display the raw request packet
Serial.print("CCCD Updated: ");
//Serial.printBuffer(request->data, request->len);
Serial.print(cccd value);
Serial.println("");

// Check the characteristic this CCCD update is associated with in case
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// this handler is used for multiple CCCD records.
if (chr->uuid == hrmc.uuid) {
if (chr->notifyEnabled(conn hdl)) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
}

}
void loop()
digitalToggle(LED RED);

if ( Bluefruit.connected() ) {
uint8_t hrmdata[2] = { 0b00000110, bps++ }; // Sensor connected,
increment BPS value

// Note: We use .notify instead of .write!
// If it is connected but CCCD is not enabled
// The characteristic's value is still updated although notification is not sent
if ( hrmc.notify(hrmdata, sizeof(hrmdata)) ){
Serial.print("Heart Rate Measurement updated to: "); Serial.println(bps);
}else{
Serial.println("ERROR: Notify not set in the CCCD or not connected!");
}
}

// Only send update once per second
delay(1000);
}

BLE Pin I/O

Firmata is a generic protocol for communicating with microcontrollers and controlling
the board's pins such as setting the GPIO outputs and inputs, PWM output, analog
reads, etc....

Setup

In order to run this demo, you will need to open Bluefruit LE Connect on your mobile
device using our free i0S (https://adafru.it/f4H), Android (https://adafru.it/f4G) or OS X
(https://adafru.it/09F) applications.

- Load the StandardFirmataBLE example sketch (https://adafru.it/Bl4) in the
Arduino IDE

« Compile the sketch and flash it to your nRF52 based Feather

« Once you are done uploading, open the Serial Monitor (Tools > Serial Monitor)

« Open the Bluefruit LE Connect application on your mobile device

« Connect to the appropriate target (probably 'Bluefruit52')

« Once connected switch to the Pin I/O application inside the app
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https://itunes.apple.com/app/adafruit-bluefruit-le-connect/id830125974?mt=8
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://itunes.apple.com/us/app/adafruit-bluefruit-le-connect/id1082414600?mt=12
https://github.com/adafruit/Adafruit_nRF52_Arduino/tree/master/libraries/Bluefruit52Lib/examples/Peripheral/StandardFirmataBLE
https://github.com/adafruit/Adafruit_nRF52_Arduino/tree/master/libraries/Bluefruit52Lib/examples/Peripheral/StandardFirmataBLE

For more information using Pin I/O module, you could check out this tutorial
here https://learn.adafruit.com/bluefruit-le-connect-for-ios/pin-i-o

Complete Code

The latest version of this code is always available on Github (https://adafru.it/vaN),
and in the Examples folder of the nRF52 BSP.

The code below is provided for convenience sake, but may be out of date! See

the link above for the latest code.

/*
Firmata is a generic protocol for communicating with microcontrollers
from software on a host computer. It is intended to work with
any host computer software package.

To download a host software package, please click on the following link
to open the list of Firmata client libraries in your default browser.

https://github.com/firmata/arduino#firmata-client-libraries

Copyright (C) 2006-2008 Hans-Christoph Steiner. All rights reserved.
Copyright (C) 2010-2011 Paul Stoffregen. All rights reserved.
Copyright (C) 2009 Shigeru Kobayashi. All rights reserved.

Copyright (C) 2009-2016 Jeff Hoefs. All rights reserved.

This library is free software; you can redistribute it and/or
modify it under the terms of the GNU Lesser General Public
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// Adafruit nRF52 Boards require Firmata version is at least 2.5.7

#include <bluefruit.h>
#include <Servo.h>
#include <Wire.h>
#include <Firmata.h>

#define I2C_WRITE BO000000O
#define I2C_READ B00001000
#define I2C_READ_CONTINUOUSLY B00010000O
#define I2C_STOP_READING B00011000

#define I2C_READ_WRITE_MODE_MASK  B00011000
#define I2C_10BIT_ADDRESS_MODE_MASK B00100000

#define I2C_END_TX_MASK B01000000
#define I2C_STOP_TX 1
#define I2C_RESTART_TX 0
#define I2C_MAX_QUERIES 8

#define I2C_REGISTER_NOT_SPECIFIED -1

// the minimum interval for sampling analog input
#define MINIMUM_SAMPLING_INTERVAL 1

// Adafruit
uint8_t ANALOG_TO PIN(uint8_t n)

{
switch (n)
{
case 0 : return PIN AO;
case 1 : return PIN Al;
case 2 : return PIN A2;
case 3 : return PIN A3;
case 4 : return PIN A4;
case 5 : return PIN A5;
case 6 : return PIN AG;
case 7 : return PIN A7;
}
return 127;
}
/ B S o ===
* GLOBAL VARIABLES
* = s * /

#ifdef FIRMATA_SERIAL_FEATURE
SerialFirmata serialFeature;
#endif

BLEUart bleuart;

/* analog inputs */
int analogInputsToReport = 0; // bitwise array to store pin reporting

/* digital input ports */
byte reportPINs[TOTAL PORTS]; // 1 = report this port, 0 = silence
byte previousPINs[TOTAL PORTS]; // previous 8 bits sent

/* pins configuration */
byte portConfigInputs[TOTAL PORTS]; // each bit: 1 = pin in INPUT, O = anything else

/* timer variables */
unsigned long currentMillis; // store the current value from millis()
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unsigned long previousMillis; // for comparison with currentMillis
unsigned int samplingInterval = 19; // how often to run the main loop (in ms)

/* i2c data */
struct i2c_device_info {
byte addr;
int reg;
byte bytes;
byte stopTX;
b

/* for i2c read continuous more */
i2c _device _info query[I2C MAX QUERIES];

byte i2cRxData[64];

boolean isI2CEnabled = false;

signed char queryIndex = -1;

// default delay time between i2c read request and Wire.requestFrom()
unsigned int i2cReadDelayTime = 0;

Servo servos[MAX SERVOS];

byte servoPinMap[TOTAL PINS];
byte detachedServos[MAX SERVO0S];
byte detachedServoCount = 0;
byte servoCount = 0;

boolean isResetting = false;

// Forward declare a few functions to avoid compiler errors with older versions
// of the Arduino IDE.

void setPinModeCallback(byte, int);

void reportAnalogCallback(byte analogPin, int value);

void sysexCallback(byte, byte, byte*);

/* utility functions */
void wireWrite(byte data)
{
#if ARDUINO >= 100
Wire.write((byte)data);
#else
Wire.send(data);
#endif
}

byte wireRead(void)
{
#if ARDUINO >= 100
return Wire.read();
#else
return Wire.receive();
#endif

void attachServo(byte pin, int minPulse, int maxPulse)
{
if (servoCount < MAX SERVOS) {
// reuse indexes of detached servos until all have been reallocated
if (detachedServoCount > 0) {
servoPinMap[pin] = detachedServos[detachedServoCount - 1];
if (detachedServoCount > 0) detachedServoCount--;
} else {
servoPinMap[pin] = servoCount;
servoCount++;

if (minPulse > 0 && maxPulse > 0) {
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servos[servoPinMap[pin]].attach(PIN TO DIGITAL(pin), minPulse, maxPulse);
} else {
servos[servoPinMap[pin]].attach(PIN TO DIGITAL(pin));
}
} else {
Firmata.sendString("Max servos attached");
}

}

void detachServo(byte pin)
{
servos[servoPinMap[pin]].detach();
// if we're detaching the last servo, decrement the count
// otherwise store the index of the detached servo
if (servoPinMap[pin] == servoCount && servoCount > 0) {
servoCount--;
} else if (servoCount > 0) {
// keep track of detached servos because we want to reuse their indexes
// before incrementing the count of attached servos
detachedServoCount++;
detachedServos[detachedServoCount - 1] = servoPinMap[pin];

}

servoPinMap[pin] = 255;
}

void enableI2CPins()
{
byte i;
// 1is there a faster way to do this? would probaby require importing
// Arduino.h to get SCL and SDA pins
for (i = 0; i < TOTAL_PINS; i++) {
if (IS PIN I2C(i)) {
// mark pins as i2c so they are ignore in non i2c data requests
setPinModeCallback(i, PIN MODE I2C);
}
}

isI2CEnabled = true;

Wire.begin();

}

/* disable the i2c pins so they can be used for other functions */
void disableI2CPins() {

isI2CEnabled = false;

// disable read continuous mode for all devices

queryIndex = -1;

void readAndReportData(byte address, int theRegister, byte numBytes, byte stopTX) {
// allow I2C requests that don't require a register read
// for example, some devices using an interrupt pin to signify new data available
// do not always require the register read so upon interrupt you call
Wire.requestFrom()
if (theRegister != I2C REGISTER NOT SPECIFIED) {
Wire.beginTransmission(address);
wireWrite((byte)theRegister);
Wire.endTransmission(stopTX); // default = true
// do not set a value of 0
if (i2cReadDelayTime > 0) {
// delay is necessary for some devices such as WiiNunchuck
delayMicroseconds (i2cReadDelayTime);

}
} else {

theRegister = 0; // fill the register with a dummy value
}

Wire.requestFrom(address, numBytes); // all bytes are returned in requestFrom
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// check to be sure correct number of bytes were returned by slave
if (numBytes < Wire.available()) {

Firmata.sendString("I2C: Too many bytes received");
} else if (numBytes > Wire.available()) {

Firmata.sendString("I2C: Too few bytes received");

}
i2cRxData[0] = address;
i2cRxData[l] = theRegister;

for (int i = 0; i < numBytes && Wire.available(); i++) {
i2cRxData[2 + i] = wireRead();
}

// send slave address, register and received bytes
Firmata.sendSysex(SYSEX I2C REPLY, numBytes + 2, i2cRxData);
}

void outputPort(byte portNumber, byte portValue, byte forceSend)
{
// pins not configured as INPUT are cleared to zeros
portValue = portValue & portConfigInputs[portNumber];
// only send if the value is different than previously sent
if (forceSend || previousPINs[portNumber] != portValue) {
Firmata.sendDigitalPort(portNumber, portValue);
previousPINs[portNumber] = portValue;

* check all the active digital inputs for change of state, then add any events

* to the Serial output queue using Serial.print() */
void checkDigitalInputs(void)
{

/* Using non-looping code allows constants to be given to readPort().

* The compiler will apply substantial optimizations if the inputs
* to readPort() are compile-time constants. */

if (TOTAL PORTS > 0 && reportPINs[0]) outputPort(0, readPort(0,
portConfigInputs[0]), false);

if (TOTAL _PORTS > 1 && reportPINs[1]) outputPort(1l, readPort(1,
portConfigInputs[1l]), false);

if (TOTAL PORTS > 2 && reportPINs[2]) outputPort(2, readPort(2,
portConfigInputs[2]), false);

if (TOTAL _PORTS > 3 && reportPINs[3]) outputPort(3, readPort(3,
portConfigInputs[3]), false);

if (TOTAL _PORTS > 4 && reportPINs[4]) outputPort(4, readPort(4,
portConfigInputs[4]), false);

if (TOTAL PORTS > 5 && reportPINs[5]) outputPort(5, readPort(5,
portConfigInputs[5]), false);

if (TOTAL PORTS > 6 && reportPINs[6]) outputPort(6, readPort(6,
portConfigInputs[6]), false);

if (TOTAL PORTS > 7 && reportPINs[7]) outputPort(7, readPort(7,
portConfigInputs[7]), false);

if (TOTAL _PORTS > 8 && reportPINs[8]) outputPort(8, readPort(8,
portConfigInputs[8]), false);

if (TOTAL PORTS > 9 && reportPINs[9]) outputPort(9, readPort(9,
portConfigInputs[9]), false);

if (TOTAL PORTS > 10 && reportPINs[10]) outputPort(10, readPort(10,
portConfigInputs[10]), false);

if (TOTAL _PORTS > 11 && reportPINs[11]) outputPort(1ll, readPort(11,
portConfigInputs[11l]), false);

if (TOTAL PORTS > 12 && reportPINs[12]) outputPort(12, readPort(12,
portConfigInputs[12]), false);

if (TOTAL PORTS > 13 && reportPINs[13]) outputPort(13, readPort(13,
portConfigInputs[13]), false);

if (TOTAL _PORTS > 14 && reportPINs[14]) outputPort(14, readPort(14,
portConfigInputs[14]), false);

if (TOTAL PORTS > 15 && reportPINs[15]) outputPort(1l5, readPort(15,
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portConfigInputs[15]), false);
}

[fl ee=ee=csscccscoconccs25000c00500500000°5000005500000°0000C0S000000000SSSSo00
/* sets the pin mode to the correct state and sets the relevant bits in the

* two bit-arrays that track Digital I/0 and PWM status

/)
void setPinModeCallback(byte pin, int mode)

if (Firmata.getPinMode(pin) == PIN_MODE IGNORE)
return;

if (Firmata.getPinMode(pin) == PIN MODE I2C && isI2CEnabled && mode !=
PIN MODE I2C) {
// disable i2c so pins can be used for other functions
// the following if statements should reconfigure the pins properly
disableI2CPins();

}
if (IS PIN DIGITAL(pin) && mode != PIN MODE SERVO) {
if (servoPinMap[pin] < MAX SERVOS && servos[servoPinMap[pin]].attached()) {
detachServo(pin);

}

}
if (IS _PIN ANALOG(pin)) {
reportAnalogCallback(PIN TO ANALOG(pin), mode == PIN MODE ANALOG ? 1 : 0); //
turn on/off reporting

}
if (IS _PIN DIGITAL(pin)) {
if (mode == INPUT || mode == PIN MODE PULLUP) {
portConfigInputs[pin / 8] |= (1 << (pin & 7))
} else {
portConfigInputs[pin / 8] &= ~(1 << (pin & 7));
}

}
Firmata.setPinState(pin, 0);
switch (mode) {
case PIN MODE ANALOG:
if (IS _PIN ANALOG(pin)) {
if (IS _PIN DIGITAL(pin)) {
pinMode (PIN TO DIGITAL(pin), INPUT); // disable output driver
#if ARDUINO <= 100
// deprecated since Arduino 1.0.1 - TODO: drop support in Firmata 2.6
digitalWrite(PIN TO DIGITAL(pin), LOW); // disable internal pull-ups
#endif
}
Firmata.setPinMode(pin, PIN_MODE_ ANALOG) ;
}
break;
case INPUT:
// Adafruit: Input without pull up cause pin state changes randomly --> lots of
transmission data

// if (IS _PIN DIGITAL(pin)) {

// pinMode (PIN _TO DIGITAL(pin), INPUT); // disable output driver
//#if ARDUINO <= 100

// // deprecated since Arduino 1.0.1 - TODO: drop support in Firmata 2.6
// digitalWrite(PIN TO DIGITAL(pin), LOW); // disable internal pull-ups
//#endif

// Firmata.setPinMode(pin, INPUT);

// }

// break;

case PIN MODE PULLUP:
if (IS PIN DIGITAL(pin)) {
pinMode (PIN TO DIGITAL(pin), INPUT PULLUP);
Firmata.setPinMode(pin, PIN_MODE_ PULLUP);
Firmata.setPinState(pin, 1);
)
break;
case OUTPUT:
if (IS PIN DIGITAL(pin)) {
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if (Firmata.getPinMode(pin) == PIN_MODE PWM) {
// Disable PWM if pin mode was previously set to PWM.
digitalWrite(PIN TO DIGITAL(pin), LOW);

}
pinMode (PIN TO DIGITAL(pin), OUTPUT);
Firmata.setPinMode(pin, OUTPUT);
}
break;
case PIN MODE PWM:
if (IS PIN PWM(pin)) {
pinMode (PIN TO PWM(pin), OUTPUT);
analogWrite(PIN TO PWM(pin), 0);
Firmata.setPinMode(pin, PIN_MODE_PWM);
}
break;
case PIN MODE SERVO:
if (IS PIN DIGITAL(pin)) {
Firmata.setPinMode(pin, PIN_MODE SERVO);
if (servoPinMap[pin] == 255 || !servos[servoPinMap[pin]].attached()) {
// pass -1 for min and max pulse values to use default values set
// by Servo library
attachServo(pin, -1, -1);
}
}
break;
case PIN MODE I2C:
if (IS PIN I2C(pin)) {
// mark the pin as i2c
// the user must call I2C CONFIG to enable I2C for a device
Firmata.setPinMode(pin, PIN_MODE I2C);
}

break;
case PIN MODE SERTIAL:
#ifdef FIRMATA_ SERIAL_FEATURE
serialFeature.handlePinMode(pin, PIN _MODE SERIAL);
#endif
break;
default:
Firmata.sendString("Unknown pin mode"); // TODO: put error msgs in EEPROM

// TODO: save status to EEPROM here, if changed
}

* Sets the value of an individual pin. Useful if you want to set a pin value but
* are not tracking the digital port state.
* Can only be used on pins configured as OUTPUT.
* Cannot be used to enable pull-ups on Digital INPUT pins.
*/
void setPinValueCallback(byte pin, int value)
{
if (pin < TOTAL PINS && IS PIN DIGITAL(pin)) {
if (Firmata.getPinMode(pin) == OUTPUT) {
Firmata.setPinState(pin, value);
digitalWrite(PIN TO DIGITAL(pin), value);
}
}
}

void analogWriteCallback(byte pin, int value)

if (pin < TOTAL_PINS) {
switch (Firmata.getPinMode(pin)) {

case PIN MODE SERVO:

if (IS PIN DIGITAL(pin))
servos[servoPinMap[pin]].write(value);

Firmata.setPinState(pin, value);
break;

case PIN MODE PWM:
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if (IS_PIN PWM(pin))
analogWrite(PIN TO PWM(pin), value);
Firmata.setPinState(pin, value);
break;
}
}
}

void digitalWriteCallback(byte port, int value)

{
byte pin, lastPin, pinValue, mask = 1, pinWriteMask = 0;

if (port < TOTAL_PORTS) {
// create a mask of the pins on this port that are writable.
lastPin = port * 8 + 8;
if (lastPin > TOTAL PINS) lastPin = TOTAL PINS;
for (pin = port * 8; pin < lastPin; pin++) {
// do not disturb non-digital pins (eg, Rx & Tx)
if (IS PIN DIGITAL(pin)) {
// do not touch pins in PWM, ANALOG, SERVO or other modes
if (Firmata.getPinMode(pin) == OUTPUT || Firmata.getPinMode(pin) == INPUT) {
pinValue = ((byte)value & mask) ? 1 : 0;
if (Firmata.getPinMode(pin) == OUTPUT) {
pinWriteMask |= mask;
} else if (Firmata.getPinMode(pin) == INPUT && pinValue == 1 &&
Firmata.getPinState(pin) != 1) {
// only handle INPUT here for backwards compatibility
#if ARDUINO > 100
pinMode(pin, INPUT_ PULLUP);
#else
// only write to the INPUT pin to enable pullups if Arduino v1.0.0 or
earlier
pinWriteMask |= mask;

}

Firmata.setPinState(pin, pinValue);

#endif

}
}
mask = mask << 1;
}
writePort(port, (byte)value, pinWriteMask);
}
}

[l/ ===cc=cscccccccccc55555005050000000CS0SSS0C0000000000C0ES6555050000000000SGSS
/* sets bits in a bit array (int) to toggle the reporting of the analogIns
*/
//void FirmataClass::setAnalogPinReporting(byte pin, byte state) {
//}
void reportAnalogCallback(byte analogPin, int value)

if (analogPin < TOTAL_ ANALOG PINS) {
if (value == 0) {
analogInputsToReport = analogInputsToReport & ~ (1 << analogPin);
} else {
analogInputsToReport = analogInputsToReport | (1 << analogPin);
// prevent during system reset or all analog pin values will be reported
// which may report noise for unconnected analog pins
if (!isResetting) {
// Send pin value immediately. This is helpful when connected via
// ethernet, wi-fi or bluetooth so pin states can be known upon
// reconnecting.
Firmata.sendAnalog(analogPin, analogRead( ANALOG TO PIN(analogPin) ) );
}
}

// TODO: save status to EEPROM here, if changed
}
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void reportDigitalCallback(byte port, int value)

if (port < TOTAL_PORTS) {
reportPINs[port] = (byte)value;
// Send port value immediately. This is helpful when connected via
// ethernet, wi-fi or bluetooth so pin states can be known upon
// reconnecting.
if (value) outputPort(port, readPort(port, portConfigInputs[port]), true);

// do not disable analog reporting on these 8 pins, to allow some

// pins used for digital, others analog. Instead, allow both types

// of reporting to be enabled, but check if the pin is configured

// as analog when sampling the analog inputs. Likewise, while

// scanning digital pins, portConfigInputs will mask off values from any
// pins configured as analog

void sysexCallback(byte command, byte argc, byte *argv)
{

byte mode;

byte stopTX;

byte slaveAddress;

byte data;

int slaveRegister;

unsigned int delayTime;

switch (command) {
case I2C REQUEST:
mode = argv[1l] & I2C READ WRITE MODE MASK;
if (argv[1l] & I2C 10BIT ADDRESS MODE MASK) {
Firmata.sendString("10-bit addressing not supported");
return;
}
else {
slaveAddress = argv[0];

}

// need to invert the logic here since 0 will be default for client
// libraries that have not updated to add support for restart tx
if (argv[1l] & I2C END TX MASK) {
stopTX = I2C RESTART TX;
}
else {
stopTX = I2C STOP TX; // default
}

switch (mode) {
case I2C WRITE:
Wire.beginTransmission(slaveAddress);
for (byte i = 2; i < argc; 1 +=2) {
data = argv[i] + (argv[i + 1] << 7);
wireWrite(data);
}
Wire.endTransmission();
delayMicroseconds(70);
break;
case I2C READ:
if (argc == 6) {
// a slave register is specified
slaveRegister = argv[2] + (argv[3] << 7);
data = argv[4] + (argv[5] << 7); // bytes to read
}
else {
// a slave register is NOT specified
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slaveRegister = I2C REGISTER NOT SPECIFIED;
data = argv[2] + (argv[3] << 7); // bytes to read

readAndReportData(slaveAddress, (int)slaveRegister, data, stopTX);
break;
case I2C READ CONTINUOUSLY:
if ((queryIndex + 1) >= I2C MAX QUERIES) {
// too many queries, just ignore
Firmata.sendString("too many queries");

break;
¥
if (argc == 6) {
// a slave register is specified
slaveRegister = argv[2] + (argv[3] << 7);
data = argv[4] + (argv[5] << 7); // bytes to read
}
else {
// a slave register is NOT specified
slaveRegister = (int)I2C REGISTER NOT SPECIFIED;
data = argv[2] + (argv[3] << 7); // bytes to read
}
queryIndex++;

query[queryIndex].addr = slaveAddress;
query[queryIndex].reg = slaveRegister;
query[queryIndex].bytes = data;
query[queryIndex].stopTX = stopTX;
break;
case I2C STOP_READING:
byte queryIndexToSkip;
// if read continuous mode is enabled for only 1 i2c device, disable
// read continuous reporting for that device
if (queryIndex <= 0) {
queryIndex = -1;
} else {
queryIndexToSkip = 0;
// if read continuous mode is enabled for multiple devices,
// determine which device to stop reading and remove it's data from
// the array, shifiting other array data to fill the space
for (byte i = 0; i < queryIndex + 1; i++) {
if (query[i].addr == slaveAddress) {
queryIndexToSkip = 1i;
break;
}
}

for (byte i = queryIndexToSkip; i < queryIndex + 1; i++) {
if (i < I2C _MAX QUERIES) {
query[i].addr = query[i + 1].addr;
query[i].reg = query[i + 1].reg;
query[i] .bytes = query[i + 1].bytes;
query[i].stopTX = query[i + 1].stopTX;

}

queryIndex--;

}
break;
default:
break;
}

break;
case I2C CONFIG:
delayTime = (argv[0] + (argv[l] << 7));

if (delayTime > 0) {
i2cReadDelayTime = delayTime;
}

if ('isI2CEnabled) {
enableI2CPins();

©Adafruit Industries Page 66 of 176



}

break;
case SERVO CONFIG:
if (argc > 4) {
// these vars are here for clarity, they'll optimized away by the compiler
byte pin = argv[0];
int minPulse argv[l] + (argv[2] << 7);
int maxPulse argv[3] + (argv[4] << 7);

if (IS PIN DIGITAL(pin)) {
if (servoPinMap[pin] < MAX SERVOS && servos[servoPinMap[pin]].attached())

detachServo(pin);

attachServo(pin, minPulse, maxPulse);
setPinModeCallback(pin, PIN MODE SERVO);
}
}
break;
case SAMPLING INTERVAL:
if (argc > 1) {
samplingInterval = argv[0] + (argv[l] << 7);
if (samplingInterval < MINIMUM SAMPLING INTERVAL) {
samplingInterval = MINIMUM SAMPLING INTERVAL;

}
} else {
//Firmata.sendString("Not enough data");
¥
break;
case EXTENDED ANALOG:
if (argc > 1) {
int val = argv[1];
if (argc > 2) val |= (argv[2] << 7);
if (argc > 3) val |= (argv[3] << 14);
analogWriteCallback(argv[0], val);
}
break;
case CAPABILITY QUERY:
Firmata.write(START SYSEX);
Firmata.write(CAPABILITY RESPONSE);
for (byte pin = 0; pin < TOTAL PINS; pin++) {
if (IS PIN DIGITAL(pin)) {
Firmata.write((byte)INPUT);
Firmata.write(1);
Firmata.write((byte)PIN MODE PULLUP);
Firmata.write(
Firmata.write(
Firmata.write(
}
if (IS _PIN ANALOG(pin)) {
Firmata.write(PIN MODE ANALOG);
Firmata.write(10); // 10 = 10-bit resolution

(byt
1);
(byte)OUTPUT) ;
1);

}

if (IS PIN PwWM(pin)) {
Firmata.write(PIN_MODE_PWM) ;
Firmata. wrlte(DEFAULT PWM | RESOLUTION);

}

if (IS _PIN DIGITAL(pin)) {
Firmata.write(PIN MODE SERVO);
Firmata.write(14);

}
if (IS PIN I2C(pin)) {
Firmata.write(PIN _MODE I2C);
Firmata.write(l); // TODO: could assign a number to map to SCL or SDA
}
#ifdef FIRMATA_SERIAL_FEATURE
serialFeature.handleCapability(pin);
#endif
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Firmata.write(127);
}
Firmata.write(END SYSEX);
break;
case PIN STATE QUERY:
if (argc > 0) {
byte pin = argv[0];
Firmata.write(START_ SYSEX);
Firmata.write(PIN STATE RESPONSE);
Firmata.write(pin);
if (pin < TOTAL_PINS) {
Firmata.write(Firmata.getPinMode(pin));
Firmata.write((byte)Firmata.getPinState(pin) & Ox7F);
if (Firmata.getPinState(pin) & OxFF80) Firmata.write((byte)
(Firmata.getPinState(pin) >> 7) & Ox7F);
if (Firmata.getPinState(pin) & 0xCO00) Firmata.write((byte)
(Firmata.getPinState(pin) >> 14) & Ox7F);
}
Firmata.write(END SYSEX);
}
break;
case ANALOG MAPPING QUERY:
Firmata.write(START SYSEX);
Firmata.write(ANALOG MAPPING RESPONSE);
for (byte pin = 0; pin < TOTAL PINS; pin++) {
Firmata.write(IS PIN ANALOG(pin) ? PIN TO ANALOG(pin) : 127);
}
Firmata.write(END SYSEX);
break;

case SERIAL MESSAGE:
#ifdef FIRMATA_SERIAL_FEATURE
serialFeature.handleSysex(command, argc, argv);
#endif
break;

void systemResetCallback()
{

isResetting = true;

// initialize a defalt state
// TODO: option to load config from EEPROM instead of default

#ifdef FIRMATA_SERIAL_FEATURE
serialFeature.reset();
#endif

if (isI2CEnabled) {

disableI2CPins();

}

for (byte i = 0; i < TOTAL _PORTS; i++) {
reportPINs[i] = false; // by default, reporting off
portConfigInputs[i] = 0; // until activated
previousPINs[i] = 0O;

}

for (byte i = 0; i < TOTAL_PINS; i++) {
// pins with analog capability default to analog input
// otherwise, pins default to digital output
if (IS PIN ANALOG(i)) {
// turns off pullup, configures everything
setPinModeCallback(i, PIN MODE ANALOG);
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} else if (IS PIN DIGITAL(i)) {
// sets the output to 0, configures portConfigInputs
setPinModeCallback(i, OUTPUT);

}

servoPinMap[i] = 255;

// by default, do not report any analog inputs
analogInputsToReport = 0;

detachedServoCount = 0;
servoCount = 0;

/* send digital inputs to set the initial state on the host computer,
* since once in the loop(), this firmware will only send on change */
/*
TODO: this can never execute, since no pins default to digital input
but it will be needed when/if we support EEPROM stored config
for (byte i=0; i < TOTAL PORTS; i++) {
outputPort(i, readPort(i, portConfigInputs[i]), true);
}

*/
isResetting = false;

}
void setup()

Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb

Serial.println("Bluefruit52 Standard Firmata via BLEUART Example");
Serial.println("------------mmmm \n");

// Config the peripheral connection with maximum bandwidth

// more SRAM required by SoftDevice

// Note: ALl config***() function must be called before begin()
Bluefruit.configPrphBandwidth (BANDWIDTH MAX);

Bluefruit.begin();
Bluefruit.setTxPower(4); // Check bluefruit.h for supported values

// try to go as fast as possible, could be rejected by some central, increase it
if needed

// 10S won't negotitate and will mostly use 30ms

Bluefruit.Periph.setConnInterval(9, 24); // min = 9*%1.25=11.25 ms, max =
23*1.25=30ms

// Configure and Start BLE Uart Service

// Firmata use several small write(l) --> buffering TXD is required to run
smoothly

// Enable buffering TXD

bleuart.begin();

bleuart.bufferTXD(true);

Firmata.setFirmwareVersion(FIRMATA FIRMWARE MAJOR VERSION,
FIRMATA FIRMWARE MINOR VERSION);

Firmata.attach (ANALOG MESSAGE, analogWriteCallback);
Firmata.attach(DIGITAL MESSAGE, digitalWriteCallback);
Firmata.attach (REPORT ANALOG, reportAnalogCallback);
Firmata.attach(REPORT DIGITAL, reportDigitalCallback);
Firmata.attach(SET _PIN MODE, setPinModeCallback);
Firmata.attach(SET DIGITAL PIN VALUE, setPinValueCallback);
Firmata.attach(START SYSEX, sysexCallback);
Firmata.attach(SYSTEM RESET, systemResetCallback);

// use bleuart as transportation layer
Firmata.begin(bleuart);
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// to use a port other than Serial, such as Seriall on an Arduino Leonardo or

Mega,

// Call begin(baud) on the alternate serial port and pass it to Firmata to begin

like this:

// Seriall.begin(57600);
// Firmata.begin(Seriall);
// However do not do this if you are using SERIAL MESSAGE

//Firmata.begin(57600);
//while (!'Serial) {
// ; // wait for serial port to connect. Needed for ATmega32u4-based boards and

Arduino 101

}

//}
systemResetCallback(); // reset to default config

// Set up and start advertising
startAdv();

void startAdv(void)

{

af
}

/*
*
*

// Advertising packet
Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected

* - Interval: fast mode = 20 ms, slow mode = 152.5 ms

* - Timeout for fast mode is 30 seconds

* - Start(timeout) with timeout = 0 will advertise forever (until connected)

*

* For recommended advertising interval

* https://developer.apple.com/library/content/qa/qal931/ index.html

=
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising

ter n seconds

LOOP ()

=== === * /

void loop()
{

©Adafruit Industries

// Skip if not connected and bleuart notification is not enabled
if ( !'(Bluefruit.connected() && bleuart.notifyEnabled()) ) return;

byte pin, analogPin;

/* DIGITALREAD - as fast as possible, check for changes and output them to the
* FTDI buffer using Serial.print() */
checkDigitalInputs();

/* STREAMREAD - processing incoming messagse as soon as possible, while still
* checking digital inputs. */
while (Firmata.available())
Firmata.processInput();

// TODO - ensure that Stream buffer doesn't go over 60 bytes
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currentMillis = millis();
if (currentMillis - previousMillis > samplingInterval) {
previousMillis += samplingInterval;
/* ANALOGREAD - do all analogReads() at the configured sampling interval */
for (pin = 0; pin < TOTAL_PINS; pin++) {
if (IS PIN ANALOG(pin) && Firmata.getPinMode(pin) == PIN MODE ANALOG) {
analogPin = PIN TO ANALOG(pin);
if (analogInputsToReport & (1 << analogPin)) {
Firmata.sendAnalog(analogPin, analogRead( ANALOG TO PIN(analogPin) ));
}
}
}
// report i2c data for all device with read continuous mode enabled
if (queryIndex > -1) {
for (byte i = 0; i < queryIndex + 1; i++) {
readAndReportData(query[i].addr, query[i].reg, query[i].bytes,
query[i].stopTX);
}
}
}
#ifdef FIRMATA_SERIAL_FEATURE

serialFeature.update();
#endif

// flush TXD since we use bufferTXD()
bleuart.flushTXD();
}

Central BLEUART

This example show you how to use Feather nRF52/nRF52840 as a Central to talk to
other Bluefruit (hnRF52 or nRF51) peripherals exposing the bleuart (AKA 'NUS') service.

Client Services

Since the Central role accesses the GATT server on the peripheral, we first need to
declare a client bleuart instance using the BLEClientUart helper class. We can also
conveniently read Device Information if BLEClientDis is also used.

BLEClientDis clientDis;
BLEClientUart clientUart;

Before we can configure client services, Bluefruit.begin() must be called with at
least 1 for the number of concurrent connections supported in central mode. Since we
won't be running the nRF52 as a peripheral in this instance, we will set the peripheral
count to O:

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1
Bluefruit.begin(0, 1);
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Afterward this, the client service(s) must be initialized by calling their begin() functi
on, and you can setup any callbacks that you wish to use from the helper class:

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

Scanner

Let's start the advertising scanner to find a peripheral.
We'll hook up the scan result callback with setRxCallback().

Whenever advertising data is found by the scanner, it will be passed to this callback
handler, and we can examine the advertising data there, and only connect to
peripheral(s) that advertise the bleuart service.

Note: If the peripheral has multiple services and bleuart is not included in the UUID
list in the advertising packet, you could optionally use another check such as
matching the MAC address, name checking, using "another service", etc.

Once we find a peripheral that we wish to communicate with, call Bluefruit.Centr
al.connect() to establish connection with it:

void setup()

{
// Other set up .....

/* Start Central Scanning
* - Enable auto scan if disconnected
* - Interval = 100 ms, window = 80 ms
* - Don't use active scan
* - Start(timeout) with timeout = 0 will scan forever (until connected)
Y
Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);
Bluefruit.Scanner.start(0); // // O = Don't stop scanning after
n seconds

}

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data

&

void scan_callback(ble gap evt adv report t* report)

{

// Check if advertising contain BleUart service
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if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )
Serial.print("BLE UART service detected. Connecting ... ");

// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);

}

Central Role

You normally need to setup the Central mode device's connect callback, which fires
when a connection is established/disconnected with a peripheral device. Alternatively
you could poll the connection status with connected(), but callbacks help to simplify
the code significantly:

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

In the connect callback, we will try to discover the bleuart service by browsing the
GATT table of the peripheral. This will help to determine the handle values for
characteristics (e.g TXD, RXD, etc.). This is all done by BLEClientUart's .discover() .
Once the service is found, enable the TXD characteristic's CCCD to allow the
peripheral to send data, and we are ready to send data back and forth between the
devices:

void connect callback(uintl6 t conn_handle)

{

Serial.println("Connected");

Serial.print("Dicovering DIS ... ");
if ( clientDis.discover(conn_handle) )
{

Serial.println("Found it");
char buffer[32+1];

// read and print out Manufacturer
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
{
Serial.print("Manufacturer: ");
Serial.println(buffer);
}

// read and print out Model Number
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getModel(buffer, sizeof(buffer)) )
{
Serial.print("Model: ");
Serial.println(buffer);
}

Serial.println();
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Serial.print("Discovering BLE Uart Service ... ");

if ( clientUart.discover(conn_handle) )

{
Serial.println("Found it");
Serial.println("Enable TXD's notify");
clientUart.enableTXD();
Serial.println("Ready to receive from peripheral");
}else
{
Serial.println("Found NONE");
// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn handle);
}

}

Full Sample Code

The full sample code for this example can be seen below:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information
All text above, and the splash screen below must be included in

any redistribution
ook ok o ok ok ok ok ook ok ok ok ok ok ok sk ook ok ok ok ok ok kosk ok ok sk ok skotok sk ok ok ok ko sk ok k sk ok skokokskokok sk ok ok kok ok sk k f

/*
* This sketch demonstrate the central API(). A additional bluefruit
* that has bleuart as peripheral is required for the demo.
=/

#include <bluefruit.h>

BLEClientBas <clientBas; // battery client
BLEClientDis <clientDis; // device information client
BLEClientUart clientUart; // bleuart client

void setup()

Serial.begin(115200);
// while ( !Serial ) delay(10); // for nrf52840 with native usb

Serial.println("Bluefruit52 Central BLEUART Example");
Serilal . PramtlR(®ecccescccccsccccsccccnscccoscccccss \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1

// SRAM usage required by SoftDevice will increase dramatically with number of
connections

Bluefruit.begin(0, 1);

Bluefruit.setName("Bluefruit52 Central");
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// Configure Battyer client
clientBas.begin();

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

/* Start Central Scanning
* - Enable auto scan if disconnected
*¥ - Interval = 100 ms, window = 80 ms
* - Don't use active scan
* - Start(timeout) with timeout = 0 will scan forever (until connected)
=/
Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);
Bluefruit.Scanner.start(0); // // O = Don't stop scanning after
n seconds

}

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
*/
void scan_callback(ble gap evt adv report t* report)
{
// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )

{

Serial.print ("BLE UART service detected. Connecting ... ");

// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);

}else

{
// For Softdevice v6: after received a report, scanner will be paused
// We need to call Scanner resume() to continue scanning
Bluefruit.Scanner.resume();

}

}

/**
* Callback invoked when an connection is established
* @param conn_handle
=/

void connect_callback(uintl6_t conn_handle)

{

Serial.println("Connected");

Serial.print("Dicovering Device Information ... ");
if ( clientDis.discover(conn_handle) )
{

Serial.println("Found it");

char buffer[32+1];

// read and print out Manufacturer

memset (buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
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{
Serial.print("Manufacturer: ");
Serial.println(buffer);

}

// read and print out Model Number
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getModel(buffer, sizeof(buffer)) )
{
Serial.print("Model: ");
Serial.println(buffer);
}

Serial.println();
}else
{

}

Serial.println("Found NONE");

Serial.print("Dicovering Battery ... ");

if ( clientBas.discover(conn_handle) )

{
Serial.println("Found it");
Serial.print("Battery level: ");
Serial.print(clientBas.read());
Serial.println("%");

}else

{

}

Serial.print("Discovering BLE Uart Service ... ");
if ( clientUart.discover(conn_handle) )

{

Serial.println("Found NONE");

Serial.println("Found it");

Serial.println("Enable TXD's notify");
clientUart.enableTXD();

Serial.println("Ready to receive from peripheral");
}else

{
Serial.println("Found NONE");

// disconnect since we couldn't find bleuart service
Bluefruit.disconnect(conn_handle);
}
}

/**
* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason is a BLE HCI STATUS CODE which can be found in ble_hci.h
*/
void disconnect_callback(uintl6_t conn_handle, uint8_t reason)
{
(void) conn _handle;
(void) reason;

Serial.print("Disconnected, reason = 0x"); Serial.println(reason, HEX);

}

/x*
* Callback invoked when uart received data
* @param uart svc Reference object to the service where the data
* arrived. In this example it is clientUart
/)

void bleuart_rx_callback(BLEClientUart& uart svc)

{
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Serial.print("[RX]: ");

while ( uart svc.available() )
{
Serial.print( (char) uart svc.read() );

}

Serial.println();
}

void loop()
if ( Bluefruit.Central.connected() )

// Not discovered yet
if ( clientUart.discovered() )
{
// Discovered means in working state
// Get Serial input and send to Peripheral
if ( Serial.available() )
{
delay(2); // delay a bit for all characters to arrive

char str[20+1] = { 0 };
Serial.readBytes(str, 20);

clientUart.print( str );

Dual Roles BLEUART

If you are not familiar with Central Role, it is advised to look at the "Central

BLEUART" example first then continue with this afterwards.

This example demonstrates how you can use a Feather nRF52/nRF52840 to connect
to two other Bluefruit or BLE devices using the bleuart (AKA 'NUS') service

concurrently, with the device running at both a peripheral and a central at the same
time.

This dual role example acts as a BLE bridge that sits between a central and a
peripheral forwarding bleuart messages back and forth, as shown in the image below:

BLE Central | 2" BluefruitnRF52 | o "%

(mobile, PC) | dual Roles ki |

A\
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Server & Client Service Setup

Since the Bluefruit device will act as both a central and a peripheral, we will need to
declare both server and client instance of the bleuart helper class:

// Peripheral uart service
BLEUart bleuart;

// Central uart client
BLEClientUart clientUart;

Before we can configure client services, Bluefruit.begin() must be called with at
least 1 for the number of concurrent connection for both peripheral and central mode:

// Initialize Bluefruit with max concurrent connections as Peripheral = 1, Central
=J]|
Bluefruit.begin(1l, 1);

After this, client services must be initialized by calling their begin() function,
followed by any callbacks that you wish to wire up as well:

// Configure and Start BLE Uart Service
bleuart.begin();
bleuart.setRxCallback(prph bleuart rx callback);

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(cent bleuart rx callback);

We are then ready to forward data from central to peripheral and vice versa using
callbacks:

void cent bleuart rx callback(BLEClientUart&amp; cent uart)
{

char str[20+1] = { 0 };

cent uart.read(str, 20);
Serial.print("[Cent] RX: ");
Serial.println(str);

if ( bleuart.notifyEnabled() )
{
// Forward data from our peripheral to Mobile
bleuart.print( str );
}else
{
// response with no prph message
clientUart.println("[Cent] Peripheral role not connected");
}
}

void prph _bleuart rx callback(void)
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// Forward data from Mobile to our peripheral
char str[20+1] = { 0 };
bleuart.read(str, 20);

Serial.print("[Prph] RX: ");
Serial.println(str);

if ( clientUart.discovered() )

{
clientUart.print(str);
}else

bleuart.printin("[Prph] Central role not connected");
}
}

Peripheral Role

The first thing to do for the peripheral part of our code is to setup the connect
callback, which fires when a connection is established/disconnected with the central.
Alternatively you could poll the connection status with connected(), but callbacks
helps to simplify the code significantly:

// Callbacks for Peripheral
Bluefruit.setConnectCallback(prph connect callback);
Bluefruit.setDisconnectCallback(prph disconnect callback);

Central Role

Next we setup the Central mode connect callback, which fires when a connection is
established/disconnected with a peripheral device:

// Callbacks for Central
Bluefruit.Central.setConnectCallback(cent connect callback);
Bluefruit.Central.setDisconnectCallback(cent disconnect callback);

Advertising and Scanner

It is possible to start both the scanner and advertising at the same time so that we can
discover and be discovered by other BLE devices. For the scanner, we use a filter that
only fires the callback if a specific UUID is found in the advertising data of the peer
device:

/* Start Central Scanning
* - Enable auto scan if disconnected
* - Interval = 100 ms, window = 80 ms
*¥ - Filter only accept bleuart service

©Adafruit Industries Page 79 of 176



* - Don't use active scan

* - Start(timeout) with timeout = 0 will scan forever (until connected)

w5/

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval(160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.filterUuid(bleuart.uuid);
Bluefruit.Scanner.useActiveScan(false);
Bluefruit.Scanner.start(0); // 0 = Don't stop scanning after n
seconds

// Advertising packet
Bluefruit.Advertising.addFlags(BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising
* - Enable auto advertising if disconnected
* - Interval: fast mode = 20 ms, slow mode = 152.5 ms
*¥ - Timeout for fast mode is 30 seconds
* - Start(timeout) with timeout = 0 will advertise forever (until connected)
3
*
%

For recommended advertising interval
https://developer.apple.com/library/content/qa/qal931/ index.html
L5
Bluefruit.Advertising.restartOnDisconnect(true);

Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising after
n seconds

Full Sample Code

The full sample code for this example can be seen below:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information
All text above, and the splash screen below must be included in

any redistribution
SRR R oK oK oK oK oK KKK KR R oK oK oK oK oK KKK KKK K R R oK oK oK oK KoK KK KKK R R R oK oK oK Sk oK K KRR R R KoK SRSk ok ok ok ok K/

/*
* This sketch demonstrate how to run both Central and Peripheral roles
* at the same time. It will act as a relay between an central (mobile)
* to another peripheral using bleuart service.
*
* Mobile <--> DualRole <--> peripheral Ble Uart
/)

#include <bluefruit.h>
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// OTA DFU service
BLEDfu bledfu;

// Peripheral uart service
BLEUart bleuart;

// Central uart client
BLEClientUart clientUart;

void setup()

Serial.begin(115200);

while ( !Serial ) delay(10);

// for nrf52840 with native usb

Serial.println("Bluefruit52 Dual Role BLEUART Example");

Serial.println("

\n");

// Initialize Bluefruit with max concurrent connections as Peripheral = 1,

Central =1

// SRAM usage required by SoftDevice will increase with number of connections
Bluefruit.begin(1l, 1);

Bluefruit.setTxPower(4);

// Callbacks for Peripheral
Bluefruit.Periph.setConnectCallback(prph connect callback);
Bluefruit.Periph.setDisconnectCallback(prph_disconnect callback);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(cent connect callback);
Bluefruit.Central.setDisconnectCallback(cent disconnect callback);

// Check bluefruit.h for supported values

// To be consistent OTA DFU should be added first if it exists
bledfu.begin();

// Configure and Start BLE Uart Service
bleuart.begin();
bleuart.setRxCallback(prph bleuart rx callback);

// Init BLE Central Uart Serivce
clientUart.begin();

clientUart.setRxCallback(cent bleuart rx callback);

X ¥ X X X X

*/

Bluefruit.
Bluefruit.
Bluefruit.
Bluefruit.

Bluefruit

Bluefruit.

seconds

Scanner

Scanner

Start Central Scanning
- Enable auto scan if disconnected

- Interval = 100 ms, window = 80 ms
- Filter only accept bleuart service
- Don't use active scan

- Start(timeout) with timeout

restartOnDisconnect(true);

filterUuid(bleuart.uuid);
useActiveScan(false);
start(0);

// Set up and start advertising
startAdv();

}

void startAdv(void)

// Advertising packet
Bluefruit.Advertising.addFlags (BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

©Adafruit Industries

.setRxCallback(scan callback);
Scanner.
.setInterval(160, 80); // in unit of 0.625 ms
Scanner.
.Scanner.
Scanner.

// 0

= 0 will scan forever (until connected)

Don't stop scanning after n
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// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)

// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

* - Enable auto advertising if disconnected

* - Interval: fast mode = 20 ms, slow mode = 152.5 ms

* - Timeout for fast mode is 30 seconds

* - Start(timeout) with timeout = 0 will advertise forever (until connected)
*
3
*

For recommended advertising interval
https://developer.apple.com/library/content/qa/qal931/ index.html

*/
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising
after n seconds

}
void loop()
{

// do nothing, all the work is done in callback

}
/* __________________________________________________________________ */
/* Peripheral

K o o o e e o e e e e e e e e e e e e e e e m e m e m e m e m m o m o m m o m e m e m m e m e —— e —— - */

void prph_connect_callback(uintl6_t conn_handle)

// Get the reference to current connection
BLEConnection* connection = Bluefruit.Connection(conn_handle);

char peer name[32] = { 0 };
connection->getPeerName(peer name, sizeof(peer name));

Serial.print("[Prph] Connected to ");
Serial.println(peer_name);

}
void prph_disconnect_callback(uintl6_t conn_handle, uint8_t reason)

(void) conn_handle;
(void) reason;

Serial.println();
Serial.println("[Prph] Disconnected");

}

void prph_bleuart_rx_callback(uintl6_t conn_handle)
(void) conn_handle;
// Forward data from Mobile to our peripheral
char str[20+1] = { 0 };
bleuart.read(str, 20);

Serial.print("[Prph] RX: ");
Serial.println(str);

if ( clientUart.discovered() )
clientUart.print(str);

}else

{

bleuart.println("[Prph] Central role not connected");
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}
/* __________________________________________________________________ */
/* Central

K o o o e e e e e e e e e e m e e e e e e m e e e e e e e e e m e m e e e e e e e e e e e m e, m, e, —, e, —,——— - - */
void scan_callback(ble gap evt adv_report t* report)
{

// Since we configure the scanner with filterUuid()

// Scan callback only invoked for device with bleuart service advertised
// Connect to the device with bleuart service in advertising packet
Bluefruit.Central.connect(report);

}

void cent_connect_callback(uintl6_t conn_handle)
{
// Get the reference to current connection
BLEConnection* connection = Bluefruit.Connection(conn_handle);

char peer name[32] = { 0 };
connection->getPeerName(peer name, sizeof(peer name));

Serial.print("[Cent] Connected to ");
Serial.println(peer_name);;

if ( clientUart.discover(conn _handle) )

// Enable TXD's notify
clientUart.enableTXD();

}else

{
// disconnect since we couldn't find bleuart service
Bluefruit.disconnect(conn_handle);

}

}

void cent_disconnect_callback(uintl6_t conn handle, uint8_t reason)
{

(void) conn_handle;

(void) reason;

Serial.println("[Cent] Disconnected");

}

/X%
* Callback invoked when uart received data
* @param cent uart Reference object to the service where the data
* arrived. In this example it is clientUart
*/

void cent_bleuart_rx_callback(BLEClientUart& cent uart)

{
char str[20+1]

={0}
cent uart.read(str, 20

)i

Serial.print("[Cent] RX: ");
Serial.println(str);

if ( bleuart.notifyEnabled() )

{
// Forward data from our peripheral to Mobile
bleuart.print( str );
}else
{
// response with no prph message
clientUart.println("[Cent] Peripheral role not connected");
}
}
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Custom: Central HRM

The BLECIlientService and BLEClientCharacteristic classes can be used to implement
any custom or officially adopted BLE service of characteristic on the client side (most
often is Central) using a set of basic properties and callback handlers.

The example below shows how to use these classes to implement the Heart Rate
Monitor (https://adafru.it/vaO) service, as defined by the Bluetooth SIG. To run this
example, you will need an extra nRF52 running peripheral HRM sketch (https://
adafru.it/Cnf)

HRM Service Definition

UUID: 0x180D (https://adafru.it/vaO)

Only the first characteristic is mandatory, but we will also implement the optional Body
Sensor Location characteristic. Heart Rate Control Point won't be used in this example
to keep things simple.

Implementing the HRM Service and
Characteristics

The core service and the first two characteristics can be implemented with the
following code:

First, define the BLEService and BLECharacteristic variables that will be used in your
project:

/* HRM Service Definitions

Heart Rate Monitor Service: 0x180D

* Heart Rate Measurement Char: 0x2A37 (Mandatory)
* Body Sensor Location Char: 0x2A38 (Optional)
*/

*

BLEClientService hrms (UUID16 SVC HEART RATE);
BLEClientCharacteristic hrmc(UUID16 CHR HEART RATE MEASUREMENT) ;
BLEClientCharacteristic bslc(UUID16 CHR BODY SENSOR LOCATION);

Then you need to initialize those variables by calling their begin().

// Initialize HRM client
hrms.begin();
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// Initialize client characteristics of HRM.
// Note: Client Char will be added to the last service that is begin()ed.
bslc.begin();

// set up callback for receiving measurement

hrmc.setNotifyCallback(hrm notify callback);
hrmc.begin();

Client Service + Characteristic Code Analysis

1. The first thing to do is to call .begin() on the BLEClientService (hrms above). Since
the UUID is set in the object declaration at the top of the sketch, there is normally
nothing else to do with the BLEClientService instance.

You MUST call .begin() on the BLEClientService before adding any

BLECIlientCharacteristics. Any BLEClientCharacteristic will automatically be
added to the last BLEClientService that was begin()'ed!

2. Since Heart Rate Measurement characteristic (clientMeasurement above) is notifia
ble. You need to set up callback for it

«'"hrmc.setNotifyCallback(hrm notify callback); ' This sets the callback
that will be fired when we receive a Notify message from peripheral. This is
needed to handle notifiable characteristic since callback allow us to response to
the message in timely manner. For this example is just simply printing out value
to Serial.

«'"hrmc.begin(); ' Once all of the properties have been set, you must call .begi
n() which will add the characteristic definition to the last BLEClientService that
was '.begin()ed".

Note for characteristic that does not support notify e.g body sensor location , we

can simply use .read() to retrieve its value.

3. Next, we can start to scan and connect to peripheral that advertises HRM service.
Once connected, we need to go through peripheral GATT table to find out the Gatt
handle for our interest. In this example they are handle for hrms, hrmc and bslc. This
looking up process for interested service/characteristic is called Discovery.

Note: Gatt handle (or just handle) is required to perform any operations at all such as

read, write, enable notify. It is required that a client characteristic must be discovered
before we could doing anything with it.
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The service should be discovered before we could discover its characteristic. This
can be done by calling hrms.discover(conn _handle) .Where conn_handle is the
connection ID i.e peripheral that we want to discover since it is possible for Bluefruit
nRF52 to connect to multiple peripherals concurrently. If the service is found, the
function will return true, otherwise false.

// Connect Callback Part 1
void connect callback(uintl6 t conn_handle)

{
Serial.println("Connected");
Serial.print("Discovering HRM Service ... ");

// If HRM is not found, disconnect and return
if ( 'hrms.discover(conn_handle) )

{
Serial.println("Found NONE");

// disconect since we couldn't find HRM service
Bluefruit.Central.disconnect(conn _handle);

return;

}

// Once HRM service is found, we continue to discover its characteristic
Serial.println("Found it");

4. Afterwards, we continue to discover all the interested characteristics within the
service by calling .discover() . The function return true if characteristics is found,
and false otherwise. You could also check with .discovered() function. A service
could contain more characteristics but we don't need to discover them all, only those
that we want to interact with.

Advanced: Alternatively, you could discover all the interested characteristics of a
service within a function call by using Bluefruit.Discovery.discoverCharacteri
stic() (notused inthe example). The API can take up to 5 characteristics, if you
need more, the variant with passing array of characteristics is also available. The
function will return the number of characteristic it found.

Note: when a characteristic is discovered by above API, all necessarily meta data
such as handles, properties ( read,write, notify etc ...), cccd handle will be updated
automatically. You can then use BLECLientCharacteristic (https://adafru.it/Cng) API
such as read(), write(), enableNotify() on it provided that its properties support such as
operation.

// Connect Callback Part 2
void connect callback(uintl6 t conn handle)

{

Serial.print("Discovering Measurement characteristic ... ");
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if ( 'hrmc.discover() )

{
// Measurement chr is mandatory, if it is not found (valid), then disconnect
Serial.println("not found !!!");
Serial.println("Measurement characteristic is mandatory but not found");
Bluefruit.Central.disconnect(conn_handle);
return;

}

Serial.println("Found it");

// Measurement is found, continue to look for option Body Sensor Location

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Body Sensor Location is optional, print out the location in text if present

Serial.print("Discovering Body Sensor Location characteristic ... ");

if ( bslc.discover() )

{

Serial.println("Found it");

// Body sensor location value is 8 bit
const char* body str[] = { "Other", "Chest", "Wrist", "Finger", "Hand", "Ear
Lobe", "Foot" };

// Read 8-bit BSLC value from peripheral
uint8 t loc value = bslc.read8();

Serial.print("Body Location Sensor: ");
Serial.println(body_str[loc_value]);
}else

{
Serial.println("Found NONE");

5. Once hrmc is discovered, you should enable its notification by calling hrmc.enabl
eNotify() . If this succeeded (return true), peripheral can now send data to us using
notify message. Which will trigger the callback that we setup earlier to handle
incoming data.

// Connect Callback Part 3
void connect callback(uintl6 t conn_handle)

// Reaching here means we are ready to go, let's enable notification on
measurement chr
if ( hrmc.enableNotify() )
{
Serial.println("Ready to receive HRM Measurement value");
}else

{
Serial.println("Couldn't enable notify for HRM Measurement. Increase DEBUG
LEVEL for troubleshooting");

}
}
/**
* Hooked callback that triggered when a measurement value is sent from peripheral
* @param chr Pointer to client characteristic that even occurred,
b in this example it should be hrmc
*

@param data Pointer to received data
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* @param len Length of received data
*/
void hrm notify callback(BLEClientCharacteristic* chr, uint8 t* data, uintl6 t len)

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Measurement contains of control byte® and measurement (8 or 16 bit) + optional
field

// if byteO's bit@ is 0 --&gt; measurement is 8 bit, otherwise 16 bit.

Serial.print("HRM Measurement: ");
if ( data[0] &amp; bit(0) )
{

uintl6 _t value;
memcpy (&amp;value, data+l, 2);

Serial.println(value);

}

else

Serial.println(data[l]);
}
}

Full Sample Code

The full sample code for this example can be seen below:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information

All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/

#include <bluefruit.h>

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: Ox2A38
/]
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16 SVC HEART RATE);
BLECharacteristic (UUID16 CHR HEART RATE MEASUREMENT);
BLECharacteristic (UUID16 CHR BODY SENSOR LOCATION);

BLEDis bledis; // DIS (Device Information Service) helper class instance
BLEBas blebas; // BAS (Battery Service) helper class instance

uint8_t bps = 0;
void setup()
{

Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb
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Serial.println("Bluefruit52 HRM Example");
Serifall praintlni (%= aisis oo \n");

// Initialise the Bluefruit module
Serial.println("Initialise the Bluefruit nRF52 module");
Bluefruit.begin();

// Set the connect/disconnect callback handlers
Bluefruit.Periph.setConnectCallback(connect callback);
Bluefruit.Periph.setDisconnectCallback(disconnect callback);

// Configure and Start the Device Information Service
Serial.println("Configuring the Device Information Service");
bledis.setManufacturer("Adafruit Industries");
bledis.setModel("Bluefruit Feather52");

bledis.begin();

// Start the BLE Battery Service and set it to 100%
Serial.println("Configuring the Battery Service");
blebas.begin();

blebas.write(100);

// Setup the Heart Rate Monitor service using

// BLEService and BLECharacteristic classes
Serial.println("Configuring the Heart Rate Monitor Service");
setupHRM() ;

// Setup the advertising packet(s)
Serial.println("Setting up the advertising payload(s)");
startAdv();

Serial.println("Ready Player One!!!");
Serial.println("\nAdvertising");

}

void startAdv(void)

{
// Advertising packet

Bluefruit.Advertising.addFlags (BLE_GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include HRM Service UUID
Bluefruit.Advertising.addService(hrms);

// Include Name
Bluefruit.Advertising.addName();

/* Start Advertising

* - Enable auto advertising if disconnected

* - Interval: fast mode = 20 ms, slow mode = 152.5 ms

* - Timeout for fast mode is 30 seconds

* - Start(timeout) with timeout = 0 will advertise forever (until connected)

*

* For recommended advertising interval

* https://developer.apple.com/library/content/qa/qal931/ index.html

=
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms
Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising

after n seconds

}
void setupHRM(void)
// Configure the Heart Rate Monitor service
// See: https://www.bluetooth.com/specifications/gatt/viewer?

attributeXmlFile=org.bluetooth.service.heart rate.xml
// Supported Characteristics:
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// Name UUID Requirement Properties

[l =ocomcccomo00006555000000000 900660 CODODO00000 COCGCSSO00D

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write <-- Not used here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was 'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Properties = Notify

// Min Len = il

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0 = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)

// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but

contact not detected, 3 = Supported and detected)

// b0o = Value format (0 = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties (CHR PROPS NOTIFY);

hrmc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdata[2] = { 0b00OEO110, Ox40 }; // Set the characteristic to use 8-bit
values, with the sensor connected and detected

hrmc.write(hrmdata, 2);

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Properties = Read

// Min Len =1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties(CHR _PROPS READ);
bslc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);
bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)
}
void connect_callback(uintl6_t conn_handle)
{

// Get the reference to current connection
BLEConnection* connection = Bluefruit.Connection(conn_handle);

char central name[32] = { 0 };
connection->getPeerName(central name, sizeof(central name));

Serial.print("Connected to ");
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Serial.println(central name);

}

/**
* Callback invoked when a connection is dropped
* @param conn_handle connection where this event happens
* @param reason is a BLE HCI STATUS CODE which can be found in ble_hci.h
*/
void disconnect_callback(uintl6_t conn_handle, uint8_t reason)
{
(void) conn_handle;
(void) reason;

Serial.print("Disconnected, reason = 0x"); Serial.println(reason, HEX);
Serial.println("Advertising!");

}

void cccd_callback(uintl6_t conn hdl, BLECharacteristic* chr, uintl6_t cccd value)
{

// Display the raw request packet

Serial.print("CCCD Updated: ");

//Serial.printBuffer(request->data, request->len);

Serial.print(cccd value);

Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr->uuid == hrmc.uuid) {
if (chr->notifyEnabled(conn _hdl)) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
}

}
void loop()
{
digitalToggle(LED RED);

if ( Bluefruit.connected() ) {
uint8_t hrmdata[2] = { 0b00000110, bps++ }; // Sensor connected,
increment BPS value

// Note: We use .notify instead of .write!
// If it is connected but CCCD is not enabled
// The characteristic's value is still updated although notification is not sent
if ( hrmc.notify(hrmdata, sizeof(hrmdata)) ){
Serial.print("Heart Rate Measurement updated to: "); Serial.println(bps);

}else{
Serial.println("ERROR: Notify not set in the CCCD or not connected!");
}
}
// Only send update once per second
delay(1000);
}

Arduino Bluefruit nRF52 API

The Adafruit nRF52 core defines a number of custom classes that aim to make it easy
to work with BLE in your projects.
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The key classes are listed below, and examined in more detail elsewhere in this
learning guide:

« AdafruitBluefruit is the main entry point to the Adafruit Bluefruit nRF52 API. This
class exposes a number of essential functions and classes, such as advertising,
the list of GATT services and characteristics defined on your device, and
connection status.

« BLEService is a wrapper class for BLE GATT service records, and can be used to
define custom service definitions, or acts as the base class for any service
helper classes.

- BLECharacteristic is a wrapper class for a BLE GATT characteristic record, and
can be used to define custom characteristics, or acts as the base class for any
characteristic helper classes.

« BLEDis is a helper class for the DIS or 'Device Information Service'.

« BLEUart is a helper class for the NUS or 'Nordic UART Service'.

« BLEBeacon is a helper class to configure your nRF52 as a beacon using the
advertising packet to send out properly formatted beacon data.

« BLEMidi is a helper class to work with MIDI data over BLE.

« BLEHidAdafruit is a helper class to emulate an HID mouse or keyboard over
BLE.

Details on each of these helper classes are found further in this learning guide.

AdafruitBluefruit

Adafruit's nRF52 BSP codebase is still undergoing active development based on
customer feedback and testing. As such, the class documentation here may be

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

This base class is the main entry point to the Adafruit Bluefruit nRF52 API, and
exposes most of the helper classes and functions that you use to configure your
device.

API

AdafruitBluefruit has the following public API:
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// Constructor
AdafruitBluefruit(void);

/* __________________________________________________________________ */
/* Lower Level Classes (Bluefruit.Advertising.*, etc.)
K o o e e e e e e e e e e e e e e m e m e m e m m e m e m m o m m e m m e m e m e m e m e ———— - - */
BLEGap Gap;
BLEGatt Gatt;
BLEAdvertising Advertising;
BLEAdvertisingData ScanResponse;
BLEScanner Scanner;
BLECentral Central;
BLEDiscovery Discovery;
/* __________________________________________________________________ */

/* SoftDevice Configure Functions, must call before begin().
* These function affect the SRAM consumed by SoftDevice.

K L L o e o o e e o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e m m e m e m e — - - */
void configServiceChanged (bool changed) ;
void configUuidl1l28Count (uint8 t uuid128 max);
void configAttrTableSize (uint32 t attr table size);
// Config Bandwidth for connections
void configPrphConn (uintl6 t mtu max, uint8 t event len, uint8 t
hvn _gsize, uint8 t wrcmd gsize);
void configCentralConn (uintl6 t mtu max, uint8 t event len, uint8 t

hvn _qsize, uint8 t wrcmd gsize);

// Convenient function to config connection

void configPrphBandwidth (uint8 t bw);
void configCentralBandwidth(uint8 t bw);
err_t begin(uint8 t prph count = 1, uint8 t central count = 0);
/* __________________________________________________________________ */
/* General Functions
B S */
void setName (const char* str);
uint8 t getName (char* name, uintl6 t bufsize);
bool setTxPower (int8 t power);
int8 t getTxPower (void);
bool setApperance (uintl6_t appear);
uintl6 t getApperance (void);
void autoConnlLed (bool enabled);
void setConnLedInterval (uint32 t ms);
/* __________________________________________________________________ */
/* GAP, Connections and Bonding
K o L o e e e e e e e e e e e e e e e e e m e m e e e e e m e m e — e m e m e m m e m m e — m e m — = - */
bool connected (void);
bool disconnect (void);
bool setConnInterval (uintl6_t min, uintl6_t max);
bool setConnIntervalMS (uintl6 t min ms, uintl6 t max ms);
uintl6_t connHandle (void);
bool connPaired (void);
uintle t connInterval (void);
bool requestPairing (void);
void clearBonds (void);

ble gap addr t getPeerAddr (void);
uint8 t getPeerAddr (uint8 t addr[6]);
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void printInfo(void);

/* __________________________________________________________________ */
/* Callbacks
S */

void setConnectCallback ( BLEGap::connect callback t fp);
void setDisconnectCallback( BLEGap::disconnect callback t fp);

These functions are generally available via 'Bluefruit.*. For example, to check the
connection status in your sketch you could run'if (Bluefruit.connected()) {

}
Examples

For examples of how to work with the parent Bluefruit class, see the Examples section
later in this guide. It's better to examine this class in the context of a real world use
case.

You can also browse the latest example code online via Github:

Browse the latest example code on

Github
https://adafru.it/vaK

BLEGap

This page is a work in progress as the APl is changing as we migrate to S132v5

(nRF52832) and S140 (nRF52840) and add better Central mode support.

This GAP API for Bluefruit is accessible via Bluefruit.Gap.*** and has the
following public functions:

typedef void (*connect callback t ) (uintl6_t conn_handle);
typedef void (*disconnect callback t ) (uintl6_t conn handle, uint8 t reason);

uint8 t getAddr (uint8 t mac([6]);

bool setAddr (uint8 t mac[6], uint8 t type);

bool connected (uintl6 t conn _handle);

uint8 t getRole (uintl6_t conn_handle);

uint8 t getPeerAddr (uintl6_t conn_handle, uint8 t addr[6]);
ble gap _addr_t getPeerAddr (uintl6_t conn_handle);

uintl6 t getPeerName (uintl6 t conn _handle, char* buf, uintl6 t
bufsize);
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uintl6 t getMTU (uintl6 t conn handle);
uintl6 t getMaxMtuByConnCfg (uint8 t conn cfg);
uintl6e t getMaxMtu (uint8 t conn_handle);

BLEAdvertising

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

'Advertising' is what makes your Bluetooth Low Energy devices visible to other
devices in listening range. The radio sends out specially formatter advertising packets
that contain information like the device name, whether you can connect to the device
(or if it only advertises), etc.

You can also include custom data in the advertising packet, which is essential how
beacons work.

The BLEAdvertisingData and BLEAdvertising classes exposes a nhumber of helper
functions to make it easier to create well-formatted advertising packets, as well as to
use the Scan Response option, which is an optional secondary advertising packet that
can be requested by a Central device. (This gives you another 27 bytes of advertising
data, but isn't sent out automatically like the main advertising packet.).

This two advertising packets are accessible via the parent AdafruitBluefruit class,
calling ' Bluefruit.Advertising.* 'and 'Bluefruit.ScanResponse.* ' from your
user sketches.

For examples of using these helper classes, see any of the examples later on in this
guide, since all devices will advertise as part of the startup process.

API

The BLEAdvertisingData class has the following public API:

JF e Adv Data ------------- */

bool addData(uint8 t type, const void* data, uint8 t len);
bool addFlags(uint8 t flags);

bool addTxPower(void);

bool addName(void);

bool addAppearance(uintl6_t appearance);

bool addManufacturerData(const void* data, uint8 t count);
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Y UUID ------------- */

bool addUuid(BLEUuid bleuuid);

bool addUuid(BLEUuid bleuuidl, BLEUuid bleuuid2);

bool addUuid(BLEUuid bleuuidl, BLEUuid bleuuid2, BLEUuid bleuuid3);

bool addUuid(BLEUuid bleuuidl, BLEUuid bleuuid2, BLEUuid bleuuid3, BLEUuid
bleuuid4);

bool addUuid(BLEUuid bleuuid[], uint8 t count);

YA Service ------------- ]

bool addService(BLEService&amp; service);

bool addService(BLEService&amp; servicel, BLEService&amp; service2);

bool addService(BLEService&amp; servicel, BLEService&amp; service2, BLEService&amp;
service3);

bool addService(BLEService&amp; servicel, BLEService&amp; service2, BLEService&amp;
service3, BLEService&amp; serviced);

Y Client Service ------------- Y
bool addService(BLEClientService&amp; service);

// Functions to work with the raw advertising packet
uint8 t count(void);
uint8 t* getData(void);

bool setData(const uint8 t* data, uint8 t count);
void clearData(void);
bool setData(Advertisable&amp; adv_able) { return adv_able.setAdv(*this); }

In addition to API from BLEAdvertisingData, The BLEAdvertising class also has
functions that dictate the behavior of advertising such as slow/fast timeout, adv
intervals, and callbacks etc...

typedef void (*stop_callback t) (void);
typedef void (*slow callback t) (void);

void setType(uint8 t adv_type);
void setFastTimeout(uintl6 t sec);

void setSlowCallback(slow callback t fp);
void setStopCallback(stop callback t fp);

void setInterval (uintl6 t fast, uintl6 t slow);
void setIntervalMS(uintl6 t fast, uintl6 t slow);

uintl6é t getInterval(void);

bool setBeacon(BLEBeacon&amp; beacon);
bool setBeacon(EddyStoneUrl&amp; eddy url);

bool isRunning(void);
void restartOnDisconnect(bool enable);

bool start(uintl6 t timeout = 0);
bool stop (void);

Related Information

« Generic Access Profile (https://adafru.it/val): This page contains the official list
of assigned numbers for the 'Data’ type field. Data is inserted into the
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advertising packet by supplying a valid 'data’' type, optionally followed by a
properly formatted payload corresponding to the selected value.

Example

For practical example code, see the Examples section later on in this guide. The
snippet below is provided for illustration purposes, but advertising should be
examined in the context of a real use case since it varies from one setup to the next!

void setup(void)

{
// Other startup code here
J] ooc

// Set up Advertising Packet
setupAdv();

// Start Advertising
Bluefruit.Advertising.start();

}

void startAdv(void)

{
// Advertising packet
Bluefruit.Advertising.addFlags(BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// Secondary Scan Response packet (optional)
// Since there is no room for 'Name' in Advertising packet
Bluefruit.ScanResponse.addName();

/* Start Advertising

- Enable auto advertising if disconnected

- Interval: fast mode = 20 ms, slow mode = 152.5 ms

- Timeout for fast mode is 30 seconds

- Start(timeout) with timeout = 0 will advertise forever (until connected)

For recommended advertising interval
https://developer.apple.com/library/content/qa/qal931/ index.html

X ¥ X X %X X ¥

*/
Bluefruit.Advertising.restartOnDisconnect(true);
Bluefruit.Advertising.setInterval(32, 244); // in unit of 0.625 ms

Bluefruit.Advertising.setFastTimeout(30); // number of seconds in fast mode
Bluefruit.Advertising.start(0); // 0 = Don't stop advertising
after n seconds

}
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BLEScanner

The Bluefruit nRF52 BSP codebase is undergoing active development based on

customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

The BLEScanner class is used in Central Mode, and facilitates scanning for BLE

peripherals in range and parsing the advertising data that is being sent out by the

peripherals.

The BLEScanner class is normally accessed via the Bluefruit class (instantiated at

startup), as shown below:

/* Start Central Scanning

* X X ¥ ¥

- Start
Y

Bluefruit.
Bluefruit.
Bluefruit.
&gt;= -80
Bluefruit
Bluefruit.
Bluefruit
seconds

API

- Enable auto scan if disconnected
- Filter for devices with a min RSSI of -80 dBm
- Interval = 100 ms, window = 50 ms
- Use active scan (requests the optional scan response packet)

(0) = will scan forever since no timeout is given

Scanner.
Scanner.
Scanner.

dBm

.Scanner

.Scanner

setRxCallback(scan callback);

restartOnDisconnect(true);
filterRssi(-80);

.setInterval(160, 80);
Scanner.
.start(0);

useActiveScan(true);

BLEScanner has the following public API:

// Only invoke callback when RSSI

// in units of 0.625 ms
// Request scan response data
// 0 = Don't stop scanning after n

typedef void (*rx_callback t) (ble gap evt adv report t*);
typedef void (*stop_callback t) (void);

BLEScanner

(void);

ble gap scan params t* getParams(void);
bool isRunning(void);

void useActiveScan(bool enable);
void setInterval(uintl6 t interval, uintl6 t window);

void setIntervalMS(uintl6 t interval, uintl6_t window);
void restartOnDisconnect(bool enable);
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void filterRssi(int8 t min rssi);
void filterMSD(uintl6 t manuf id);

void filterUuid
void filterUuid
void filterUuid
void filterUuid

BLEUuid ble uuid);

BLEUuid ble uuidl, BLEUuid ble uuid2);

BLEUuid ble uuidl, BLEUuid ble uuid2, BLEUuid ble uuid3);
BLEUuid ble uuidl, BLEUuid ble uuid2, BLEUuid ble uuid3, BLEUuid

P

ble uuid4);
void filterUuid(BLEUuid ble uuid[], uint8 t count);

void clearFilters(void);

bool start(uintl6 t timeout = 0);
bool stop(void);

------------- Callbacks -------------%/

void setRxCallback(rx callback t fp);
void setStopCallback(stop callback t fp);

/*

------------- Data Parser -------------%/

uint8 t parseReportByType(const uint8 t* scandata, uint8 t scanlen, uint8 t type,
uint8 t* buf, uint8 t bufsize = 0);

uint8 t parseReportByType(const ble gap evt adv report t* report, uint8 t type,
u1nt8 t* buf, uint8 t bufsize = 0);

bool checkReportForUuid(const ble gap evt adv_report t* report, BLEUuid

ble uuid);

bool checkReportForService(const ble gap evt adv report t* report,
BLEClientService svc);

bool checkReportForService(const ble gap evt adv report t* report, BLEService
svc);

setRxCallback(rx_callback_t fp)

Whenever a valid advertising packet is detected (based on any optional filters that are

applied in the BLEScanner class), a dedicated callback function (see
rx callback t) will be called.

The callback function has the following signature:

NOTE: ble gap evt adv report t is partofthe Nordic nRF52 SD and is defined in
ble_gap.h

void scan_callback(ble gap evt adv report t* report)

{

/* Display the timestamp and device address */
if (report-&gt;scan_rsp)

/* This is a Scan Response packet */
Serial.printf("[SR%10d] Packet received from ", millis());
}
else
{
/* This is a normal advertising packet */
Serial.printf("[ADV%9d] Packet received from ", millis());
}
Serial.printBuffer(report-&gt;peer addr.addr, 6, ':');
Serial.print("\n");
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/* Raw buffer contents */
Serial.printf("%14s %d bytes\n", "PAYLOAD", report-&gt;dlen);
if (report-&gt;dlen)

Serial.printf("%15s", " ");
Serial.printBuffer(report-&gt;data, report-&gt;dlen, '-');
Serial.println();

}

/* RSSI value */
Serial.printf("%14s %d dBm\n", "RSSI", report-&gt;rssi);

/* Adv Type */
Serial.printf("%14s ", "ADV TYPE");
switch (report-&gt;type)
{
case BLE GAP_ADV_TYPE ADV IND:
Serial.printf("Connectable undirected\n");
break;
case BLE GAP_ADV_TYPE ADV DIRECT IND:
Serial.printf("Connectable directed\n");
break;
case BLE GAP_ADV_TYPE ADV_SCAN IND:
Serial.printf("Scannable undirected\n");
break;
case BLE _GAP_ADV_TYPE_ADV_NONCONN IND:
Serial.printf("Non-connectable undirected\n");
break;

}

/* Check for BLE UART UUID */
if ( Bluefruit.Scanner.checkReportForUuid(report, BLEUART UUID SERVICE) )

{
Serial.printf("%14s %s\n", "BLE UART", "UUID Found!");

}

/* Check for DIS UUID */
if ( Bluefruit.Scanner.checkReportForUuid(report, UUID16 SVC DEVICE INFORMATION) )

{
Serial.printf("%14s %s\n", "DIS", "UUID Found!");

}

Serial.println();

void useActiveScan(bool enable);

Enabling 'Active Scan' by setting the enable parameter to 1 will cause the device to
request the optional Scan Response advertising packet, which is a second 31 byte
advertising packet that can be used to transmit additional information.

By default active scanning is disabled, so no Scan Response packets will be received

by BLEScanner unless this function is called and set to 1 before calling Bluefruit.S
canner.start(0) .
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void filterRssi(int8_t min_rssi);

void filterMSD(uint16_t manuf_id);

void filterUuid(BLEUuid ble_uuid);

void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid?2);
void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2,
BLEUuid ble_uuid3);

void filterUuid(BLEUuid ble_uuid1, BLEUuid ble_uuid2,
BLEUuid ble_uuid3, BLEUuid ble_uuid4);

void filterUuid(BLEUuid ble_uuid[], uint8_t count);

Filters can be applied to BLEScanner to narrow down the data sent to the callback
handler, and make processing advertising packets easier for you.

As of BSP 0.7.0 the following three filters are present:

« filterRssi(int8 t min rssi) : Filters advertising results to devices with at
least the specified RSSI value, which allows you to ignore devices that are too
far away or whose signal is too weak. The higher the number, the strong the
signal so -90 is a very weak signal, and -60 is a much stronger one.

o filterUuid(BLEUuid ble uuid) : Filters advertising results to devices that
advertise themselves as having the specified service UUID. If multiple UUIDs are
entered, they will be filtered with boolean OR logic, meaning any single UUID
present will be considered a match.

« void filterMSD(uintl6 t manuf id) : Fitlers advertising results to devices
that contain a Manufacturer Specific Data data type, and who use the specifed
Bluetooth Customer ID (manuf id) . This can be useful to filter iBeacon versus
Eddystone devices, for example, which both used the MSD field, or to look for
custom MSD data matching your own CID.

When multiple UUIDs are added via one of the filterUuid(...) functions, they

UUIDs will be filtered using boolean 'OR' logic, meaning that the callback will fire
when ANY of the specified UUIDs are detected in the advertising packet.

void clearFilters(void);

This function clears and filter values set using the functions above.
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bool start(uint16_t timeout = 0);
bool stop(void);

The .start and .stop functions can be used to start and stop scanning, and
should be called after all of the main parameters (timing, filters, etc.) have been set.

The .start function has a single parameter called timeout, which sets the number
of seconds to scan for advertising packets. Setting this to '0' (the default value) will
cause the device to scan forever.

Make sure you set any filters of BLEScanner parameters before calling .start!

void restartOnDisconnect(bool enable);

Setting this function to '"1" will cause the scanning process to start again as soon as
you disconnect from a peripheral device. The default behaviour is to automatically
restart scanning on disconnect.

Examples

For an example that uses almost all of the BLEScanner and advertising APl in Central
mode, see central_scan_advanced.ino (https://adafru.it/y5a) in the Central examples
folder.

central_scan_advanced.ino on

Github
https://adafru.it/y5a

This example is only available in BSP 0.7.0 and higher!

BLEService

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62
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This base class is used when defining custom BLE Gatt Services, such as the various
service helper classes that make up the Adafruit Bluefruit nRF52 API described here.

Unless you are implementing a custom GATT service and characteristic, you normally

won't use this base class directly, and would instantiate and call a higher level helper
service or characteristic included in the Bluefruit nRF52 API.

Basic Usage

There are normally only two operation required to use the BLEService class:

You need to declare and instantiate the class with an appropriate 16-bit or 128-bit
UUID in the constructor:

BLEService myService = BLEService(0x1234);

You then need to call the .begin() method on the instance before adding any
BLECharacteristics to it (via the BLECharacteristic's respective .begin() function call):

myService.begin();

Order of Operations (Important!)

One very important thing to take into consideration when working with BLEService
and BLECharacteristic, is that any BLECharacteristic will automatically be added to the
last BLEService that had it's ".begin()" function called. As such, you must

call yourService.begin() before adding any characteristics!

See the example at the bottom of this page for a concrete example of how this works
in practice.

API

BLEService has the following overall class structure:
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This documentation may be slightly out of date as bugs are fixed, and the API

develops. You should always consult the Github repo for the definitive latest

code release and class definitions!

BLEUuid uuid;

static BLEService* lastService;
BLEService(void);

BLEService(uintl6 t uuidl6);
BLEService(uint8 t const uuid128[]);

void setUuid(uintl6_t uuid16);
void setUuid(uint8 t const wuuidl128[]);

virtual err_t begin(void);

Example

The following example declares a HRM (Heart Rate Monitor) service, and assigns
some characteristics to it:

Note that this example code is incomplete. For the full example open the

'custom_hrm' example that is part of the nRF52 BSP! The code below is for
illustration purposes only.

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: 0x2A38
&5/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16_SVC HEART RATE);
BLECharacteristic (UUID16 CHR HEART RATE MEASUREMENT);
BLECharacteristic(UUID16 CHR BODY SENSOR LOCATION);

void setupHRM(void)
{

// Configure the Heart Rate Monitor service

// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.service.heart rate.xml

// Supported Characteristics:

// Name uuib Requirement Properties

Jf] occcc00000000000000000000000 900C0D  COOOODGC00D COOO00C00D

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write &lt;-- Not used
here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was 'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
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// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Permission = Notify

// Min Len =1

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0@ = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)

// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but

contact not detected, 3 = Supported and detected)

// b0o = Value format (0 = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties(CHR _PROPS NOTIFY);

hrmc.setPermission(SECMODE_OPEN, SECMODE_NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdata[2] = { 0b00000110, Ox40 }; // Set the characteristic to use 8-bit
values, with the sensor connected and detected

hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Permission = Read

// Min Len =1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties(CHR PROPS READ);

bslc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);

bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)
}

void cccd callback(BLECharacteristic&amp; chr, uintl6 t cccd value)
{
// Display the raw request packet
Serial.print("CCCD Updated: ");
//Serial.printBuffer(request-&gt;data, request-&gt;len);
Serial.print(cccd value);
Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
}
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BLECharacteristic

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

This base class is used when defining custom BLE GATT characteristics, and is used
throughput the Adafruit Bluefruit nRF52 APl and helper classes.

Unless you are implementing a custom GATT service and characteristic, you normally
won't use this base class directly, and would instantiate and call a higher level helper
service or characteristic included in the Bluefruit nRF52 API.

Basic Usage

There are two main steps to using the BLECharacteristic class.

First, you need to declare and instantiate your BLECharacteristic class with a 16-bit or
128-bit UUID:

BLECharacteristic myChar = BLECharacteristic(OxABCD);

Then you need to set the relevant properties for the characteristic, with the following
values at minimum:

myChar.setProperties(CHR PROPS READ);
myChar.setPermission (SECMODE OPEN, SECMODE NO ACCESS);
myChar.setFixedLen(1); // Alternatively .setMaxLen(uintl6 t len)
myChar.begin();

- .setProperties can be set to one or more of the following macros, which
correspond to a single bit in the eight bit 'properties' field for the characteristic
definition:

o CHR_PROPS_BROADCAST = bit(0),

o CHR_PROPS_READ = bit(1),

o CHR_PROPS_WRITE_WO_RESP = bit(2),
o CHR_PROPS_WRITE = bit(3),

o CHR_PROPS_NOTIFY = bit(4),
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°© CHR_PROPS_INDICATE = bit(5)

- .setPermission sets the security level for the characteristic, where the first value
sets the read permissions, and the second value sets the write permissions,
where both fields can have one of the following values:

o SECMODE_NO_ACCESS = 0x00,

o SECMODE_OPEN = Ox11,

o SECMODE_ENC_NO_MITM = 0x21,

o SECMODE_ENC_WITH_MITM = 0x31,

o SECMODE_SIGNED_NO_MITM = 0x12,

o SECMODE_SIGNED_WITH_MITM = 0x22

. .setFixedLen() indicates how many bytes this characteristic has. For
characteristics that use 'notify' or 'indicate' this value can be from 1..20, other
characteristic types can be set from 1..512 and values >20 bytes will be sent
across multiple 20 byte packets. If the characteristic has a variable len, you set
the .setMaxLen() value to the maximum value it will hold (up to 20 bytes).

« .begin() will cause this characteristic to be added to the last BLEService that had
it's .begin() method called.

Order of Operations (Important!)

One very important thing to take into consideration when working with BLEService
and BLECharacteristic, is that any BLECharacteristic will automatically be added to the
last BLEService that had it's ".begin() function called. As such, you must

call yourService.begin() before adding any characteristics!

See the example at the bottom of this page for a concrete example of how this works
in practice.

API

BLECharacteristic has the following overall class structure:

This documentation may be slightly out of date as bugs are fixed, and the API

develops. You should always consult the Github repo for the definitive latest
code release and class definitions!

[HPomccconns Callback Signatures ---------- */
typedef void (*read authorize cb t) (BLECharacteristic&amp; chr,
ble gatts evt read t * request);
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typedef void (*write authorize cb t)
ble gatts evt write t* request);
typedef void (*write cb t)

uintl6é t len, uintl6_t offset);
typedef void (*write cccd cb t)

BLEUuid uuid;

// Constructors
BLECharacteristic(void);
BLECharacteristic(BLEUuid bleuuid);

// Destructor
virtual ~BLECharacteristic();

BLEService&amp; parentService(void);

void setTempMemory(void);

void
void
void
void
void

Configure
setUuid (BLEUuid bleuuid);
setProperties(uint8 t prop);

setMaxLen(uintl6_t max_len);
setFixedLen(uintl6 t fixed len);

/*
void

Descriptors

addDescriptor()

(BLECharacteristic&amp; chr,
(BLECharacteristic&amp; chr, uint8 t* data,

(BLECharacteristic&amp; chr, uintl6 t value);

setPermission(BleSecurityMode read perm, BleSecurityMode write perm);

setUserDescriptor(const char* descriptor); // aka user descriptor
void setReportRefDescriptor(uint8 t id, uint8 t type);

// TODO refactor to use

void setPresentationFormatDescriptor(uint8 t type, int8 t exponent, uintl6 t unit,

uint8 t name space

Callbacks
setWriteCallback

setCccdWriteCallback
setReadAuthorizeCallback
setWriteAuthorizeCallbak

void
void
void
void

—_— e~ o~ —~

virtual err_t begin(void);

// Add Descriptor function must be called
err_t addDescriptor(BLEUuid bleuuid, void
SECMODE_OPEN,

BleSecurityMode read perm
SECMODE_NO_ACCESS) ;

1, uintl6 t descritpor

0);

write cb t fp);

write cccd cb t fp);

read authorize cb t fp);
write authorize cb t fp);

right after begin()
const * content, uintl6 t len,
BleSecurityMode write perm

ble gatts char handles t handles(void);

len);

YA Write ------------- &
uintl6é t write(const void* data, uintl6 t
uintl6 t write(const char* str);

uintle t write8 (uint8 t num);
uintl6e t writel6 (uintl6_t num);
uintle t write32 (uint32_t num);
uintle t write32 (int num) ;
[¥---oma - Read ------------- 27
uintl6 t read(void* buffer, uintl6 t bufsize);
uint8 t read8 (void);

uintl6é t readl6(void);

uint32 t read32(void);

Y Notify -------------

uintl6e t getCccd(void);

bool notifyEnabled(void);
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bool notify(const void* data, uintl6 t len);
bool notify(const char* str);

bool notify8 (uint8 t num);
bool notifyl6 (uintl6_t num);
bool notify32 (uint32_t num);
bool notify32 (int num) ;

[¥---o - Indicate ------------- 4
bool indicateEnabled(void);

bool indicate(const void* data, uintl6_t len);
bool indicate(const char* str);

bool indicate8 (uint8 t num)
bool indicatel6 (uintl6 t num)
( )
( )

bool indicate32 uint32 t num
bool indicate32 int num

Example

The following example configures an instance of the Heart Rate Monitor (HRM)
Service and it's related characteristics:

Note that this example code is incomplete. For the full example open the

'custom_hrm' example that is part of the nRF52 BSP! The code below is for

illustration purposes only.

/* HRM Service Definitions
* Heart Rate Monitor Service: 0x180D
* Heart Rate Measurement Char: 0x2A37
* Body Sensor Location Char: Ox2A38
&/
BLEService hrms
BLECharacteristic hrmc
BLECharacteristic bslc

BLEService(UUID16 SVC HEART RATE);
BLECharacteristic(UUID16 CHR HEART RATE MEASUREMENT) ;
BLECharacteristic(UUID16 CHR BODY SENSOR LOCATION);

void setupHRM(void)

// Configure the Heart Rate Monitor service

// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.service.heart rate.xml

// Supported Characteristics:

// Name UuID Requirement Properties

[l eeccccccccccsccccccccccccoos coooee  ooccccccoos coooooooos

// Heart Rate Measurement 0x2A37 Mandatory Notify

// Body Sensor Location 0x2A38 Optional Read

// Heart Rate Control Point 0x2A39 Conditional Write &lt;-- Not used
here

hrms.begin();

// Note: You must call .begin() on the BLEService before calling .begin() on
// any characteristic(s) within that service definition.. Calling .begin() on
// a BLECharacteristic will cause it to be added to the last BLEService that
// was 'begin() 'ed!

// Configure the Heart Rate Measurement characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
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attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Permission = Notify

// Min Len = il

// Max Len =8

// BO = UINT8 - Flag (MANDATORY)

// b5:7 = Reserved

// b4 = RR-Internal (0@ = Not present, 1 = Present)

// b3 = Energy expended status (0 = Not present, 1 = Present)

// bl:2 = Sensor contact status (0+1 = Not supported, 2 = Supported but

contact not detected, 3 = Supported and detected)

// b0o = Value format (0 = UINT8, 1 = UINT16)

// Bl = UINT8 - 8-bit heart rate measurement value in BPM
// B2:3 = UINT16 - 16-bit heart rate measurement value in BPM
// B4:5 = UINT16 - Energy expended in joules

// B6:7 = UINT16 - RR Internal (1/1024 second resolution)

hrmc.setProperties(CHR _PROPS NOTIFY);

hrmc.setPermission(SECMODE OPEN, SECMODE NO ACCESS);

hrmc.setFixedLen(2);

hrmc.setCccdWriteCallback(cccd callback); // Optionally capture CCCD updates

hrmc.begin();

uint8 t hrmdatal[2] = { 0b00000110, Ox40 }; // Set the characteristic to use 8-bit
values, with the sensor connected and detected

hrmc.notify(hrmdata, 2); // Use .notify instead of .write!

// Configure the Body Sensor Location characteristic
// See: https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Permission = Read

// Min Len =1

// Max Len =1

// BO = UINT8 - Body Sensor Location
// 0 = Other

// 1 = Chest

// 2 = Wrist

// 3 = Finger
// 4 = Hand

// 5 = Ear Lobe
// 6 = Foot

// 7:255 = Reserved

bslc.setProperties(CHR _PROPS READ);

bslc.setPermission(SECMODE_OPEN, SECMODE_NO ACCESS);

bslc.setFixedLen(1);

bslc.begin();

bslc.write8(2); // Set the characteristic to 'Wrist' (2)
}

void cccd callback(BLECharacteristic&amp; chr, uintl6 t cccd value)
{
// Display the raw request packet
Serial.print("CCCD Updated: ");
//Serial.printBuffer(request-&gt;data, request-&gt;len);
Serial.print(cccd value);
Serial.println("");

// Check the characteristic this CCCD update is associated with in case
// this handler is used for multiple CCCD records.
if (chr.uuid == hrmc.uuid) {
if (chr.notifyEnabled()) {
Serial.println("Heart Rate Measurement 'Notify' enabled");
} else {
Serial.println("Heart Rate Measurement 'Notify' disabled");
}
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BLECIlientService

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

This base class is used when defining custom BLE Gatt Clients.
Unless you are implementing a custom GATT client service and characteristic, you

normally won't use this base class directly, and would instantiate and call a higher
level helper service or characteristic included in the Bluefruit nRF52 API.

Basic Usage

There are normally only threes operations required to use the BLEClientService class:

1.) You need to declare and instantiate the class with an appropriate 16-bit or 128-bit
UUID in the constructor:

BLEClientService myService = BLEService(0x1234);

2.) You then need to call the .begin() method on the instance before adding any
BLECIlientCharacteristics to it (via the BLEClientCharacteristic's respective .begin()
function call):

myService.begin();

3) When connected e.g in connect callback, you should call .discover() to discover the
service

myService.discover();

API

BLECIlientService has the following overall class structure:
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This documentation may be slightly out of date as bugs are fixed, and the API

develops. You should always consult the Github repo for the definitive latest

code release and class definitions!

BLEUuid uuid;

// Constructors
BLEClientService(void);
BLEClientService(BLEUuid bleuuid);

virtual bool begin(void);
virtual bool discover (uintl6_t conn_handle);
bool discovered(void);

uintl6 t connHandle(void);

void setHandleRange(ble gattc _handle range t handle range);
ble gattc handle range t getHandleRange(void);

Example

The following example declares a HRM (Heart Rate Monitor) service, and assigns
some characteristics to it:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information
All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/

/* This sketch show how to use BLEClientService and BLEClientCharacteristic
to implement a custom client that is used to talk with Gatt server on
peripheral.

Note: you will need another feather52 running peripheral/custom HRM sketch
to test with.

#include &lt;bluefruit.h&gt;

/* HRM Service Definitions

* Heart Rate Monitor Service: 0x180D
Heart Rate Measurement Char: 0x2A37 (Mandatory)
* Body Sensor Location Char: Ox2A38 (Optional)
L

*

BLEClientService hrms (UUID16 SVC HEART RATE);
BLEClientCharacteristic hrmc(UUID16 CHR HEART RATE MEASUREMENT) ;
BLEClientCharacteristic bslc(UUID16 CHR BODY SENSOR LOCATION);
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void setup()

{

©

n

}

\

}
/

\"

{

}
/

Vv

Serial.begin(115200);

Serial.println("Bluefruit52 Central Custom HRM Example");
Serial.println(M------mmmm e \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1
// SRAM usage required by SoftDevice will increase dramatically with number of
onnections

Bluefruit.begin(0, 1);

Bluefruit.setName("Bluefruit52 Central");

// Initialize HRM client
hrms.begin();

// Initialize client characteristics of HRM.
// Note: Client Char will be added to the last service that is begin()ed.
bslc.begin();

// set up callback for receiving measurement
hrmc.setNotifyCallback(hrm notify callback);
hrmc.begin();

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setDisconnectCallback(disconnect callback);
Bluefruit.Central.setConnectCallback(connect callback);

/* Start Central Scanning

* - Enable auto scan if disconnected

* - Interval = 100 ms, window = 80 ms

* - Don't use active scan

* - Filter only accept HRM service

* - Start(timeout) with timeout = 0 will scan forever (until connected)
Y

Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);

Bluefruit.Scanner.setInterval(160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.filterUuid(hrms.uuid);

Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // // @ = Don't stop scanning after
seconds

oid loop()

// do nothing

* %

* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data

&

oid scan_callback(ble gap evt adv report t* report)

// Connect to device with HRM service in advertising
Bluefruit.Central.connect(report);

Xk

* Callback invoked when an connection is established
* @param conn_handle

*/

oid connect callback(uintl6 t conn_handle)
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Serial.println("Connected");
Serial.print("Discovering HRM Service ... ");

// If HRM is not found, disconnect and return
if ( 'hrms.discover(conn_handle) )

{
Serial.println("Found NONE");

// disconect since we couldn't find HRM service
Bluefruit.Central.disconnect(conn handle);

return;

}

// Once HRM service is found, we continue to discover its characteristic
Serial.println("Found it");

Serial.print("Discovering Measurement characteristic ... ");
if ( 'hrmc.discover() )
{

// Measurement chr is mandatory, if it is not found (valid), then disconnect
Serial.println("not found !!!");
Serial.println("Measurement characteristic is mandatory but not found");
Bluefruit.Central.disconnect(conn_handle);
return;

}

Serial.println("Found it");

// Measurement is found, continue to look for option Body Sensor Location

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Body Sensor Location is optional, print out the location in text if present

Serial.print("Discovering Body Sensor Location characteristic ... ");

if ( bslc.discover() )

{

Serial.println("Found it");

// Body sensor location value is 8 bit
const char* body str[] = { "Other", "Chest", "Wrist", "Finger", "Hand", "Ear
LObe", "FOO't" };

// Read 8-bit BSLC value from peripheral
uint8 t loc value = bslc.read8();

Serial.print("Body Location Sensor: ");
Serial.println(body_str[loc_value]);
}else

{
}

// Reaching here means we are ready to go, let's enable notification on
measurement chr
if ( hrmc.enableNotify() )

{
Serial.println("Ready to receive HRM Measurement value");
}else

{
Serial.println("Couldn't enable notify for HRM Measurement. Increase DEBUG
LEVEL for troubleshooting");
}
}

/x*
* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason

Serial.println("Found NONE");
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*/
void disconnect callback(uintl6 _t conn handle, uint8 t reason)

{
(void) conn_handle;
(void) reason;

Serial.println("Disconnected");

}

/**
* Hooked callback that triggered when a measurement value is sent from peripheral
* @param chr Pointer client characteristic that even occurred,
& in this example it should be hrmc
* @param data Pointer to received data
* @param len Length of received data
L5

void hrm notify callback(BLEClientCharacteristic* chr, uint8 t* data, uintl6 t len)
{

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Measurement contains of control byte@® and measurement (8 or 16 bit) + optional
field

// if byteO®'s bit® is 0 --&gt; measurement is 8 bit, otherwise 16 bit.
Serial.print("HRM Measurement: ");

if ( data[0] &amp; bit(0) )

{

uintl6e t value;
memcpy (&amp;value, data+l, 2);

Serial.println(value);

}

else

{

}
}

Serial.println(data[l]);

BLECIlientCharacteristic

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

This base class is used when defining custom client for BLE GATT characteristics, and
is used throughout the Adafruit Bluefruit nRF52 APl and helper classes.

Unless you are implementing a custom client for GATT service and characteristic, you

normally won't use this base class directly, and would instantiate and call a higher
level helper service or characteristic included in the Bluefruit nRF52 API.
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Basic Usage

There are three main steps to using the BLECharacteristic class.

1.) First, you need to declare and instantiate your BLECharacteristic class with a 16-bit
or 128-bit UUID:

BLEClientCharacteristic myChar = BLEClientCharacteristic(OxABCD);

2.) Then you need to set the relevant callback for the characteristic if it supports
notify or indicate.

myChar.setNotifyCallback(notify callback);
myChar.begin();

. .setNotifyCallback This sets the callback that will be fired when we receive a
Notify message from peripheral. This is needed to handle notifiable
characteristic since callback allow us to response to the message in timely
manner

« .begin() will cause this characteristic to be added to the last BLEClientService
that had it's .begin() method called.

3) Discover the characteristic after connected to peripheral by calling .discover() |
tis a must in order to perform any operation such as .read(), .write(), .enableNotify().

if ( myChar.discover() )

{
uint32 t value = myChar.read32();

}

API

BLECIlientCharacteristic has the following overall class structure:

This documentation may be slightly out of date as bugs are fixed, and the API

develops. You should always consult the Github repo for the definitive latest
code release and class definitions!

[H¥eoccccooos Callback Signatures ---------- */
typedef void (*notify cb t ) (BLEClientCharacteristic* chr, uint8 t* data,
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uintl6 t

typedef void (*indicate cb t)

uintl6e t

len);

len);

BLEUuid uuid;

// Constructors
BLEClientCharacteristic(void);
BLEClientCharacteristic(BLEUuid bleuuid);

// Destructor

virtual ~

void

bool
bool

uintl6 t
uintl6e t
uint8 t

BLEClientCharacteristic();
begin(BLEClientService* parent svc = NULL);

discover(void);
discovered(void);

connHandle(void);
valueHandle(void);
properties(void);

BLEClientService&amp; parentService(void);

uintl6e t
uint8 t
uintl6 t
uint32 t

uintl6 t
uintl6 t
uintl6 t
uintl6 t

uintl6 t
uintl6 t
uintl6 t
uintl6 t

/* _______

bool

bool
bool

bool
bool

void
void

------ Read -------------*%/
read(void* buffer, uintl6 t bufsize);
read8 (void);

readl6e(void);

read32(void);

------ Write without Response-------------%/
write (const void* data, uintl6 _t len);
write8 (uint8 t value);

writel6 (uintl6 t value);

write32 (uint32_t value);

------ Write with Response-------------*%/
write resp(const void* data, uintl6 t len);
write8 resp (uint8 t value);

writel6 resp (uintl6 t value);

write32 resp (uint32_t value);

------ Notify -------------*%/
writeCCCD (uintl6_t value);

enableNotify (void);
disableNotify (void);

enableIndicate (void);
disableIndicate (void);

------ Callbacks -------------*/

setNotifyCallback(notify cb t fp, bool useAdaCallback = true);

(BLEClientCharacteristic* chr, uint8 t* data,

setIndicateCallback(indicate cb t fp, bool useAdaCallback = true);

Example

The following example configures an instance of the Heart Rate Monitor (HRM)

Service and it's related characteristics:

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules
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Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information
All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/

/* This sketch show how to use BLEClientService and BLEClientCharacteristic

* to implement a custom client that is used to talk with Gatt server on

* peripheral.

*

* Note: you will need another feather52 running peripheral/custom HRM sketch
* to test with.

&/

#include &lt;bluefruit.h&gt;

/* HRM Service Definitions

* Heart Rate Monitor Service: 0x180D
Heart Rate Measurement Char: 0x2A37 (Mandatory)
* Body Sensor Location Char: 0x2A38 (Optional)
w5/

*

BLEClientService hrms (UUID16 SVC HEART RATE);
BLEClientCharacteristic hrmc(UUID16 CHR HEART RATE MEASUREMENT) ;
BLEClientCharacteristic bslc(UUID16_CHR BODY SENSOR_LOCATION);

void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 Central Custom HRM Example");
SErilal . PramtlR(Peccccccccnccccscccccccccconccccsasccas \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1

// SRAM usage required by SoftDevice will increase dramatically with number of
connections

Bluefruit.begin(0, 1);

Bluefruit.setName("Bluefruit52 Central");

// Initialize HRM client
hrms.begin();

// Initialize client characteristics of HRM.
// Note: Client Char will be added to the last service that is begin()ed.
bslc.begin();

// set up callback for receiving measurement
hrmc.setNotifyCallback(hrm notify callback);
hrmc.begin();

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setDisconnectCallback(disconnect callback);
Bluefruit.Central.setConnectCallback(connect callback);

/* Start Central Scanning

- Enable auto scan if disconnected

- Interval = 100 ms, window = 80 ms

- Don't use active scan

- Filter only accept HRM service

- Start(timeout) with timeout = 0 will scan forever (until connected)

* X X ¥ X
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S

Bluefruit.Scanner.setRxCallback(scan callback);

Bluefruit.Scanner.restartOnDisconnect(true);

Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms

Bluefruit.Scanner.filterUuid(hrms.uuid);

Bluefruit.Scanner.useActiveScan(false);

Bluefruit.Scanner.start(0); // // O = Don't stop scanning after
n seconds

}
void loop()

// do nothing
}

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
&

void scan callback(ble gap evt adv report t* report)

{
// Connect to device with HRM service in advertising
Bluefruit.Central.connect(report);

}

/x*
* Callback invoked when an connection is established
* @param conn_handle

*/

void connect callback(uintl6 t conn handle)

{
Serial.println("Connected");
Serial.print("Discovering HRM Service ... ");

// If HRM is not found, disconnect and return
if ( 'hrms.discover(conn_handle) )

{
Serial.println("Found NONE");

// disconect since we couldn't find HRM service
Bluefruit.Central.disconnect(conn_handle);

return;

}

// Once HRM service is found, we continue to discover its characteristic
Serial.println("Found it");

Serial.print("Discovering Measurement characteristic ... ");
if ( 'hrmc.discover() )
{

// Measurement chr is mandatory, if it is not found (valid), then disconnect
Serial.println("not found !!!");

Serial.println("Measurement characteristic is mandatory but not found");
Bluefruit.Central.disconnect(conn handle);

return;

}

Serial.println("Found it");

// Measurement is found, continue to look for option Body Sensor Location

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.body sensor location.xml

// Body Sensor Location is optional, print out the location in text if present

Serial.print("Discovering Body Sensor Location characteristic ... ");

if ( bslc.discover() )

{

Serial.println("Found it");
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// Body sensor location value is 8 bit
const char* body str[] = { "Other", "Chest", "Wrist", "Finger", "Hand", "Ear
Lobe", "Foot" };

// Read 8-bit BSLC value from peripheral
uint8 t loc value = bslc.read8();

Serial.print("Body Location Sensor: ");
Serial.println(body str[loc valuel);
}else

{
}

Serial.println("Found NONE");

// Reaching here means we are ready to go, let's enable notification on
measurement chr
if ( hrmc.enableNotify() )
{
Serial.println("Ready to receive HRM Measurement value");
}else

{
Serial.println("Couldn't enable notify for HRM Measurement. Increase DEBUG
LEVEL for troubleshooting");
}
}

/**
* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason
*/
void disconnect callback(uintl6_t conn _handle, uint8 t reason)
{
(void) conn_handle;
(void) reason;

Serial.println("Disconnected");

}
/**
* Hooked callback that triggered when a measurement value is sent from peripheral
* @param chr Pointer client characteristic that even occurred,
* in this example it should be hrmc
* @param data Pointer to received data
* @param len Length of received data
&7

void hrm notify callback(BLEClientCharacteristic* chr, uint8 t* data, uintl6 t len)

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.heart rate measurement.xml

// Measurement contains of control byte® and measurement (8 or 16 bit) + optional
field

// if byte@'s bit® is 0 --&gt; measurement is 8 bit, otherwise 16 bit.

Serial.print("HRM Measurement: ");

if ( data[0] &amp; bit(0) )
{
uintl6 t value;
memcpy (&amp;value, data+l, 2);

Serial.println(value);

}

else

{

}
}

Serial.println(datal[l]);
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BLEDiscovery

This page is a work in progress as the API is changing as we migrate to S132v5

(nRF52832) and S140 (nRF52840) and add better Central mode support.

BLEDiscovery is a helper class to make finding characteristics on a Gatt server
(hosted on a BLE peripheral) easier. For service discovery, the BLEClientService's di
scover() API must be used, as shown below:

API

BLEDiscovery(void); // Constructor

void begin(void);
bool begun(void);
void setHandleRange(ble gattc handle range t handle range);

ble gattc _handle range t getHandleRange(void);

uint8 t discoverCharacteristic(uintl1l6 t conn handle, BLEClientCharacteristic*
chr[], uint8 t count);

uint8 t discoverCharacteristic(uintl6 t conn_handle, BLEClientCharacteristic&amp;
chrl);

uint8 t discoverCharacteristic(uintl6 t conn handle, BLEClientCharacteristic&amp;
chrl, BLEClientCharacteristic&amp; chr2);

uint8 t discoverCharacteristic(uintl6 t conn_handle, BLEClientCharacteristic&amp;
chrl, BLEClientCharacteristic&amp; chr2, BLEClientCharacteristic&amp; chr3);
uint8 t discoverCharacteristic(uintl1l6 t conn handle, BLEClientCharacteristic&amp;
chrl, BLEClientCharacteristic&amp; chr2, BLEClientCharacteristic&amp; chr3,
BLEClientCharacteristic&amp; chr4);

uint8 t discoverCharacteristic(uintl1l6 t conn handle, BLEClientCharacteristic&amp;
chrl, BLEClientCharacteristic&amp; chr2, BLEClientCharacteristic&amp; chr3,
BLEClientCharacteristic&amp; chr4, BLEClientCharacteristic&amp; chr5);

For concrete examples of how to use this API see the 'Central’ folder in the

examples that are part of the BSP.

BLEDis

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62
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This helper class acts as a wrapper for the Bluetooth Device Information Service (http
s://adafru.it/q9E) (Ox180A). This official GATT service allows you to publish basic
information about your device in a generic manner.

The Bluefruit BLEDis helper class exposes the following characteristics:

« Model Number String (https://adafru.it/vav) (0x2A24), exposed via .setModel(con
st char”)

« Serial Number String (https://adafru.it/vaw) (Ox2A25), private

« Firmware Revision String (https://adafru.it/vax) (Ox2A26), private

« Hardware Revision String (https://adafru.it/vay) (Ox2A27), exposed via .setHardw
areRev(const char*)

« Software Revision String (https://adafru.it/vaz) (Ox2A28), exposed via .setSoftwa
reRev(const char*)

« Manufacturer Name String (https://adafru.it/vaA) (Ox2A29), exposed via .setMan
ufacturer(const char®)

The Serial Number String is private and is populated with a unique device ID that
NRF52832 SoCs are programmed with during manufacturing.

The Firmware Revision String is also private and is populated with the following fields
(to help us track issues and offer better feedback in the support forums):

o Softdevice Name (Sxxx)
o Softdevice Version (x.x.x)
o Bootloader Version (x.Xx.x)

Note: The Softdevice and Bootloader fields are separated by a single comma,

meaning the final output will resemble the following string: 'S132 2.0.1, 0.5.0'

The remaining characteristics are all public and can be set to an value (up to 20 chars
in length) using the appropriate helper function, but they have the following default
values (for the nRF52832):

« Model Number String: Bluefruit Feather 52

« Hardware Revision String: NULL

« Software Revision String: The nRF52 BSP version number
« Manufacturer Name String: Adafruit Industries
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Setting a public value to NULL will prevent the characteristic from being present in
the DIS service.

API

The following functions and constructors are defined in the BLEDis class:

BLEDis (void);

void setModel(const char* model);

void setHardwareRev(const char* hw rev);

void setSoftwareRev(const char* sw rev);

void setManufacturer(const char* manufacturer);

err_t begin(void);

The individual characteristic values are set via the .set*() functions above, and when
all values have been set you call the .begin() function to add the service to the
device's internal GATT registry.

Example

The following bare bones examples show how to setup the device information service
with user-configurable strings for values:

#include &lt;bluefruit.hé&gt;

BLEDis bledis;

void setup()

{ Serial.begin(115200);
Serial.println("Bluefruit52 DIS Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
bledis.setModel ("Bluefruit Feather52");
bledis.begin();

// Set up Advertising Packet
setupAdv();

// Start Advertising
Bluefruit.Advertising.start();

}

void setupAdv(void)

Bluefruit.Advertising.addFlags (BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);
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Bluefruit.Advertising.addTxPower();

// There isn't enough room in the advertising packet for the
// name so we'll place it on the secondary Scan Response packet
Bluefruit.ScanResponse.addName();

}

void loop()

{
}

Output

If you examine the device using the Bluefruit LE Connect app on iOS, Android or OS X
you should see something resembling the following output:

BLEUart

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is
incomplete, and you should consult the Github repo for the latest code and API

developments: https://goo.gl/LdEx62

BLEUart is a wrapper class for NUS (Nordic UART Service), which is a proprietary
service defined by Nordic Semiconductors that we use as a baseline transport
mechanism between Bluefruit modules and our mobile and desktop Bluefruit LE
Connect applications. You can use it to easily send ASCII or binary data in both
directions, between the peripheral and the central device.

API

BLEUart has the following public API:

// RX Callback signature (fires when data was written by the central)
typedef void (*rx callback t) (void);
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// Constructor

BLEUart(uint16 t fifo depth = BLE UART DEFAULT FIFO DEPTH);

virtual err_t begin(void);

bool notifyEnabled(void);

void setRxCallback( rx callback t fp);

// Stream API

virtual int read
virtual int read
virtual size t write
virtual size t write
virtual int available
virtual int peek
virtual void flush

(
(
(
(
(
(
(

void );

uint8 t * buf, size t size );

uint8 t b );

const uint8 t *content, size t len );
void );

void );

void );

// Pull in write(str) and write(buf, size) from Print

using Print::write;

Example

The following example shows how to use the BLEUart helper class.

This example may be out of date, and you should always consult the latest example

code in the nRF52 BSP!

#include &lt;bluefruit.h&gt;

BLEDis bledis;
BLEUart bleuart;
BLEBas blebas;

#define STATUS LED (17)
#define BLINKY MS (2000)

uint32 t blinkyms;
void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 BLEUART Example");

// Setup LED pins and reset blinky counter
pinMode (STATUS LED, OUTPUT);

blinkyms = millis();

// Setup the BLE LED to be enabled on CONNECT

// Note: This is actually the default behaviour, but provided
// here in case you want to control this manually via PIN 19
Bluefruit.autoConnLed(true);

Bluefruit.begin();

Bluefruit.setName("Bluefruit52");
Bluefruit.setConnectCallback(connect callback);
Bluefruit.setDisconnectCallback(disconnect callback);

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
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bledis.setModel("Bluefruit Feather52");
bledis.begin();

// Configure and Start BLE Uart Service
bleuart.begin();

// Start BLE Battery Service
blebas.begin();
blebas.update(100);

// Set up Advertising Packet
setupAdv();

// Start Advertising
Bluefruit.Advertising.start();

}

void setupAdv(void)

{
Bluefruit.Advertising.addFlags(BLE GAP_ADV FLAGS LE ONLY GENERAL DISC MODE);
Bluefruit.Advertising.addTxPower();

// Include bleuart 128-bit uuid
Bluefruit.Advertising.addService(bleuart);

// There is no room for Name in Advertising packet
// Use Scan response for Name
Bluefruit.ScanResponse.addName();

}

void loop()
{
// Blinky!
if (blinkyms+BLINKY MS &lt; millis()) {
blinkyms = millis();
digitalToggle(STATUS LED);
}

// Forward from Serial to BLEUART
if (Serial.available())

{
// Delay to get enough input data since we have a
// limited amount of space in the transmit buffer
delay(2);

uint8 t buf[64];
int count = Serial.readBytes(buf, sizeof(buf));
bleuart.write( buf, count );

}

// Forward from BLEUART to Serial

if ( bleuart.available() )

{
uint8 t ch;
ch = (uint8 t) bleuart.read();
Serial.write(ch);

}

}

void connect callback(void)

Serial.println("Connected");

}

void disconnect callback(uint8 t reason)
{

(void) reason;

Serial.println();
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Serial.println("Disconnected");
Serial.println("Bluefruit will start advertising again");

}

BLEClientUart

The Bluefruit nRF52 BSP codebase is undergoing active development based on

customer feedback and testing. As such, the class documentation here is
incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

BLECIlientUart is a wrapper class for the client side of the NUS or 'Nordic UART
Service' (aka 'BLE UART'). It is only required when your Bluefruit nRF52 board is
acting as Central communicating to other BLE peripherals that expose the BLEUart (h
ttps://adafru.it/yud) service.

API

BLECIlientUart has the following public API:
// Callback Signatures
typedef void (*rx _callback t) (BLEClientUart&amp; svc);
BLEClientUart(uint16 t fifo depth = BLE UART DEFAULT FIFO DEPTH);

virtual bool begin(void);
virtual bool discover(uintl6 t conn handle);

void setRxCallback( rx callback t fp);

bool enableTXD(void);
bool disableTXD(void);

// Stream API

virtual int read ( void );
virtual int read ( uint8 t * buf, size t size );
int read ( char * buf, size t size ) { return
read( (uint8 t*) buf, size); }
virtual size t write (uint8 t b );
virtual size t write ( const uint8 t *content, size t len );
virtual int available ( void );
virtual int peek ( void );
virtual void flush ( void );
Examples

The following example shows how to use the BLEClientUart helper class.

©Adafruit Industries Page 127 of 176


https://goo.gl/LdEx62
file:///home/bluefruit-nrf52-feather-learning-guide/bleuart

#include &lt;bluefruit.h&gt;

BLEClientDis clientDis;
BLEClientUart clientUart;

void setup()

{
Serial.begin(115200);

Serial.println("Bluefruit52 Central BLEUART Example");
Serial.println("--------------------------- - \n");

// Initialize Bluefruit with maximum connections as Peripheral = 0, Central =1

// SRAM usage required by SoftDevice will increase dramatically with number of
connections

Bluefruit.begin(0, 1);

Bluefruit.setName("Bluefruit52 Central");

// Configure DIS client
clientDis.begin();

// Init BLE Central Uart Serivce
clientUart.begin();
clientUart.setRxCallback(bleuart rx callback);

// Increase Blink rate to different from PrPh advertising mode
Bluefruit.setConnLedInterval(250);

// Callbacks for Central
Bluefruit.Central.setConnectCallback(connect callback);
Bluefruit.Central.setDisconnectCallback(disconnect callback);

/* Start Central Scanning
* - Enable auto scan if disconnected
*¥ - Interval = 100 ms, window = 80 ms
* - Don't use active scan
* - Start(timeout) with timeout = 0 will scan forever (until connected)
S
Bluefruit.Scanner.setRxCallback(scan callback);
Bluefruit.Scanner.restartOnDisconnect(true);
Bluefruit.Scanner.setInterval (160, 80); // in unit of 0.625 ms
Bluefruit.Scanner.useActiveScan(false);
Bluefruit.Scanner.start(0); // // @ = Don't stop scanning after
n seconds

}

/**
* Callback invoked when scanner pick up an advertising data
* @param report Structural advertising data
&

void scan callback(ble gap evt adv report t* report)

// Check if advertising contain BleUart service
if ( Bluefruit.Scanner.checkReportForService(report, clientUart) )

{
Serial.print("BLE UART service detected. Connecting ... ");

// Connect to device with bleuart service in advertising
Bluefruit.Central.connect(report);

}
}

/**
* Callback invoked when an connection is established
* @param conn_handle

55

void connect callback(uintl6 t conn handle)
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Serial.println("Connected");

Serial.print("Dicovering DIS ... ");
if ( clientDis.discover(conn_handle) )
{

Serial.println("Found it");
char buffer[32+1];

// read and print out Manufacturer
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getManufacturer(buffer, sizeof(buffer)) )
{
Serial.print("Manufacturer: ");
Serial.println(buffer);
}

// read and print out Model Number
memset (buffer, 0, sizeof(buffer));
if ( clientDis.getModel(buffer, sizeof(buffer)) )
{
Serial.print("Model: ");
Serial.println(buffer);
}

Serial.println();

}
Serial.print("Discovering BLE Uart Service ... ");

if ( clientUart.discover(conn_handle) )

{

Serial.println("Found it");

Serial.println("Enable TXD's notify");
clientUart.enableTXD();

Serial.println("Ready to receive from peripheral");
}else

{
Serial.println("Found NONE");

// disconect since we couldn't find bleuart service
Bluefruit.Central.disconnect(conn_handle);
}
}

/**
* Callback invoked when a connection is dropped
* @param conn_handle
* @param reason
*/
void disconnect callback(uintl6_t conn_handle, uint8 t reason)
{
(void) conn_handle;
(void) reason;

Serial.println("Disconnected");

}

/**
* Callback invoked when uart received data
* @param uart svc Reference object to the service where the data
* arrived. In this example it is clientUart
&
void bleuart rx callback(BLEClientUart&amp; uart svc)

{
Serial.print("[RX]: ");
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while ( uart_svc.available() )
{

Serial.print( (char) uart svc.read() );
}

Serial.println();
}

void loop()
{

if ( Bluefruit.Central.connected() )

// Not discovered yet

if ( clientUart.discovered() )

{
// Discovered means in working state
// Get Serial input and send to Peripheral
if ( Serial.available() )

{
delay(2); // delay a bit for all characters to arrive

char str[20+1] = { 0 };
Serial.readBytes(str, 20);

clientUart.print( str );

BLEBeacon

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

The BLEBeacon helper class allows you to easily configure the nRF52 as a 'Beacon’,

which uses the advertising packet to send out a specifically format chunk of data to
any devices in listening range.

The following values must be set in order to generate a valid 'Beacon' packet:

- Manufacturer ID: A 16-bit value (registered with the Bluetooth SIG (https://
adafru.it/vaB)!) that identifies the manufacturer.

« Major: A 16-bit 'Major' number, used to differentiate beacon nodes.

« Minor: A 16-bit 'Minor' number, used to differentiate beacon nodes.

« RSSI @ 1M: A signed 8-bit value (int8_t) indicating the RSSI measurement at 1m
distance from the node, used to estimate distance to the beacon itself.
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These values can either be set in the constructor, or via the individual functions
exposed as part of this helper class.

API

BLEBeacon has the following public API:

// Constructors

BLEBeacon(void);

BLEBeacon(uint8 t const uuid128[16]);

BLEBeacon(uint8 t const uuid128[16], uintl6 t major, uintl6_t minor, int8 t rssi);

// Set the beacon payload values

void setManufacturer(uintl6 t manfacturer);

void setUuid(uint8 t const uuid128[16]);

void setMajorMinor(uintl6_t major, uintl6_t minor);
void setRssiAtlm(int8 t rssi);

// Start advertising
bool start(void);
bool start(BLEAdvertising&amp; adv);

In addition to these functions, the BLEAdvertising class (accessible via
‘Bluefruit.Advertising.”’) exposes the following function to assign Beacon payload to
the advertising payload:

bool setBeacon(BLEBeacon&amp; beacon);

See the example below for a concrete usage example.

Example

The following example will configure the nRF52 to advertise a 'Beacon' payload:

#include &lt;bluefruit.h&gt;

// Beacon uses the Manufacturer Specific Data field in the advertising

// packet, which means you must provide a valid Manufacturer ID. Update

// the field below to an appropriate value. For a list of valid IDs see:

// https://www.bluetooth.com/specifications/assigned-numbers/company-identifiers
// 0x004C is Apple (for example)

#define MANUFACTURER ID 0x004C

// AirlLocate UUID: E2C56DB5-DFFB-48D2-B060-DOF5A71096E0
uint8 t beaconUuid[16] =
{
OxE2, OxC5, 0Ox6D, 0xB5, OxDF, OxFB, 0x48, 0xD2,
OxBO, Ox60, OxDO, OxF5, OxA7, 0x10, 0x96, OXEO,
i

// A valid Beacon packet consists of the following information:
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// UUID, Major, Minor, RSSI @ 1M
BLEBeacon beacon(beaconUuid, 0x0001, 0x0000, -54);

void setup()
Serial.begin(115200);
Serial.println("Bluefruit52 Beacon Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52");

// Manufacturer ID is required for Manufacturer Specific Data
beacon.setManufacturer(MANUFACTURER ID);

// Setup the advertising packet
setupAdv();

// Start advertising
Bluefruit.Advertising.start();

}

void setupAdv(void)

{
// Set the beacon payload using the BLEBeacon class populated

// earlier in this example
Bluefruit.Advertising.setBeacon(beacon);

// char* adv = Bluefruit.Advertising.getData();

// There is no room left for 'Name' in the advertising packet
// Use the optinal secondary Scan Response packet for 'Name' instead
Bluefruit.ScanResponse.addName();

}

void loop()

{
// Toggle both LEDs every second
digitalToggle(LED BUILTIN);
delay(1000);

}

Testing

If you test with the nRF Beacons application (@ (https://adafru.it/vaC) or Android (htt
ps://adafru.it/vaD)) you can configure the app to look for the UUID, Manufacturer ID,
Major and Minor values you provided, and you should be able to see the beacon, as
shown in the two screenshots below:

Make sure that the UUID, Major and Minor values match or the application won't

detect your beacon node!
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BLEMidi

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

BLEMidi is a helper class that adds support for sending and receiving MIDI Messages
using the MIDI over Bluetooth LE specification. BLEMidi supports the full standard
MIDI protocol (including SysEx messages), and it also can act as the hardware
interface for the Arduino MIDI Library.

API

BLEMidi has the following public API.

// Constructor
BLEMidi(uintl6 t fifo depth = 128);

err_t begin (void);

bool notifyEnabled (void);

// Stream API for Arduino MIDI Library Interface
int read (void);

size t write (uint8 t b);
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int available (void);

int peek (void);

void flush (void);

size t write (const char *str);

size t write (const uint8 t *buffer, size t size);

Installing the Arduino MIDI Library

BLEMidi is easiest to use when combined with the Arduino MIDI Library by Francois

Best, lathoub. You will need version 4.3.1 installed before continuing with the example
code.

Next, select Communication from the topic dropdown, and enter MIDI Library into the
search box. Click the Install button to install version 4.3.0 or higher of the MIDI
Library.

Type All Topic QII L' Filter your search..

Arduino Uno WiFi Dev Ed Library 0y Arduine
This library allows users to use network features like rest and mqtt. Includes some tools for the ESP8266. Use this library only with
Arduino Uno WiFi Developer Edition.

‘ ArduinoCloud by Arduino
Easly connect your Arduino/Genuino board to the Arduino Cloud Easly connect your Arduino/Genuino board to the Arduino Cloud

o

‘ ArduinoHttpClient by Arduino Version 0.1.0 INSTALLED
[EXPERIMENTAL] Easily interact with web servers from Arduino, using HTTP and WebSocket's. This library can be used for HTTP (GET,
POST, PUT, DELETE) requests to a web server. It also supports with W servers. Based on Adrian McEwen's

HttpClient library.
More info

ArduinoSound by Arduino
|_TEXPERIMENTALI] A simnle wav to nlav and analvze audio data usina Arduino. Currently onlv sunports SAMD21 boards and 125 andio

Close

Example

The blemidi example demonstrates how to use the BLEMidi helper class with the Ard
uino MIDI Library. The example sends a looping arpeggio, and prints any incoming
MIDI note on and note off messages to the Arduino Serial Monitor.
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This example may be out of date, and you should always consult the latest example
code in the Bluefruit52 example folder!

/*********************************************************************
This is an example for our nRF52 based Bluefruit LE modules

Pick one up today in the adafruit shop!

Adafruit invests time and resources providing this open source code,
please support Adafruit and open-source hardware by purchasing
products from Adafruit!

MIT license, check LICENSE for more information

All text above, and the splash screen below must be included in

any redistribution
*********************************************************************/
#include &lt;bluefruit.h&gt;
#include &1t;MIDI.h&gt;

BLEDis bledis;
BLEMidi blemidi;

// Create a new instance of the Arduino MIDI Library,
// and attach BluefruitLE MIDI as the transport.
MIDI CREATE BLE INSTANCE(blemidi);

// Variable that holds the current position in the sequence.
int position = 0;

// Store example melody as an array of note values

byte note sequence[] = {
74,78,81,86,90,93,98,102,57,61,66,69,73,78,81,85,88,92,97,100,97,92,88,85,81,78,
74,69,66,62,57,62,66,69,74,78,81,86,90,93,97,102,97,93,90,85,81,78,73,68,64,61,
56,61,64,68,74,78,81,86,90,93,98,102

}

void setup()

{
Serial.begin(115200);
Serial.println("Adafruit Bluefruit52 MIDI over Bluetooth LE Example");

Bluefruit.begin();
Bluefruit.setName("Bluefruit52 MIDI");

// Setup the on board blue LED to be enabled on CONNECT
Bluefruit.autoConnLed(true);

// Configure and Start Device Information Service
bledis.setManufacturer("Adafruit Industries");
bledis.setModel("Bluefruit Feather52");
bledis.begin();

// Initialize MIDI, and listen to all MIDI channels
// This will also call blemidi service's begin()
MIDI.begin(MIDI CHANNEL OMNI);

// Attach the handleNoteOn function to the MIDI Library. It will

// be called whenever the Bluefruit receives MIDI Note On messages.
MIDI.setHandleNoteOn(handleNoteOn);
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// Do the same for MIDI Note Off messages.
MIDI.setHandleNoteOff (handleNoteOff);

// Set General Discoverable Mode flag
Bluefruit.Advertising.addFlags(BLE GAP ADV FLAGS LE ONLY GENERAL DISC MODE);

// Advertise TX Power
Bluefruit.Advertising.addTxPower();

// Advertise BLE MIDI Service
Bluefruit.Advertising.addService(blemidi);

// Advertise device name in the Scan Response
Bluefruit.ScanResponse.addName();

// Start Advertising
Bluefruit.Advertising.start();

// Start MIDI read loop
Scheduler.startLoop(midiRead);

}
void handleNoteOn(byte channel, byte pitch, byte velocity)

// Log when a note is pressed.

Serial.printf("Note on: channel = %d, pitch = %d, velocity - %d", channel, pitch,
velocity);

Serial.println();

}
void handleNoteOff(byte channel, byte pitch, byte velocity)

// Log when a note is released.

Serial.printf("Note off: channel = %d, pitch = %d, velocity - %d", channel,
pitch, velocity);

Serial.println();

}

void loop()
{

// Don't continue if we aren't connected.
if (! Bluefruit.connected()) {

return;
}

// Don't continue if the connected device isn't ready to receive messages.
if (! blemidi.notifyEnabled()) {

return;
}

// Setup variables for the current and previous
// positions in the note sequence.

int current = position;

int previous = position - 1;

// If we currently are at position 0, set the
// previous position to the last note in the sequence.

if (previous &lt; 0) {
previous = sizeof(note sequence) - 1;
}

// Send Note On for current position at full velocity (127) on channel 1.
MIDI.sendNoteOn(note sequence[current], 127, 1);

// Send Note Off for previous note.
MIDI.sendNoteOff(note sequence[previous], 0, 1);

// Increment position
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position++;

// If we are at the end of the sequence, start over.
if (position &gt;= sizeof(note sequence)) {
position = 0;

}
delay(286);

}

void midiRead()

{

// Don't continue if we aren't connected.
if (! Bluefruit.connected()) {
return;

}

// Don't continue if the connected device isn't ready to receive messages.
if (! blemidi.notifyEnabled()) {
return;

}

// read any new MIDI messages
MIDI.read();

Usage

You will need to do a small bit of setup on your selected platform to connect to the
BLE MIDI enabled Bluefruit52.

Click on a platform below to view BLE MIDI setup instructions for your device:

+ macOS (0OS X)
- i0S

. mjroid

« Windows

The arpeggio should automatically play once the Bluefruit52 is connected to your
software synth. The video below shows the Bluefruit52 connected to Moog's
Animoog on iOS.

Note: The board used in the video was a pre-release prototype. The production

boards are standard Adafruit Black.
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BLEHidAdafruit

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is
incomplete, and you should consult the Github repo for the latest code and API

developments: https://goo.gl/LdEx62

BLEHidAdafruit allows you to simulate a mouse or keyboard using the HID (Human
Interface Device) profile that is part of the Bluetooth Low Energy standard.

Most modern mobile devices with Bluetooth Low Energy support, and the latest
operating systems generally support Bluetooth Low Energy mice and keyboards out
of the box, once you pair your Bluefruit nRF52/nRF52840 Feather and run an
appropriate sketch.

API

The BLEHidAdafruit helper class has the following public API:

// Constructor
BLEHidAdafruit(void);

// Call this once to start the HID service
virtual err_t begin(void);

// Keyboard

err_t keyboardReport(hid keyboard report t* report);

err_t keyboardReport(uint8 t modifier, uint8 t keycode[6]);

err_t keyboardReport(uint8 t modifier, uint8 t keycode0®, uint8 t keycodel=0,
uint8 t keycode2=0, uint8 t keycode3=0, uint8 t keycode4=0, uint8 t keycode5=0);

err_t keyPress(char ch);
err_t keyRelease(void);
err_t keySequence(const char* str, int interal=5);

// Consumer Media Keys

err_t consumerReport(uintl6 t usage code);
err_t consumerKeyPress(uintl6 t usage code);
err_t consumerKeyRelease(void);

// Mouse

err_t mouseReport(hid mouse report t* report);

err_t mouseReport(uint8 t buttons, int8 t x, int8 t y, int8 t wheel=0, int8 t
pan=0);

err_t mouseButtonPress(uint8 t buttons);
err_t mouseButtonRelease(void);

err t mouseMove(int8 t x, int8 t y);

err_t mouseScroll(int8 t scroll);
err_t mousePan(int8 t pan);
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Example Sketches

There are a variety of example sketches showing how to use the BLEHidAdafruit
class. You can browse the latest source code on Github with the following links:

« hid_keyboard (https://adafru.it/vb8): This example will simulate an HID
keyboard, waiting for data to arrive via the nRF52's serial port (via USB serial),
and send that data over the air to the bonded Central device.

« hid_mouse (https://adafru.it/vb9): This example will simulate an HID mouse. To
use it run the sketch and open the Serial Monitor, then enter the appropriate

characters to move the mouse or trigger/release the mouse buttons.

Bonding HID Devices

In order to use your HID mouse or keyboard, you will first need to bond the two
devices. The bonding process involves the following steps:

« The two devices will connect to each other normally

« A set of security keys are exchanged between the two devices, and stores in
non-volatile memory on each side. This is to ensure that each side is reasonably
confident it is talking to the device it thinks it is for future connections, and to
encrypt over the air communication between the devices (so that people can
'sniff' your keyboard data, etc.).

« On the nRF52 side this key data will be stored in a section of flash memory
reserved for this purpose using an internal file system.

« The process of storing these security keys is referred to as bonding, and allows
bonded devices to securely communicate without user interaction in the future.

« To cancel the bonding agreement, you can simply delete the keys on the nRF52
via the clearbonds (https://adafru.it/vba) sketch, or delete the bonding data on
your mobile device of computer.

If you run into any bonding problems, try running the clearbonds sketch to

remove and old bonding data from local non-volatile memory!
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Setting up your Bluefruit device for bonding

To bond an device, run an appropriate HID sketch on the nRF52 to emulate either an
HID mouse or an HID keyboard. In the event that you use the HID mouse example you
may need to open the Serial Monitor to use it.

In this example we'll run the hid_keyboard example sketch, flashing it to the nRF52,
which should give you the following results:

Opening the Serial Monitor will give you the following output (though it may differ
depending on the debug level you have selected):

©Adafruit Industries Page 140 of 176



Bonding on iOS

To bond to an iOS device, make sure the sketch is running (as described above) and
go into your Settings app and Select Bluetooth.

You should see a device at the bottom of this page called Bluefruit52 (this may vary
depending on the version of the sketch you are using!):

Click the device, and you will get a pairing request like this:

Click the Pair button, and the devices will be paired and bonded, and will
automatically connect to each other in the future.

If everything went will, you will see the device in your MY DEVICES list, as follows:
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Testing the HID Keyboard and Bonding

To test the HID keyboard sketch and bonding process, open the Serial Monitor (or
your favorite terminal emulator), enter some text, and if you are using the Serial
Monitor click the Send button. This will send some text over the air to

whatever textbox or text control has focus in your app.

The text will then appear in your mobile app or bonded device.

If the characters don't match exactly what you send, be sure to check your keyboard
language settings, since you may be sending data to a device with a different
keyboard setup!

BLEANCcS

The Bluefruit nRF52 BSP codebase is undergoing active development based on
customer feedback and testing. As such, the class documentation here is

incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

BLEANCcs is a helper class that enables you to receive notifications from the Apple
Notification Center Service (https://adafru.it/ErH) from devices such as an iPhone or

iPad. It can be used to receive alerts such as incoming or missed calls, email
messages, or most alerts that appear on the mobile device's screen when locked.

API

Because the BLEANCs class is a work in progress, the latest public API for the
BLEANCcs helper class should be viewed here (https://adafru.it/xen).
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ANCS OLED Example

The ancs_oled (https://adafru.it/xeo) example uses the Adafruit FeatherWing OLED (h
ttps://adafru.it/sao) to display any incoming alerts.

Sketch Requirements

In order to use this example sketch the following libraries must be installed on your
system:

« Adafruit_GFX (https://adafru.it/xep) (Github source (https://adafru.it/ala))
« Adafruit_SSD1306 (https://adafru.it/xep) (Github source (https://adafru.it/aHq))
« Version 0.6.0 or higher of the Bluefruit nRF52 BSP

Loading the Sketch

The ancs_oled sketch can be loaded via the examples menu under Peripheral >
ancs_oled:

With the sketch loaded, you can build the firmware and then flash it to your device via
the Upload button or menu option:
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Make sure that the Adafruit_SSD1306.h file has the 'SSD1306_128_32' macro

enabled. Running the sketch with 'SSD1306_128_64' set will cause corrupted
data to appear on the OLED display.

Once the sketch is running on the nRF52 Feather you can proceed with the one-
time pairing process, described below.

Pairing to your Mobile Device

Before you can start receiving notifications, you will need to 'pair' the nRF52 Feather
and the mobile device.

The pairing process causes a set of keys to be exchanged and stored on the two
devices so that each side knows it is talking to the same device it originally bonded
with, and preventing any devices in the middle from eavesdropping on potentially

sensitive data.

The one-time pairing process is described below, and assumes you are already
running the ancs_oled sketch on your nRF52 device.

1. In the Settings app go to Bluetooth:
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* Bluetooth On

2. Scroll to the bottom of the list of 'My Devices' and click on Bluefruit52 under Other
Devices:

OTHER DEVICES =

7]

Bluefruit52

3. When the pairing dialog box comes up, click the Pair button:

Bluetooth Pairing Request

“Bluefruit52” would like to pair with
your iPhone.

4. Wait for the pairing process to complete, at which point Bluefruit52 should appear
in the My Devices list with the Connected status:

Bluefruit52 Connected @
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Once two devices have been paired, they will automatically reconnect to each

other whenever they are in range and have their Bluetooth radios enabled.

Wait for Alerts

At this point, any alerts that the mobile device generates will be displayed on the
OLED display along with the notification category and date:

Family

R t from I!!J?£’1I7
i.%. would like to

oet the app I"ngm L.

Certain alerts (such as incoming calls) can also have actions associated with them,

making use of the three buttons on the left-hand side of the display to decide which
action to take.

In the ancs_oled example, we have a special section of code for incoming calls where
you can accept or decline a call with an appropriate button press:

// Check buttons
uint32 t presedButtons = readPressedButtons();

if ( myNotifs[activeIndex].ntf.categoryID == ANCS CAT INCOMING CALL )
{

/* Incoming call event

* - Button A to accept call

* - Button C to decline call

*/
if ( presedButtons &amp; bit (BUTTON_A) )
{

bleancs.actPositive(myNotifs[activeIndex].ntf.uid);

}
if ( presedButtons &amp; bit (BUTTON C) )
{

bleancs.actNegative(myNotifs[activeIndex].ntf.uid);
}
}

©Adafruit Industries Page 146 of 176



BLECIlientCts

The Bluefruit nRF52 BSP codebase is undergoing active development based on

customer feedback and testing. As such, the class documentation here is
incomplete, and you should consult the Github repo for the latest code and API
developments: https://goo.gl/LdEx62

BLECIlientCts is a helper class that implements adopted Current Time Service (https://
adafru.it/BiT) , which enables you to receive time from devices such as an iPhone or
iPad.

API

// Callback Signatures
typedef void (*adjust callback t) (uint8 t reason);

BLEClientCts(void);

virtual bool begin(void);
virtual bool discover(uintl6 t conn handle);

bool getCurrentTime(void);
bool getLocalTimeInfo(void);

bool enableAdjust(void);
void setAdjustCallback(adjust callback t fp);

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.current time.xml
struct ATTR _PACKED {

uintl6 t year;

uint8 t month;

uint8 t day;

uint8 t hour;

uint8 t minute;

uint8 t second;

uint8 t weekday;

uint8 t subsecond;

uint8 t adjust reason;
} Time;

// https://www.bluetooth.com/specifications/gatt/viewer?
attributeXmlFile=org.bluetooth.characteristic.local time information.xml
struct ATTR PACKED {

int8 t timezone;

uint8 t dst offset;
}LocalInfo;
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Client CTS OLED Example

The client_cts_oled (https://adafru.it/BiU) example uses the Adafruit FeatherWing
OLED (https://adafru.it/sao) to display received time.

Sketch Requirements

In order to use this example sketch the following libraries must be installed on your
system:

« Adafruit_GFX (https://adafru.it/xep) (Github source (https://adafru.it/ala))
« Adafruit_SSD1306 (https://adafru.it/xep) (Github source (https://adafru.it/aHq))

Loading the Sketch

The client_cts_oled sketch can be loaded via the examples menu under Peripheral >
client_cts_oled:

With the sketch loaded, you can build the firmware and then flash it to your device via
the Upload button or menu option. Once the sketch is running on the nRF52 Feather
you can proceed with the one-time pairing process, described below.

Make sure that the Adafruit_SSD1306.h file has the 'SSD1306_128_32' macro

enabled. Running the sketch with 'SSD1306_128_64' set will cause corrupted
data to appear on the OLED display.
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Pairing to your Mobile Device

Before you can start receiving notifications, you will need to 'pair' the nRF52 Feather
and the mobile device.

The pairing process causes a set of keys to be exchanged and stored on the two
devices so that each side knows it is talking to the same device it originally bonded
with, and preventing any devices in the middle from eavesdropping on potentially
sensitive data.

The one-time pairing process is described below, and assumes you are already
running the ancs_oled sketch on your nRF52 device.

1. In the Settings app go to Bluetooth:

Bluetooth On

2. Scroll to the bottom of the list of 'My Devices' and click on Bluefruit52 under Other
Devices:

OTHER DEVICES .,

Bluefruit52

3. When the pairing dialog box comes up, click the Pair button:
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Bluetooth Pairing Request

“Bluefruit52” would like to pair with
your iPhone.

Cancel

4. Wait for the pairing process to complete, at which point Bluefruit52 should appear
in the My Devices list with the Connected status:

Bluefruit52 Connected @

Once two devices have been paired, they will automatically reconnect to each
other whenever they are in range and have their Bluetooth radios enabled.

Wait for Time Data

At this point, time data from the mobile device will be read and display on the the
OLED. For demo purpose the sketch will read time data from mobile once every
second. However, in reality, nRF52 should have an internal timer that keep track of
second, and only read/sync with mobile after several hours or days, similar to how IP
device got time from NTP server.
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BLECentral

This page is a work in progress as the APl is changing as we migrate to S132v5

(nRF52832) and S140 (nRF52840) and add better Central mode support.

The Central mode APl is accessible via Bluefruit.Central.* and has the following
public functions:

void begin(void);

/* __________________________________________________________________ */

/* GAP

K o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e = */

bool setConnInterval(uintl6_t min, uintl6_t max);

bool setConnIntervalMS (uintl6 t min ms, uintl6 t max ms);

bool connect(const ble gap evt adv _report t* adv_report);

bool connect(const ble gap addr t *peer addr);

bool disconnect(uintl6 t conn handle);

bool connected (uintl6 t conn_handle); // If connected to a specific peripheral
bool connected (void); // If connected to any peripherals
Y Callbacks ------------- 3

void setConnectCallback ( BLEGap::connect callback t fp);
void setDisconnectCallback( BLEGap: :disconnect callback t fp);

For examples of how to use the Central mode API, see the Central examples folder (h
ttps://adafru.it/BiV).
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nRF52 ADC

The nRF52 family includes an adjustable 'successive-approximation ADC' which can
be configured to convert data with up to 14-bit resolution (0..16383), and the reference
voltage can be adjusted up to 3.6V internally.

The default values for the ADC are 10-bit resolution (0..1023) with a 3.6V reference
voltage, meaning every digit returned from the ADC = 3600mV/1024 = 3.515625mV.

Analog Reference Voltage

The internal reference voltage is 0.6V with a variable gain setting, and can be adjust
via the analogReference(...) function, providing one of the following values:

« AR_INTERNAL (0.6V Ref * 6 = 0..3.6V) <-- DEFAULT
« AR_INTERNAL_3_0 (0.6V Ref * 5 = 0..3.0V)

« AR_INTERNAL_2_4 (0.6V Ref * 4 = 0..2.4V)

« AR_INTERNAL_1_8 (0.6V Ref * 3 =10..1.8V)

« AR_INTERNAL_1_2 (0.6V Ref * 2 = 0..1.6V)

« AR_VDD4 (VDD/4 REF * 4 = 0.VDD)

For example:

// Set the analog reference to 3.0V (default = 3.6V)
analogReference(AR_INTERNAL 3 0);

Analog Resolution

The ADC resolution can be set to 8, 10, 12 or 14 bits using the analogReadResolution(.
..) function, with the default value being 10-bit:

// Set the resolution to 12-bit (0..4095)
analogReadResolution(12); // Can be 8, 10, 12 or 14
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Default ADC Example (10-bit, 3.6V
Reference)

The original source for this code is included in the nRF52 BSP and can be viewed
online here (https://adafru.it/zod).

#include <Arduino.h>
#include <Adafruit_TinyUSB.h> // for Serial

int adcin A5;
int adcvalue = 0;
float mv_per_1lsb = 3600.0F/1024.0F; // 10-bit ADC with 3.6V input range

void setup() {
Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb

}

void loop() {
// Get a fresh ADC value
adcvalue = analogRead(adcin);

// Display the results
Serial.print(adcvalue);

Serial.print(" [");
Serial.print((float)adcvalue * mv_per lsb);
Serial.println(" mV]");

delay(100);

Advanced Example (12-bit, 3.0V Reference)

The original source for this code is included in the nRF52 BSP and can be viewed
online here (https://adafru.it/zoe).

#include <Arduino.h>
#include <Adafruit_TinyUSB.h> // for Serial

#if defined ARDUINO_NRF52840_CIRCUITPLAY

#define PIN_VBAT A8 // this is just a mock read, we'll use the light
sensor, so we can run the test

#endif

uint32_t vbat pin = PIN VBAT; // A7 for feather nRF52832, A6 for
nRF52840

#define VBAT_MV_PER_LSB (0.73242188F) // 3.0V ADC range and 12-bit ADC
resolution = 3000mV/4096

#ifdef NRF52840_XXAA

#define VBAT DIVIDER (0.5F) // 150K + 150K voltage divider on VBAT
#define VBAT_DIVIDER_COMP (2.0F) // Compensation factor for the VBAT
divider

#else

#define VBAT_DIVIDER (0.71275837F) // 2M + 0.806M voltage divider on VBAT =

©Adafruit Industries Page 153 of 176


https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Hardware/adc/adc.ino
https://github.com/adafruit/Adafruit_nRF52_Arduino/blob/master/libraries/Bluefruit52Lib/examples/Hardware/adc_vbat/adc_vbat.ino

(2M / (0.806M + 2M))

#define VBAT_DIVIDER COMP (1.403F) // Compensation factor for the VBAT

divider
#endif

#define REAL_VBAT_MV_PER_LSB (VBAT_DIVIDER COMP * VBAT MV_PER_LSB)

float readVBAT(void) {
float raw;

// Set the analog reference to 3.0V (default = 3.6V)
analogReference (AR _INTERNAL 3 0);

// Set the resolution to 12-bit (0..4095)
analogReadResolution(12); // Can be 8, 10, 12 or 14

// Let the ADC settle
delay(1l);

// Get the raw 12-bit, 0..3000mV ADC value
raw = analogRead(vbat pin);

// Set the ADC back to the default settings
analogReference (AR DEFAULT) ;
analogReadResolution(10);

// Convert the raw value to compensated mv, taking the resistor-
// divider into account (providing the actual LIPO voltage)
// ADC range is 0..3000mV and resolution is 12-bit (0..4095)
return raw * REAL VBAT MV_PER LSB;

}

uint8_t mvToPercent(float mvolts) {
if(mvolts<3300)
return 0;

if(mvolts <3600) {
mvolts -= 3300;
return mvolts/30;

}

mvolts -= 3600;
return 10 + (mvolts * 0.15F ); // thats mvolts /6.66666666
}

void setup() {
Serial.begin(115200);
while ( !Serial ) delay(10); // for nrf52840 with native usb

// Get a single ADC sample and throw it away
readVBAT () ;
}

void loop() {
// Get a raw ADC reading
float vbat mv = readVBAT();

// Convert from raw mv to percentage (based on LIPO chemistry)
uint8_t vbat per = mvToPercent(vbat mv);

// Display the results

Serial.print("LIPO = ");
Serial.print(vbat mv);
Serial.print(" mV (");
Serial.print(vbat per);
Serial.println("%)");
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delay(1000);
}

Memory Map

This page applies to BSP 0.8.0 and higher, which introduced bootloader v5.1.0

and $132 v5.x.x. For earlier releases (BSP release < 0.8.0) see bootloader v0.5.0
and S132 v2.x.x at the bottom of this page.

BSP release & Bootloader version

The memory usage depends on the version of the Softdevice and/or bootloader
(single/dual bank). Following is the Bootloader and Softdevice version included with
BSP release

- 0.9.x :nRF52832 S132 v6.1.1 single bank andnRF52840 S140 v6.1.1 single bank
- 0.8.x :nRF52832 S132 v2.0.1 dual banks and S132 v5.1.0 dual banks

- 0.7.x and older:nRF52832 S132 v2.0.1 dual banks

Starting from BSP 0.9.x only single banks will be used to maximize the flash

storage

Flash Memory

The nRF52832 has 512 KB flash, nRF52840 has 1024 KB flash. The flash layout varies
as follows:
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« SoftDevice: This section of flash memory contains the Soft Device, which is
Nordic's black box Bluetooth Low Energy stack.

« Application: This section of flash memory stores the user sketches that you
compile in the Arduino IDE.
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« Reserved: This section of flash memory is kept empty to enable dual banks safe
firmware updates. Whenever you try to update the Application are, the new
application data will first be written to the free memory section, and the verified
before it is swapped out with the current application code. This is to ensure that
DFU complete successfully and that the entire image is safely store on the
device to avoid losing the application code. This region is not used by single
bank bootloader

« User Data: This 28KB section of flash memory is reserved for config settings. It
uses an open source file system called Little File System (https://adafru.it/C-n),
which is a part of ARM Mbed OpenSource to store bonding data. For example,
when you bond the nRF52 with another Central device.

« DFU Bootloader: This section of flash memory stores the actual bootloader code
that will be executed by the MBR described earlier.

SRAM Layout

The nRF52832 has 64KB of SRAM available, and actual memory use will depend on
your project, although the stack and heap memory locations are described below:

« Soft Device: amount of SRAM exclusive allocated for SoftDevice by Linker script.
The size is subject to change and varies by releases. For BSP release 0.8.0 it is 1
2.5 KB. However, the actual memory required by the SoftDevice depends on
the run-time configuration determined by Bluefruit's configNNN() API.

« Sketch BSS: static and global data used by your sketch.

« Heap Memory: The largest memory region, this is used for allocating the real
time operating systems (RTOS) thread stack, malloc() etc. The size, based on the
variables shown below, is Y =64 -12.5- X -2 (KB ), where 12.5KB will vary
depending on the SoftDevice used.

« Stack Memory: Used by non RTOS thread code, this is mostly for Interrupt
Service Routines (ISRs) and SoftDevice API calls. The current size is 2 KB.

Functions affecting SoftDevice SRAM usage

The Bluefruit nRF52 configNNN() functions set the behavior of SoftDevice, thus
determining the total SRAM usage. These functions must be called before begin().

« configUuid128Count() : Defines the number of UUID128 entries that the
SoftDevice supports, e.g Bleuart, BleMidi, or other services and
characteristics. Default value is 10.
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- configAttrTableSize(): The total size of the attribute table, which holds services
and characteristics. If your application needs lots of characteristics you may
need to increase this. Default value is 2048 bytes.

configPrphConn(), configPrphBandwidth(): These function set the parameters
that determine the bandwidth for peripheral's

connections. configPrphBandwidth() is a convenient helper that calls

configPrphConn() with appropriate parameters.
configCentralConn(), configCentralBandwidth(): These functions set the

parameters that determine the bandwidth for central mode connections.
configCentralBandwidth() is a convenient helper that calls configCentralConn()
with appropriate parameters.

begin(): Bluefruit nRF52's begin() function also affects the bandwidth since it

takes 2 (optional) parameters. The first one is the number of concurrent
connections for peripheral links (to mobile phones, your computer, etc.), the
second one is the number of central links (to BLE accessories, or another
feather52 running in peripheral mode). The maximum number of concurrent
connections for SoftDevice v5.x is 20.

0x2000 FFFF

Stack
2KB

0x2000 NNNN

Sketch BSS
X KB

Actual usage depend
on configuration** SoftDevice

Bluefruit nRF52 S132 v5.x.x SRAM Usage

If you run into an error message saying "SoftDevice require more SRAM than

provided by linker", try altering your system config -- for ex. lower bandwidth,
fewer connection or a smaller attribute table size. Another advanced option is to
modify the linker script, but this should be done with care and knowledge of what
you are changing.

[CFG] SoftDevice config requires more SRAM than provided by the linker.
App Ram Start must be at least 0x20004180 (provided 0x20003200).
Please update linker file or re-config SoftDevice.
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Software Resources

To help you get your Bluefruit LE module talking to other Central devices, we've put
together a number of open source tools for most of the major platforms supporting
Bluetooth Low Energy.

Bluefruit LE Client Apps and Libraries

Adafruit has put together the following mobile or desktop apps and libraries to make
it as easy as possible to get your Bluefruit LE module talking to your mobile device or
laptop, with full source available where possible:

Bluefruit LE Connect (https://adafru.it/f4G) (Android/Java)

Bluetooth Low Energy support was added to Android starting with Android 4.3
(though it was only really stable starting with 4.4), and we've already released Bluefru
it LE Connect to the Play Store (https://adafru.it/f4G).

The full source code (https://adafru.it/fY9) for Bluefruit LE Connect for Android is also
available on Github to help you get started with your own Android apps. You'll need a
recent version of Android Studio (https://adafru.it/fYa) to use this project.

Bluefruit LE Connect (https://adafru.it/f4H) (iI0S/Swift)

Apple was very early to adopt Bluetooth Low Energy, and we also have an iOS
version of the Bluefruit LE Connect (https://adafru.it/f4H) app available in Apple's app
store.

©Adafruit Industries Page 159 of 176


https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://github.com/adafruit/Bluefruit_LE_Connect_Android
https://developer.android.com/sdk/index.html
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The full swift source code for Bluefruit LE Connect for iOS is also available on Github.
You'll need XCode and access to Apple's developper program to use this project:

« Version 1.x source code: https://github.com/adafruit/Bluefruit_LE_Connect (https
://adafru.it/ddv)

« Version 2.x source code: https://github.com/adafruit/Bluefruit_LE_Connect_v2 (h
ttps://adafru.it/09E)

Version 2.x of the app is a complete rewrite that includes iOS, OS X GUI and OS

X command-line tools in a single codebase.

Bluefruit LE Connect for OS X (https://
adafru.it/o9F) (Switf)

This OS X desktop application is based on the same V2.x codebase as the iOS app,
and gives you access to BLE UART, basic Pin I/O and OTA DFU firmware updates from
the convenience of your laptop or mac.

This is a great choice for logging sensor data locally and exporting it as a CSV, JSON
or XML file for parsing in another application, and uses the native hardware on your

computer so no BLE dongle is required on any recent mac.

The full source is also available on Github (https://adafru.it/09E).
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Bluefruit LE Command Line Updater for OS
X (hftps:/7adafru.it/pLF) (SWITT)

This experimental command line tool is unsupported and provided purely as a proof
of concept, but can be used to allow firmware updates for Bluefruit devices from the
command line.

This utility performs automatic firmware updates similar to the way that the GUI
application does, by checking the firmware version on your Bluefruit device (via the
Device Information Service), and comparing this against the firmware versions
available online, downloading files in the background if appropriate.

Simply install the pre-compiled tool via the DMG file (https://adafru.it/pLF) and place it
somewhere in the system path, or run the file locally via "/bluefruit' to see the help
menu:

$ ./bluefruit
bluefruit v0.3

Usage:

bluefruit &lt;command&gt; [options...]
Commands:

Scan peripherals: scan

Automatic update: update [--enable-betal] [--uuid &lt;uuid&gt;]

Custom firmware: dfu --hex &lt;filename&gt; [--init &lt;filename&gt;] [--
uuid &lt;uuidé&gt;]

Show this screen: --help

Show version: --version
Options:

--uuid &lt;uuid&gt; If present the peripheral with that uuid is used. If not
present a list of peripherals is displayed

--enable-beta If not present only stable versions are used

Short syntax:
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-u = --uuid, -b = --enable-beta, -h = --hex, -i = --init, -v = --version, -7
--help

Deprecated: Bluefruit Buddy (https://adafru.it/mCn) (OS X)

This native OS X application is a basic proof of concept app that allows you to
connect to your Bluefruit LE module using most recent macbooks or iMacs. You can
get basic information about the modules and use the UART service to send and
receive data.

The full source for the application is available in the github repo at Adafruit_Bluefruit
LE_OSX (https://adafru.it/mCo).

ABLE (https://adafru.it/ijB) (Cross Platform/Node+Electron)

ABLE (https://adafru.it/ijB) (Adafruit Bluefruit LE Desktop) is a cross-platform desktop
application based on Sandeep Misty's noble library (https://adafru.it/ijC) and the Elect
ron (https://adafru.it/ijD) project from Github (used by Atom).

It runs on OS X, Windows 7+ and select flavours of Linux (Ubuntu tested locally).
Windows 7 support is particularly interesting since Windows 7 has no native support
for Bluetooth Low Energy but the noble library talks directly to supported Bluetooth
4.0 USB dongles (http://adafru.it/1327) to emulate BLE on the system (though at this
stage it's still in early BETA and drops the connection and takes more care to work
with).

This app allows you to collect sensor data or perform many of the same functionality
offered by the mobile Bluefruit LE Connect apps, but on the desktop.
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The app is still in BETA, but full source (https://adafru.it/ijE) is available in addition to
the easy to use pre-compiled binaries (https://adafru.it/ijB).

Bluefruit LE Python Wrapper (https://adafru.it/fQF)

As a proof of concept, we've played around a bit with getting Python working with the
native Bluetooth APIs on OS X and the latest version of Bluez on certain Linux targets.

There are currently example sketches showing how to retreive BLE UART data as well
as some basic details from the Device Information Service (DIS).

This isn't an actively support project and was more of an experiment, but if you have a
recent Macbook or a Raspberry Pi and know Python, you might want to look at Adafr
uit_Python_BluefruitLE (https://adafru.it/fQF) in our github account.

Debug Tools

If your sense of adventure gets the better of you, and your Bluefruit LE module
goes off into the weeds, the following tools might be useful to get it back from
unknown lands.
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These debug tools are provided purely as a convenience for advanced users for

device recovery purposes, and are not recommended unless you're OK with

potentially bricking your board. Use them at your own risk.

Adalink (https://adafru.it/fPq) (Python)

This command line tool is a python-based wrapper for programming ARM MCUs using
either a Segger J-Link (https://adafru.it/fYU) or an STLink/V2 (https://adafru.it/ijF). You
can use it to reflash your Bluefruit LE module using the latest firmware from the Bluef

ruit LE firmware repo (https://adafru.it/edX).

Details on how to use the tool are available in the readme.md file on the main Adafrui
t_Adalink (https://adafru.it/fPq) repo on Github.

Completely reprogramming a Bluefruit LE module with AdaLink would require four
files, and would look something like this (using a JLink):

adalink nrf51822 --programmer jlink --wipe
--program-hex "Adafruit BluefruitLE Firmware/softdevice/

s110 nrf51 8.0.0 softdevice.hex"
--program-hex "Adafruit BluefruitLE Firmware/bootloader/bootloader 0002.hex"
--program-hex "Adafruit BluefruitLE Firmware/0.6.7/blefriend32/

blefriend32 s110 xxac 0 6 7 150917 blefriend32.hex"

--program-hex "Adafruit BluefruitLE Firmware/0.6.7/blefriend32/
blefriend32 s110 xxac 0 6 7 150917 blefriend32 signature.hex"

You can also use the Adalink tool to get some basic information about your module,
such as which SoftDevice is currently programmed or the IC revision (16KB SRAM or
32KB SRAM) via the --info command:

$ adalink nrf51822 -p jlink --info
Hardware ID : QFACA10 (32KB)
Segger ID : NRF51822 xxAC

SD Version : S110 8.0.0

Device Addr : ¥k gk sxokokex ok
Device ID : 3k 3k >k 3k >k >k >k >k 5k >k >k ok koK k k

Adafruit nRF51822 Flasher (https://adafru.it/fVL) (Python)

Adafruit's nRF51822 Flasher is an internal Python tool we use in production to flash
boards as they go through the test procedures and off the assembly line, or just
testing against different firmware releases when debugging.
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It relies on AdaLink or OpenOCD beneath the surface (see above), but you can use
this command line tool to flash your nRF51822 with a specific SoftDevice, Bootloader
and Bluefruit firmware combination.

It currently supports using either a Segger J-Link or STLink/V2 via AdaLink, or GPIO
on a Raspberry Pi (https://adafru.it/fVL) if you don't have access to a traditional ARM
SWD debugger. (A pre-built version of OpenOCD for the RPi is included in the repo

since building it from scratch takes a long time on the original RPi.)

We don't provide active support for this tool since it's purely an internal project, but
made it public just in case it might help an adventurous customer debrick a board on
their own.

$ python flash.py --jtag=jlink --board=blefriend32 --softdevice=8.0.0 --
bootloader=2 --firmware=0.6.7

jtag : jlink
softdevice : 8.0.0
bootloader 12

board : blefriend32
firmware : 0.6.7

Writing Softdevice + DFU bootloader + Application to flash memory

adalink -v nrf51822 --programmer jlink --wipe --program-hex

"Adafruit BluefruitLE Firmware/softdevice/s110 nrf51 8.0.0 softdevice.hex" -
program-hex "Adafruit BluefruitLE Firmware/bootloader/bootloader 0002.hex" -
program-hex "Adafruit BluefruitLE Firmware/0.6.7/blefriend32/

blefriend32 s110 xxac 0 6 7 150917 blefriend32.hex" --program-hex

"Adafruit BluefruitLE Firmware/0.6.7/blefriend32/

blefriend32 s110 xxac 0 6 7 150917 blefriend32 signature.hex"

Downloads

The following resources may be useful working with the Bluefruit nRF52 Feather:

« Adafruit_nRF52_Arduino (https://adafru.it/vaF): The core code for this device
(hosted on Github)

« NRF52 Example Sketches (https://adafru.it/vaK): Browse the example code from
the core repo on Github

« NRF52832 Product Specification v1.4 (https://adafru.it/Erl): Key technical
documentation for the nRF52832 SoC

- EagleCAD PCB files on GitHub (https://adafru.it/vbH)

Feather Bluefruit NRF52 Pinout

Diagram

https://adafru.it/z4c
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MyNewt Bootloader

This is if you want to program in MyNewt support - the bootloader will not work with

Arduino!
feather52_boot_bleuart.bin

https://adafru.it/Ep4

You can use adalink and a jlink to program this in via SWD to address O with
something like:

adalink -v nrf52832 -p jlink -b feather52 boot bleuart.bin 0

(Don't forget you may have to erase the chip)

Module Details

The Bluefruit nRF52 Feather uses the MDBT42Q module from Raytac. Details on the
module, including FCC and other certifications are available in the document below:

MDBT42Q-Version_B.pdf

https://adafru.it/vbb
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Schematic

Schematic (pre March 16 2018)

FAQSs

NOTE: For FAQs relating to the BSP, see the dedicated BSP FAQ list (https://adafru.it/
vnF).
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What are the differences between the nRF51 and nRF52
Bluefruit boards? Which one should | be using?

The two board families take very different design approaches.

All of the nRF51 based modules are based on an AT command set (over UART or
SPI), and require two MCUs to run: the nRF51 hosting the AT command parser, and
an external MCU sending AT style commands.

The nRF52 boards run code directly on the nRF52, executing natively and calling
the Nordic S132 SoftDevice (their proprietary Bluetooth Low Energy stack) directly.
This allows for more efficient code since there is no intermediate AT layer or
transport, and also allows for lower overall power consumption since only a single
device is involved.

The nRF52 will generally give you better performance, but for situation where you
need to use an MCU with a feature the nRF52 doesn't have (such as USB), the
NRF51 based boards will still be the preferable solution.

Can | run nRF51 Bluefruit sketches on the nRF527?

No. The two board families are fundamentally different, and have entirely separate
APls and programming models. If you are migrating from the nRF51 to the nRF52,
you will need to redesign your sketches to use the newer API, enabling you to
build code that runs natively on the nRF52832 MCU.

Can | use the nRF52 as a Central to connect to other BLE
peripherals?

The S132 Soft Device and the nRF52832 HW support Central mode, so yes this

is possible. At this early development stage, though, there is only bare bones
support for Central mode in the Adafruit nRF52 codebase, simply to test the HW
and S132 and make sure that everything is configured properly. An example is
provided of listening for incoming advertising packets, printing the packet contents
and meta-data out to the Serial Monitor. We hope to add further Central mode
examples in the future, but priority has been given to the Peripheral APl and
examples for the initial release.
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How are Arduino sketches executed on the nRF52? Can |
do hard real time processing (bit-banging NeoPixels,
Software Serial etc.)?

In order to run Arduino code on the nRF52 at the same time as the low level
Bluetooth Low Energy stack, the Bluefruit nRF52 Feather uses FreeRTOS as a task
scheduler. The scheduler will automatically switch between tasks, assigning clock
cycles to the highest priority task at a given moment. This process is generally
transparent to you, although it can have implications if you have hard real time
requirements. There is no guarantee on the nRF52 to meet hard timing
requirements when the radio is enabled an being actively used for Bluetooth Low
Energy. This isn't possible on the nRF52 even without FreeRTOS, though, since the
SoftDevice (Nordic's propietary binary blob stack) has higher priority than any user
code, including control over interrupt handlers.

Can | use GDB to debug my nRF527?

You can, yes, but it will require a Segger J-Link (that's what we've tested against
anyway, other options exist), and it's an advanced operation. But if you're asking
about it, you probably know that.

Assuming you have the Segger J-Link drivers installed, you can start Segger's GDB
Server from the command line as follows (OSX/Linux used here):

$ JLinkGDBServer -device nrf52832 xxaa -if swd -speed auto

Then open a new terminal window, making sure that you have access to gcc-arm-
none-eabi-gdb from the command line, and enter the following command:

$ ./arm-none-eabi-gdb something.ino.elf

“something.ino.elf "is the name of the .elf file generated when you built your
sketch. You can find this by enabling 'Show verbose output during: [x] compilation’
in the Arduino IDE preferences. You CAN run GDB without the .elf file, but pointing
to the .elf file will give you all of the meta data like displaying the actual source
code at a specific address, etc.

Once you have the (gdb) prompt, enter the following command to connect to the
Segger GDB server (updating your IP address accordingly, since the HW isn't
necessarily local!):

(gdb) target remote 127.0.0.1:2331
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If everything went well, you should see the current line of code where the device is
halted (normally execution on the nRF52 will halt as soon as you start the Segger
GDB Server).

At this point, you can send GDB debug commands, which is a tutorial in itselfl As a
crash course, though:

- To continue execution, type 'monitor go'then'continue'
« To stop execution (to read register values, for example.), type
"monitor halt'
- To display the current stack trace (when halted) enter ' bt'
- To get information on the current stack frame (normally the currently
executing function), try these:
o info frame: Display info on the current stack frame
o info args : Display info on the arguments passed into the stack frame
o info locals : Display local variables in the stack frame
o info registers:Dump the core ARM register values, which can be
useful for debugging specific fault conditions

Are there any other cross platform or free debugging
options other than GDB?

If you have a Segger J-Link (https://adafru.it/w5c), you can also use Segger's
OZone debugger GUI (https://adafru.it/w5d) to interact with the device, though
check the license terms since there are usage restrictions depending on the J-Link
module you have.

You will need to connect your nRF52 to the J-Link via the SWD and SWCLK pins on
the bottom of the PCB, or if you are OK with fine pitch soldering via the SWD
header.

You can either solder on a standard 2x5 SWD header (https://adafru.it/w5e) on the
pad available in the board, or you can solder wires to the SWD and SWCLK pads
on the bottom of the PCB and use an SWD Cable Breakout Board (https://adafru.it/
u7d), or just connect cables directly to your J-Link via some other means.

You will also need to connect the VTRef pin on the JLink to 3.3V on the Feather to
let the J-Link know what voltage level the target has, and share a common GND by
connecting the GND pins on each device.

Before you can start to debug, you will need to get the .elf file that contains all the
debug info for your sketch. You can find this file by enabling Show Verbose Output
During: compilation in the Arduino Preferences dialogue box. When you build your

©Adafruit Industries Page 170 of 176


https://www.adafruit.com/new?q=jlink&
https://www.segger.com/ozone.html
https://www.segger.com/ozone.html
https://www.adafruit.com/product/752
https://www.adafruit.com/product/2743

sketch, you need to look at the log output, and find the .elf file, which will resemble
something like this (it will vary depending on the OS used): /var/folders/86/
hb2vpl4n5 5 yvdz z8w9x c0000gn/T/arduino build 118496/

ancs oled.ino.elf

In the OZone New Project Wizard, when prompted to select a target device in
OZone select nNRF52832_xxAA, then make sure that you have set the Target
Interface for the debugger to SWD, and finally point to the .elf file above:
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Next select the Attach to running program option in the top-left hand corner, or via the
menu system, which will cause the debugger to connect to the nRF52 over SWD:

At this point, you can click the PAUSE icon to stop program execution, and then
analyze variables, or set breakpoints at appropriate locations in your program
execution, and debug as you would with most other embedded IDEs!
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Clicking on the left-hand side of the text editor will set a breakpoint on line 69 in the
image below, for example, and the selecting Debug > Reset > Reset & Run from the

menu or icon will cause the board to reset, and you should stop at the breakpoint you
set:

You can experiment with adding some of the other debug windows and options via
the View menu item, such as the Call Stack which will show you all of the functions
that were called before arriving at the current breakpoint:
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Can | make two Bluefruit nRF52's talk to each other?

Yes, by running one board in peripheral mode and one board in central mode,
where the central will establish a connection with the peripheral board and you can
communicate using BLE UART or a custom service. See the following Central BLE
UART example to help you get started: https://github.com/adafruit/
Adafruit_nRF52_Arduino/tree/master/libraries/Bluefruit52Lib/examples/Central

On Linux I'm getting 'arm-none-eabi-g++: no such file or

directory’, even though 'arm-none-eabi-g++' exists in the
path specified. What should | do?

This is probably caused by a conflict between 32-bit and 64-bit versions of the
compiler, libc and the IDE. The compiler uses 32-bit binaries, so you also need to
have a 32-bit version of libc installed on your system (details (https://adafru.it/vnE)).
Try running the following commands from the command line to resolve this:

sudo dpkg --add-architecture 1386
sudo apt-get update
sudo apt-get install libc6:1386

what should | do when Arduino failed to upload sketch to
my Feather ?

If you get this error:

Timed out waiting for acknowledgement from device.

Failed to upgrade target. Error is: No data received on serial
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port. Not able to proceed.
Traceback (most recent call last):
File "nordicsemi\ main .py", line 294, in serial
File "nordicsemi\dfu\dfu.py", line 235, in dfu send images
File "nordicsemi\dfu\dfu.py", line 203, in dfu send image
File "nordicsemi\dfuldfu transport serial.py"”, line 155, in
send init packet
File "nordicsemi\dfuldfu transport serial.py", line 243, in
send packet
File "nordicsemi\dfuldfu transport serial.py", line 282, in
get ack nr
nordicsemi.exceptions.NordicSemiException: No data received on
serial port. Not able to proceed.

This is probably caused by the bootloader version mismatched on your feather and
installed BSP. Due to the difference in flash layout (more details (https://adafru.it/
Dsy)) and Softdevice API (which is bundled with bootloader), sketch built with
selected bootloader can only upload to board having the same version. In short,
you need to upgrade/burn bootloader to match on your Feather, follow

above Update The Bootloader (https://adafru.it/Dsx) guide

It only has to be done once to update your Feather

Do Feather/Metro nRF52832 and nRF52840 support BLE
Mesh ?

They all support BLE Mesh, but we don't provide Arduino library for Mesh. You
need to write code based on Nordic sdk mesh.

Unable to upload sketch/update bootloader with macOS

If you get error similar to this:

Arduino: 1.8.8 (Mac 0S X), Board: "Adafruit Bluefruit nRF52832
Feather, 0.2.9 (s132 6.1.1), Level 0 (Release)"

[1716] Error loading Python lib '/var/folders/gw/
b0cg4zm508qf rf2m655gd3mOEOOgn/T/ MEIE6ec69/Python': dlopen:
dlopen(/var/folders/gw/b0cg4zm508qf rf2m6559d3me00Ogn/T/ MEIE6ec69/
Python, 10): Symbol not found: futimens

Referenced from: /var/folders/gw/b0cg4zm508qf rf2m6559d3mOOOOgn/
T/ MEIE6ec69/Python (which was built for Mac 0S X 10.13)
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